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FOREWORD            
 

EffiValidation 3.0 is designed to meet the requirements and needs of Testing and Calibration laboratories 

accredited according to the EN ISO/IEC 17 025:2001 standard, and the needs of Quality Control laboratories 

operating under regulatory GxP environments. The software enables users to plan and carry out validations of 

analytical (microbiological) methods, to evaluate inter-laboratory comparison studies, to develop and use 

calibration models, to develop and maintain control charts, to determine uncertainties of analytical results, to 

handle electronic records of the laboratory (Book of Samples, Book of Specifications, Book of Equipment, Book 

of Documents, Book of Deviations, Book of Contacts, Book of Reference Standards, Book of Chemicals and 

Book of Volumetric Solutions) and to meet the 21 CFR Part 11 requirements. 

 

EffiValidation 3.0 is compliance-ready and offers a high Level of software validation and quality as it was 

designed and developed under a Development Life Cycle process (General Principles of Software Validation, 

Final Guidance; GAMP 4: Guide for Validation of Automated Systems). It conforms to the Electronic Records 

and Electronic Signatures Final Rule (21 CFR Part 11) including automatic Audit Trails. The software is 

supplied with accompanying documentation, i.e. Functional Specification for computer systems, Installation 

Qualification (IQ) and Operational Qualification (OQ) procedures/documents as the basis for an ongoing 

qualification process and with Book of Reference Examples in printed and electronic form (on the installation 

CD). 

 

The following standards and interpretation guides are the main documents used to develop the EffiValidation 3.0 

software: 

- Validation of analytical (microbiological) methods: EN ISO/IEC 17 025, ICH, USP, FDA and Eurachem 

guides 

- Inter-laboratory Comparison: ISO 5725 

- Control Charts: ISO 8252 

- Calibration Models: ISO 8466-1,-2 

- Uncertainties of analytical results: Eurachem/CITAC Guide 

- Electronic Records:  21 CFR Part 11, EN ISO/IEC 17 025 

- Software Validation: General Principles of Software Validation, FDA ï CDRH; GAMP 4: Guide for Validation 

of Automated Systems, ISPE; Good Practices for Computerized Systems in Regulated ñGXPò Environments: 

PIC/S.  

 

This User's Guide describes how to work with the software, i.e. how to create a database of analytical (testing 

and calibration) methods, enter data, calculate results, handle graphs, print and export data/results/graphs to other 

applications, etc. The Userôs Guide does not give details on the statistical algorithms implemented in the 

software. To learn more about these methods, users are advised to consult international standards and guides by 

ISO, ICH, FDA, EPA, IUPAC, AOAC, Eurachem, etc.  

 

The following notation is used throughout the software and documentation:  

¶ Window and tab names are underlined  

¶ Commands are displayed in italics (commands from menu or icons) 

¶ Data to be entered and Results obtained are displayed in bold 

 

 

The authors declare they are not responsible either for damage resulting from incorrect application of the 

software or from interpretation of results. These are responsibilities of the final software user.  

 

The authors hope that with the software EffiValidation 3.0 users will successfully validate their analytical 

methods, evaluate inter-laboratory comparisons, construct calibration models, establish control charts, estimate 

uncertainties of analytical results and will have a positive experience with the electronic record books. The 

outcome of the software implementation should be a reduced likelihood of non-compliance during accreditation 

or GxP inspection and improved operational performance and reduced costs. 

 

Comments from software users are welcome and will be considered for further implementation in upgrades and 

new versions of the software.  

 

EffiChem 

http://www.effichem.com       Lysice 5. 5. 2010 

http://www.effichem.com/
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CHAPTER 

1 
GENERAL INFORMATION  

 

This chapter contains: 

 

Á Contact information 

Á Brief description of the software  

Á Summary of ISO/IEC 17 025:2001 requirements: ñGeneral Requirements for Suitability of Testing 

and Calibration Laboratoriesò regarding the method validation, determination of uncertainties and 

Validation of software  

Á Summary of requirements for Quality Control laboratories operating under regulatory GxP 

environments regarding the method validation, software validation and electronic records and 

signatures. 

 

Hardware requirements, delivery details, installation and getting started information are included in Chapter 2. 

 

Note: the contents of this User's Guide overlap with the Help and Instructions included in the software. 

1.1 CONTACT  INFORMATION            

 

Post address:     EffiChem 

      Lesn² 593 

      679 91 Lysice 

      Czech Republic 

 

Telephone:      +420 516 473 304 

Fax:       +420 516 473 304 

Mobile:       +420 606 714 974 
 

E-mail:      effichem@effichem.com   

      sales@effichem.com   

      support@effichem.com   

 

Web:      http://www.effichem.com 

 

1.2 BRIEF DESCRIPTION OF THE SOFTWARE        

 

EffiValidation 3.0 is database software designed to:  

V Plan and evaluate validations of analytical (chemical and microbiological) methods and to archive data 

and validation results (in accordance with EN ISO/IEC 17 025:2001, ICH, USP and FDA, Eurachem 

guides and D.L. Massart et al., Handbook of Chemometrics and Qualimetrics, Part A, Elsevier, 

Amsterdam, 1997) 

V Develop and use calibration models (according to ISO 8466:1 and 2 Standard) 

V Develop and use control charts (ISO 8258 Standard) 

V Determine uncertainties of analytical results (e.g. EURACHEM/CITAC Guide) 

V Evaluate inter-laboratory comparisons (ISO 5725-2 Standard) 

V Handle electronic records (21 CFR Part 11: Samples and Results, Specifications, Equipment, 

Deviations, Contacts, Reference Standards, Chemicals and Volumetric Solutions)  

mailto:effichem@effichem.com
mailto:sales@effichem.com
mailto:support@effichem.com
http://www.effichem.com/
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The software allows separate evaluation of (i) Exploratory (ii) Full and (iii) Retrospective validation of testing 

methods and the evaluation of (iv) System Suitability tests and (v) Method Transfer data, recorded when 

transferring method from a development to a receiving laboratory or from an approved to a receiving laboratory.  

With respect to PhEur (European Pharmacopoeia) and FDA (Food and Drug Administration) requirements, 

EffiValidation 3.0 software enables users to validate analytical methods for pharmaceutical use, i.e. methods to 

determine assay, impurities (quantitative/limit tests), physical parameters and identity. It also offers the 

evaluation of HPLC characteristics (for System Suitability testing). 

The choice of validation depends on several aspects: whether the method to be validated is normalized or not, 

whether it is a new or a modified normalized method, etc. In addition, it also depends on the application, on the 

range of the method, on the goal of validation, etc.  

The Inter-laboratory Comparison module extends the possibilities of the (internal) validation module by external 

validation. 

 
The basis of the EffiValidation 3.0 software is a database of Analytical Methods, which are the subject of 

Validation, Inter-laboratory Comparison, Calibration, regulation by means of Control Charts and/or subject of 

determination Uncertainties. The database is created by the user(s) and guarantees 100% traceability of all data 

and results for users as well as auditors/inspectors performing audit trials. Records in the database can be printed 

or exported to other applications working in the Microsoft Windows environment.  

Access to the database is managed by a system of Login Names and Passwords granted by the System 

Administrator, developed to comply with 21 CFR Part 11. 

 

All operations carried out by EffiValidation 3.0 are recorded in the Global Audit Trials and History log sections 

so that the System Administrator can trace back user interactions with the software. 

 

The software is distributed in two language versions: English and Czech. User support is provided by means of 

the software Help, software Instructions and by the documentation, including this User's Guide, Userôs Tutorial, 

Book of Reference Examples and Functional Specifications for the computer system. 

 

1.3 REQUIREMENTS OF THE ISO/IEC 17 025 STANDARD      

 

1.3.1 VALIDATION OF METHODS      

 

The ISO/IEC 17 025 standard defines validation as ñThe confirmation by examination and the provision of 

effective evidence that the particular requirements for a specific intended use are fulfilledò. The standard 

provides further explanation given below. 

 

The laboratory shall validate non-standardized methods, laboratory-designed/developed methods, standardized 

methods used outside their intended range and amplifications of standardized methods to confirm that the 

methods are fit for the intended use. The validation shall be as extensive as is necessary to meet the needs in the 

given application or field of application. The laboratory shall record the results obtained, the procedure used for 

the validation, and a statement as to whether the method is fit for the intended use. 

 

The range and accuracy of the values obtainable from validated methods (e.g. the uncertainty of the results, 

detection limit, selectivity of the method, linearity, limit of repeatability and/or reproducibility, robustness 

against external influences and/or cross-sensitivity against interference from the matrix of the sample/test 

object) as assessed for the intended use shall be relevant to the clientôs needs. 

 

NOTE 1: Validation includes the specification of the requirements, determination of the characteristics of the 

methods, the comparison of the requirements with the values of the characteristics of the method, and a 

statement on the validity. 

 

NOTE 2: The techniques used for the determination of the characteristics of a method should be one of, or a 

combination of, the following: calibration using reference standards or reference materials, comparison of 

results achieved with other methods, inter-laboratory comparisons, systematic assessment of the result, 

assessment of the uncertainty of the results based on scientific understanding of the theoretical principles of the 

method, and practical experience. 
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NOTE 3: As method development proceeds, regular review is required to verify that the needs of the client are 

still being fulfilled.  Changing requirements requiring modifications to the development plan should be approved 

and authorized. 

 

NOTE 4: Validation is always a balance between costs, risks and technical possibilities. 

 

1.3.2 ESTIMATION OF UNCERTAINTIES     

 

As far as the uncertainty estimation is concerned, ISO/IEC 17 025 standard states that ñA calibration 

laboratory, or a testing laboratory performing its own calibrations, shall have and apply a procedure to estimate 

the uncertainty of measurement for all calibrations and for all types of calibrationsò. The standard provides 

further explanation given below. 

 

Testing laboratories shall also have and apply procedures for estimating uncertainties of measurement, except 

when the test methods preclude such rigorous calculations. In certain cases it is not possible to undertake 

metrologically and statistically valid estimations of uncertainty of measurement. In these cases the laboratory 

shall at least attempt to identify all the components of uncertainty and make the best possible estimation, and 

ensure that the form of reporting does not give an exaggerated impression of accuracy. 

 

NOTE: In those cases where a well-recognized test method specifies limits to the values of the major sources of 

uncertainty of measurement and specifies the form of presentation of calculated results, the laboratory is 

considered to have satisfied this clause by following the reporting instructions. 

 

When estimating the uncertainty of measurement, all uncertainty components which are of importance in the 

given situation shall be taken into account using accepted methods of analysis. 

 

NOTE 1: Sources contributing to the uncertainty include, but are not necessarily limited to, the reference 

standards and reference materials used, methods and equipment used, the environmental conditions, the 

condition of the item being tested or calibrated and the operator. 

 

NOTE 2: The predicted long-term behavior of the tested and/or calibrated item is normally not taken into 

account when estimating the measurement uncertainty. 

 

NOTE 3: For further information see ISO 5725-1 and the Guide to the Expression of Uncertainty in 

Measurement (see bibliography). 

 

1.3.3 SOFTWARE VALIDATION     

 

The ISO/IEC 17 025 standard states that: When computers or automated equipment are used for the acquisition, 

processing, recording, reporting, storage or retrieval of test or calibration data, the laboratory shall ensure 

that: 

a) computer software developed by the user is documented in sufficient detail and suitably validated or 

otherwise checked as being adequate for use: 

b) procedures are established and implemented for protecting the integrity of data; such procedures shall 

include, but not be limited to, integrity and confidentiality of data entry or collection, data storage, data 

transmission and data processing; 

c) computers and automated equipment are maintained to ensure proper functioning and are provided 

with the environmental and operating conditions necessary to maintain the integrity of test and 

calibration data. 

NOTE: Commercial software (text editors, databases, statistical software) in general use within its designed 

application range may be considered sufficiently validated. 

Configuration and modifications of the software should be validated. 

 

Detailed information regarding software validation can be found in: 

- GAMP 4: Guide for Validation of Automated Systems, ISPE, December 2001 

- General Principles of Software Validation; Final Guidance for Industry and FDA Staff: FDA ï CDRH, 

11.1. 2002 

- Good Practices for Computerized Systems in Regulated ñGXPò Environments: PIC/S, Draft, 14.1. 

2002. 
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1.3.4 EQUIPMENT AND LABORATORY     

 

The ISO/IEC 17 025:2001 standard states that: The laboratory shall be furnished with all items of sampling, 

measurement and test equipment required for the correct performance of the tests and/or calibrations (including 

sampling, preparation of test and/or calibration items, processing and analysis of test and/or calibration data). 

In those cases where the laboratory needs to use equipment outside its permanent control, it shall ensure that the 

requirements of this International Standard are met. 

Equipment and its software used for testing, calibration and sampling shall be capable of achieving the accuracy 

required and shall comply with specifications relevant to the tests and/or calibrations concerned. Calibration 

programmes shall be established for key quantities or values of the instruments where these properties have a 

significant affect on the results. When received, equipment, including that used for sampling, shall be checked to 

establish that it meets the laboratoryôs specification requirements, complies with the relevant standard 

specifications, and shall be checked and/or/ calibrated in accordance with measurement traceability before use. 
 

Equipment shall be operated by authorized personnel. Up-to-date instructions on the use and maintenance of 

requirement (including any relevant manuals provided by the manufacturer of the equipment) shall be readily 

available for use by the appropriate laboratory personnel. 

 

Each item of equipment used for testing and calibration and significant to the result shall, when practicable, be 

uniquely identified. 

 

Records shall be maintained of each item of equipment significant to the tests and/or calibrations performed. 

The records shall include at least the following: 

a) identity of the item of equipment; 

b) manufacturerôs name, type identification, and serial number or other unique identification; 

c) checks that equipment complies with the specification; 

d) current location, where appropriate; 

e) the manufacturerôs instructions, if available, or reference to their location; 

f) dates, results and copies of reports and certificates of all calibrations, adjustments, acceptance 

criteria, and due date of next calibration; 

g) maintenance carried out to date and the maintenance plan; 

h) damage, malfunction, modification or repair to the equipment.ò 

 

The laboratory shall have procedures and have an established plan for safe handling, transport, storage, use 

and maintenance of measuring equipment to ensure proper functioning and in order to prevent contamination or 

deterioration. 

1.4 REQUIREMENTS OF PH.EUR. AND USP         

 

1.4.1 VALIDATION  OF METHODS     

 

Several pharmaceutical guides were published regarding the analytical method validation. The most important 

ones are: 

¶ ICH-Q2A ñText on Validation of Analytical Procedure 

¶ ICH-Q2B ñValidation on Analytical Procedures: Methodology 

¶ CDER ñReviewer Guidance: Validation of Chromatographic Methodò  

¶ CDER ñSubmitting Samples and Analytical Data for Method Validationsò 

¶ CDER Draft ñAnalytical Procedures and Method Validationò  

¶ CDER ñBio-analytical Method Validation for Human Studiesò  

¶ USP: ñValidation of Compendial Methodsò (current revision) 

 

In the pharmaceutical industry, every analytical method used in the process of a drug registration must be 

validated and the validation documented by results. For chromatographic methods, system suitability tests must 

be developed. Methods used to control cleaning validation, dissolution testing and stability testing must be 

validated accordingly. 

Validation of a method is a procedure that follows after the method development and optimisation. It consists of 

verification and documentation that the method is suitable for the intended use.  

Typical validation characteristics include: Precision (Repeatability, Intermediate Precision, Reproducibility), 

Accuracy, Selectivity/Specificity, Limit of Detection and Limit of Quantification, Linearity and Range, and 



12/115 

5/5/2010  Userôs Guide EffiValidation 3.0  version: 2.505     

 
 

Robustness. Depending on the intended use of the method (assay, impurities, identity, physical parameters) 

PhEur and USP recommends evaluating validation characteristics based on the following table:  

 
Validation parameter Category 

Assay Impurities  Physical 

parameters 

Identity  

Quantitatively  Limit test  

Precision + + *  + - 

Accuracy + + *  *  - 

Selectivity/Specificity + + + *  + 

Limit of detection -  + *  - 

Limit of quantification - + - *  - 

Linearity + + - *  - 

Range + + *  *  - 

Robustness + + + + - 

Parameter indicated + are required, parameters indicated * may be required. 

 

 

1.4.2 VALIDATION  OF SOFTWARE    

 

Requirements for software validation in the pharmaceutical industry are specified in the guide from the Food and 

Drug Administration (FDA): ñGeneral Principles of Software Validation; Final Guidance for Industry and FDA 

Staffò, FDA ï CDRH, 11.1. 2002.  

This guide states that: Any software used to automate any part of the device production process or any part of 

the quality system must be validated for the intended use. Software validation is defined to be ñconfirmation by 

examination and provision of objective evidence that software specifications conform to user needs and intended 

uses, and that the particular requirements implemented through software can be consistently fulfilled. Validation 

typically includes evidence that all software requirements have been implemented correctly and completely and 

are traceable to system requirements. 

Software has to be validated throughout the entire software life cycle model, which typically includes the 

following (General Principles of Software Validation; FDA): 

¶ Quality Planning (the management) 

¶ System Requirements Definition 

¶ Detailed Software Requirements Specification 

¶ Software Designs Specification (future structure) 

¶ Construction or Coding (implementation of requirements to the source code) 

¶ Testing (integration and testing to confirm compliance with the specification) 

¶ Installation (testing of the installed version in the end-user environment) 

¶ Operation and Support 

¶ Maintenance (upgrade, replacement of components, etc.) 

¶ Retirement 

 

Verification, testing, and other tasks that support software validation occur during each of these activities. 

 

1.4.3 ELECTRONIC RECORDS AND SIGNATURES    

 

Requirements regarding Electronic Records and Signatures highlighted by the Final Rule 21 CFR Part 11: The 

final rule provides criteria under which FDA will consider electronic records to be equivalent to paper records, and 

electronic signatures equivalent to traditional handwritten signatures. Part 11 (21 CFR part 11) applies to any paper records 

required by statute or agency regulations and supersedes any existing paper record requirements by providing that 

electronic records may be used in lieu of paper records. Electronic signatures which meet the requirements of the rule will be 

considered to be equivalent to full handwritten signatures, initials, and other general signings required by agency 

regulations. 

Section 11.2 provides that records may be maintained in electronic form and electronic signatures may be used in lieu of 

traditional signatures. Records and signatures submitted to the agency may be presented in an electronic form provided the 

requirements of part 11 are met and the records have been identified in a public docket as the type of submission the agency 

accepts in an electronic form. Unless records are identified in this docket as appropriate for electronic submission, only 

paper records will be regarded as official submissions.  

Section 11.3 defines terms used in part 11, including the terms: Biometrics, closed system, open system, digital signature, 

electronic record, electronic signature, and handwritten signature.  

Section 11.10 describes controls for closed systems, systems to which access is controlled by persons responsible for the 

content of electronic records on that system. These controls include measures designed to ensure the integrity of system 
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operations and information stored in the system. Such measures include: (1) Validation; (2) the ability to generate accurate 

and complete copies of records; (3) archival protection of records; (4) use of computer-generated, time-stamped audit trails; 

(5) use of appropriate controls over systems documentation; and (6) a determination that persons who develop, maintain, or 

use electronic records and signature systems have the education, training, and experience to perform their assigned tasks. 

Section 11.10 also addresses the security of closed systems and requires that: (1) System access be limited to authorized 

individuals; (2) operational system checks be used to enforce permitted sequencing of steps and events as appropriate; (3) 

authority checks be used to ensure that only authorized individuals can use the system, electronically sign a record, access 

the operation or computer system input or output device, alter a record, or perform operations; (4) device (e.g., terminal) 

checks be used to determine the validity of the source of data input or operation instruction; and (5) written policies be 

established and adhered to holding individuals accountable and responsible for actions initiated under their electronic 

signatures, so as to deter record and signature falsification.  

Section 11.30 sets forth controls for open systems, including the controls required for closed systems in Ä 11.10 and 

additional measures such as document encryption and use of appropriate digital signature standards to ensure record 

authenticity, integrity, and confidentiality.  

Section 11.50 requires signature manifestations to contain information associated with the signing of electronic records. This 

information must include the printed name of the signer, the date and time when the signature was executed, and the meaning 

(such as review, approval, responsibility, and authorship) associated with the signature. In addition, this information is 

subject to the same controls as for electronic records and must be included in any human readable forms of the electronic 

record (such as electronic display or printout). 

Under Ä 11.70, electronic signatures and handwritten signatures executed to electronic records must be linked to their 

respective records so that signatures cannot be excised, copied, or otherwise transferred to falsify an electronic record by 

ordinary means.  

Under the general requirements for electronic signatures, at Ä 11.100, each electronic signature must be unique to one 

individual and must not be reused by, or reassigned to, anyone else. Before an organization establishes, assigns, certifies, or 

otherwise sanctions an individualôs electronic signature, the organization shall verify the identity of the individual. 

Section 11.200 provides that electronic signatures not based on biometrics must employ at least two distinct identification 

components such as an identification code and password. In addition, when an individual executes a series of signings during 

a single period of controlled system access, the first signing must be executed using all electronic signature components and 

the subsequent signings must be executed using at least one component designed to be used only by that individual. When an 

individual executes one or more signings not performed during a single period of controlled system access, each signing 

must be executed using all of the electronic signature components. Electronic signatures not based on biometrics are also 

required to be used only by their genuine owners and administered and executed to ensure that attempted use of an 

individualôs electronic signature by anyone else requires the collaboration of two or more individuals. This would make it 

more difficult for anyone to forge an electronic signature. Electronic signatures based upon biometrics must be designed to 

ensure that such signatures cannot be used by anyone other than the genuine owners. 

Under Ä 11.300, electronic signatures based upon use of identification codes in combination with passwords must employ 

controls to ensure security and integrity. The controls must include the following provisions: (1) The uniqueness of each 

combined identification code and password must be maintained in such a way that no two individuals have the same 

combination of identification code and password; (2) persons using identification codes and/or passwords must ensure that 

they are periodically recalled or revised; (3) loss management procedures must be followed to de-authorize lost, stolen, 

missing, or otherwise potentially compromised tokens, cards, and other devices that bear or generate identification codes or 

password information; (4) transaction safeguards must be used to prevent unauthorized use of passwords and/or 

identification codes, and to detect and report any attempt to misuse such codes; (5) devices that bear or generate 

identification codes or password information, such as tokens or cards, must be tested initially and periodically to ensure that 

they function properly and have not been altered in an unauthorized manner. 
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CHAPTER 

2 
HARDWARE REQUIREMENTS , SOFTWARE 

PACKAGE , INSTALLATION ,  

GETTING STARTED , ACCESS CONTROL 
 

This chapter covers the following topics: 

 

Á Summary of hardware and software requirements to run EffiValidation 3.0 

Á Information about the software package and installation 

Á Getting started with the software 

Á Access control ð Login Name and Password  

2.1 HARDWARE AND SOFTWARE REQUIREMENTS          

 

CPU:    Pentium 400MHz  or higher 

RAM:    32MB (minimum), 128MB (recommended) 

Free hard disk space:  28MB for installation of software, approx. 100MB for database  

Display resolution:  800 x 600 (minimum) 

Operation system:  Windows 98, 2000, NT (with Service Pack 5), XP or Windows 7 

 

2.2 SOFTWARE PACKAGE AND INSTALLATI ON         

 

The EffiValidation 3.0 software is supplied on an installation CD with a hardware key. Without this key, the 

software runs as a DEMO version only (can also be downloaded from www.effichem.com). The software 

package includes the following documentation: Functional Specification for computer systems, Userôs Guide 

(including Userôs Tutorial) and Book of Reference Examples. 

Installation components needed: 
 

Single user installation (full version) 

- Program files 

- Help files (optional) 

- Firebird server  

- Firebird client 

- Database 
 

Network installation ï server (see Fig. 2.1) 

- Program files (optional) 

- Help files (optional) 

- Firebird server  

- Database 
 

Network installation ï client (see Fig. 2.1) 

- Program files 

- Help files (optional) 

- Firebird client 

ñDatabaseò must not be installed on any network - client!   Fig. 2.1: Installation components 
 

Detailed information about the Firebird database engine, including the terms and conditions of the licence 

agreement, is available at www.ibphoenix.com 

http://www.effichem.com/
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Procedure to install the software: 

- Insert installation CD into a CD drive. Alternatively, run the version downloaded from the Website. 

- The Auto-run program will start the installation automatically. If this does not happen, run the setup_en.exe 

file, which will start the installation, i.e. open the window Setup ï EffiValidation. The installation guide will 

guide you through the complete installation process. The procedure is as follows:  

¶ In the Setup ï EffiValidation window, click Next 

¶ Read carefully terms and conditions of the Licence Agreement. Select ñI accept the agreementò and 

click Next if you agree with the agreement. Otherwise, select ñI do not accept the agreementò and 

stop the installation. 

¶ Select Destination Directory where you would like EffiValidation be installed. 

Default C:\Program files\EffiValidation 3.0. Then click Next 

¶ Select Components which should be installed. First select among:  Full (single-user) installation, 

Server installation, Client installation (database on the server) and Custom installation. If necessary, 

select the components to be installed. Click Next when you are ready to continue. 

¶ Select Start Menu Folder, default EffiValidation 3.0 

¶ Select Additional Tasks, other icons and HW key 

¶ Ready to Install window is opened summarizing the entered information. Click Install to continue 

with the installation.  

¶ The software is installed.  

¶ Completing the EffiValidation Setup Wizard is opened. To complete the installation of the 

EffiValidation, Setup must restart your computer. Select Yes, to restart the computer immediately 

or No, to restart the computer later. 

 

When the installation is complete, the EffiValidation 3.0 program group is created with the following items: 

EffiValidation 3.0, EffiValidation on the Web, Help and Uninstall.  

2.3 RUNNING THE SOFTWARE            

 

Run the software by clicking the EffiValidation 3.0 icon, or choose Start > Programs > EffiValidation 3.0 > 

EffiValidation 3.0. The User Verification window is displayed (see also Chapter 2.4.). There, the user shall enter 

Login Name and Password. Default Login Name and Password to be used after the software delivery is admin 

and admin. Both can be changed from Tools > List of Software Users. 

If the entered data are correct, the main EffiValidation 3.0 window is opened followed by the Tips and Tricks 

window. The menu in the main EffiValidation 3.0 window is used to handle analytical methods in the database, 

to insert data, to evaluate results and to view and print results/graphs. The user can also enter and edit data in all 

electronic record books (Samples, Specifications, Equipment, Documents, Deviations, Contacts, Reference 

Standards, Chemicals and Volumetric Solutions).  

 

When start up of the software is not successful, because the connection to database cannot be established, an 

error message appears:  

ñAn error occurred while connecting to Database. I/O error for file C:\Program files\EffiValidation 3\Ev.gdb. 

Error while trying to open file. The system cannot open the given file.ò 

There may be two reasons for this message: 

(a) database is not available, e.g. because the given installation is a network ï client installation. In this case, the 

window ñConnection Settingsò is opened, where it is necessary to enter: 

 ǒ Server Name  - name or IP address of the server, where the common database is located 

 ǒ Database  - path to database on the server, e.g. C:\Program files\EffiValidation 3\Ev.gdb 

 ǒ Protocol  - the protocol to be applied, e.g. TCP/IP 

Click Save. 

(b) The Firebird Guardian and/or the Firebird server is not running on server. In this case, it has to be started 

from Control Panel > Firebird Service Manager, where all checkboxes should be checked: 

 ǒ Autostart Firebird Server in Windows startup 

 ǒ Run Firebird as service 

 ǒ Use Firebird Guardian 
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Fig. 2.2: Firebird Service Manager window 

2.4 ACCESS CONTROL             

 

EffiValidation 3.0 is protected from non-authorized use by a system of access control, i.e. by Login Names and 

Passwords, consisting of four Levels:  
 

System Administrator: is responsible for installation and configuration of the software. It is the only user with 

access to the Database Manager and Password and Electronic Records Policy window, etc.  
 

Software Administrator:  has the right to edit and view all data and to assign access of individual users to 

Analytical Methods (List of Methods > Access) and other software functions. Software Administrator also has 

access to List of Software Users (Tools > List of Software Users) enabling them to define Login Names and 

Passwords, and to Database (Tools > Database) enabling them to Backup and Restore database.  

Software Administrator is usually the head of the laboratory, head of a working group or the quality manager of 

the laboratory.  
 

User: software user with the right to edit data related to an Analytical Method created by the user of the given 

Login Name or belonging to an Analytical Method to which access has been authorized by the Administrator 
 

Host: software user with the right to view data related to an Analytical Method to which access of the Host user 

has been authorized by the Administrator. 

 

After starting the software, the User Verification window is displayed. If the entered Login Name and Password 

are correct, the EffiValidation 3.0 software is started. Otherwise, the application is closed.  
 

 
Fig. 2.3: User Verification window 

 

EffiValidation 3.0 is supplied with a predefined System Administrator Login Name and Password. For other 

users, Administrator can establish the Login Names and Passwords through the menu: Tools > List of Software 

Users > New.  

2.5 21 CFR PART 11            

 

The EffiValidation 3.0 software is equipped with tools to comply with 21 CFR Part 11: 

- Access controls (see 2.4) 

- Automatically generated Global Audit Trials and History of electronic records (see 9.11) 

- Unique secure electronic signatures (see 9.8) 

- Ability to disclose deleted records, i.e. record bin (see 4.3) 

Global Audit Trial and History consistently records the User Name, Computer Name, Date and Time of entering 

and editing data and performing software operations. All data entered and saved in the software are stored in a 

database; data handling is recorded in History, without any option of changing, re-writing or concealing previous 
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information. Also, data deleted using the function ñDeleteò are kept in a re-cycle Bin, from which they can be 

displayed or restored. 

 

The History window can be, through the whole software (in the List of Methods window, Data Table window, 

electronic Record Books, etc.), opened by clicking the History button. The appearance of the opened History 

window is the same as at the given Date and Time.  
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CHAPTER 

3 
SOFTWARE HANDLING , MENUS AND ICONS 

 

This chapter covers the following topics: 
 

Á Basic rules for handling the EffiValidation 3.0 software  

Á Main window of the EffiValidation 3.0 software 

Á Main menu and icons within the software interface 

3.1 SOFTWARE HANDLING            

 

Basic rules for handling the software are similar to other programs in the Microsoft Windows environment. 

Basic elements are windows. Every window contains a title in the left upper corner and buttons with maximize, 

minimize and close function in the right upper corner.  
 

For quick switching between windows, the standard Microsoft Windows key combinations can be used: 

<Alt>+<Tab> ð switching between windows containing running applications and <Alt>+<F4> ð closing the 

current window without any confirmation. 

3.2 EFFIVALIDATION  3.0 M AIN WINDOW           

 

After entering the Login Name and Password in the User Verification window (for details, see chapter 2.4) the 

EffiValidation 3.0 main window is opened: 

 

 
Fig. 3.1: EffiValidation 3.0 window 

 

This window shows from top to bottom: Title bar, Menu bar, Method Under Evaluation bar, Icon panel (on the 

left side), Info panel (on the right side) and the Status bar.  
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The Method Under Evaluation bar shows the Key of the Analytical Method (see 4.2) that is currently being 

evaluated. On the right side of the bar, the Method Key Settings icon is displayed, opening the Method Key 

Settings window 

 
Fig. 3.2: Method Key Settings window 

 

Icons left below the Method Under Evaluation bar enable users to run some functions of the software without 

using the main Menu (see 3.3).  

 

The Info panel contains the tabs Welcome to EffiValidation 3.0, Contact, Notice Board and Validation Report 

(report from the Operation Qualification of the installed version). 

 

The status bar at the bottom of the EffiValidation 3.0 main window displays the software Version (build), Date, 

Login Name of the current user and HW key number. 

3.3 MENU, ICONS AND INFO PANEL           

 

The EffiValidation 3.0 main window contains the following Menu: 

 
Analytical Methods Validation Inter-laboratory Comparison QC Tools Record Books Tools  Help 

 

Individual menu items are described in detail in the following chapters.  

 

The core part of the software is a database of Analytical Methods that are subject to Validation, Inter-laboratory 

Comparison, Calibration, and regulation by means of Control Charts and/or subject to determination of 

Uncertainties. For this reason, the item Analytical Methods is the first one in the main menu. Validation , Inter -

laboratory Comparison and QC Tools are items for performing calculations. Record Books are designed to 

manage electronic records (Book of Samples, Book of Equipment, Book of Documents, etc.). The Tools menu 

enables users to carry out IQ/OQ, to set up user defined parameters for Data and Calculations, to manage the List 

of Users and Database and to set up a security policy. The last item in the menu bar is Help. 

 

On the Icon panel, i.e. on the left side of the EffiValidation 3.0 main window, the following icons are located for 

direct access to key features of the software (thus eliminating the need to use the main menu): 

  List of Methods             

  Exploratory Validation  

  Full Validation 

  HPLC ï FDA 

  HPLC ï Ph.Eur. 

  Control Charts 

  Calibration 

  Uncertainties 

  Operational Qualification  

  Book of Samples 

  Book of Equipment 

  Book of Documents 

Functions represented by the icons can be started by double-clicking the icons. 

 

In the Info Panel, i.e. on the right side of the EffiValidation 3.0 main window, the following tabs are located: 

  Welcome to EffiValidation 3.0 (see Fig. 3.1)  

  Contact 

  Notice Board 

  Validation Report (software OQ report, see chapter 9.2)  
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CHAPTER 

4 
ANALYTICAL METHODS 

 

This chapter covers the following topics: 

 

Á Analytical Methods menu in the EffiValidation 3.0 main window  

Á New Method window 

Á List of Methods window  

Á Closing Method item  

Á Closing EffiValidation 3.0 item  

4.1 DATABASE OF ANALYTICAL METHODS          

 

The core of the EffiValidation 3.0 software is a database of Analytical Methods, which are subject to Validation, 

Inter-laboratory Comparison, Calibration, and regulation by means of Control Charts and/or subject to 

determination Uncertainties.  

 

Therefore, Analytical Methods is the first main menu item. It comprises the following possibilities:   

New Method   - Definition of a new Analytical Method (see figure below). 

List of Methods  - Handling of methods in the database  (see chapter 4.3). 

Close Method - Closing Method Under Evaluation by the given user 

Close EffiValidation 3.0 - Exiting the software EffiValidation 3.0 

 

4.2 NEW M ETHOD            

 

Clicking on New Method opens the New Method window. Every method in the database of EffiValidation 3.0 is 

characterized by a unique KEY, consisting of 6 items: (method) Material  (matrix) ï Project ï Method Used ï

Series ï Date ï Number: 

 

 
Fig. 4.1: New Method window 
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These KEY items characterize the Analytical Method and have the following meanings:  

 Material  -  Name of the material/matrix that the method being validated is applied to. 

Examples: Blood serum, Drinking water, etc. 

 Project -  Project title. Examples: Amphetamines and Metabolites, Nitrates and Nitrites, etc. 

 Method Used -  Type of analytical method used. Examples: GC, UV, etc. 

 Series -  Auxiliary number (from 1 to 9) used to sort methods in the List of Methods. 

Example: 1. It can be used to sort Methods with respect to e.g. working groups 

 Date -  Date characterizing the given method. Default date is the date of inserting the 

method into the database.  Example: 5.5. 2003. 

 Number -  Identification number of the Method in the laboratory documentation. Example: 

M.0025, CH.0003, etc. 

 

Users can enter three additional items: 

 Version - Version of the method. Example: 1.01 or 1979 

 Standard - Reference to a standard in case the method is standardized. Example: ISO 4182: 

1979. 

 Analyst - First Name and Surname of the Analyst. Example: George Smith. Entering and 

changing the analyst is accomplished through the List of Analysts (see 9.7). 

 

4.2.1 VALIDATED PROPERTY  

    

Below the method items, the list of Validated Properties is displayed: 

 Validated Property - Validated Property as described below. Example: Nitrates: NO3-, Nitrites: NO2-. 

Entering and changing of Validated Properties is accomplished through the control 

buttons Save, New, Edit and Delete  

 Note - User note concerning the given Validated Property 
 

Entering a New or Editing an existing Validated Property is done using the Validated Property window. The user 

enters the name of the Validated Property and Note (in the General tab, see Fig. 4.2.a), e.g. 4-

Hydroxyamphetamine  

 

 
Fig. 4.2 a): Validated Property window: General tab 

 

Eventually, the user can select where to display this Validated Property (in the Display in Algorithms tab, see 

Fig. 4.2.b). Default setting is to display Validated Property in all algorithms: 

 

 
Fig. 4.2 b): Validated Property window: Display in Algorithms tab 

 

After entering all data for the new Validated Property (Fig. 4.2.a), click the Save button to save the entered 

Validated Property in the list of Validated Properties and to return to the New Method window.  

By clicking Delete, the selected Validated Property is moved to the Bin (of Validated Properties), clicking 

History opens the History window with all time records regarding the selected Validated Property: 
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Fig. 4.3: History of Validated Property window 

 

Click on Display to open the Edit Method window as saved in History under the given Record Date/Time: 

 

 
Fig. 4.4: Edit Method window as saved in History under the given Record Date/Time 

 

 

4.2.2 ANNEXES       

 

On the Annexes tab, the user can enter New, or Edit, Delete or Open existing Annexes of the given Method. 

 

 
Fig. 4.5: Annexes window 

 

 Description - Description of the Annex, Example: SOP method CH.0003 

 Note - Path to the Annex file saved on the disc, enabling the user to Open it (type the path 

or use the icon to insert the path) 

Finally, when validation of the method is finished and satisfactory results have been achieved, a Method 

Declaration and method Note can be filled in via the Edit Method window. This declaration usually states, ñThe 

given method is suitable for the intended useò. 

 

4.3 L IST OF METHODS            

 

The List of Methods window allows handling of methods: 
 

 
Fig. 4.6: List of Methods window 
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Radio-buttons: All, This Month, This Week, Today, Period From... To ... enable filter and display of Analytical 

Methods in the List of Methods window based on the time interval.  

Checkbox ñDisplay Binò on the right side displays the List of Methods that were removed from the current List 

of Methods and that have been placed in the Bin.  
 

The buttons on the right side of the window have the following meanings: 

Close  - Closing the List of Methods window 

New  - Defining a new Analytical Method (see chapter 4.2) 

Edit - Editing data of the existing method highlighted in List of Methods using the cursor (see 

chapter 4.2) 

Delete - Reversible deletion of the selected Method from the actual List of Methods to the recycle 

Bin. After answering ñYesò to the dialog question: ñDo you really want to delete this 

method?ò the method is removed. The removed method can be restored from the Bin by 

clicking on Restore 

Print - Printing the selected Method, printing List of Methods or viewing Preview or Editing 

Print Report (see 4.3.1) 

Refresh - Refreshing the List of Methods, aiming to display methods entered by other users when 

running the software as a network application 

Apply  - Selecting the method highlighted in the List of Methods window as the Method Under 

Evaluation, i.e. Method to be statistically assessed 

Access  - Controlling access of users to Analytical Methods in the database (see 4.3.3) 

Export  - Exporting the List of Methods and Saving as (see 4.3.4)  

History - Displaying History of the Method (see 4.3.2) 

Legend  - Checkbox to display/close the Legend in the List of Methods window 
 

Legend shows the access details: black methods have been entered by the user currently using the software, red 

methods are accessible to the given user but not created by him, and grey methods are not accessible to the given 

user.  

The software allows users to Sort and to Search for Analytical Methods according to any item of the method 

KEY. Sorting (ascending/descending) is done by clicking the column header (e.g. Number, see Fig. 4.6, 

indicated by the arrow up/down); Searching is done by clicking the given column header and typing the required 

string from the keyboard, e.g. by clicking the Project column and typing the required string: 

. Data to evaluate validation parameters are entered from the Validation menu, data to 

evaluate inter-laboratory studies from the Inter-laboratory Comparison menu and data to evaluate Calibrations, 

Control Charts and Uncertainties from the QC Tools menu. 
 

4.3.1 PRINT       

 

Print Method   - Printing the Method information as shown in 4.2 

Print List of Methods - Printing the List of Methods as shown in 4.3 (Figure 4.6) 

Preview  - Previewing the Method or List of Methods prior to printing 

Edit Print Report - Editing the Method or List of Methods Print Report (for details on Editing Print 

Reports see 5.2.4) 

 

4.3.2 HISTORY       

 

For every Analytical Method , the History window shows the Record Date, Record Time, method Number, 

Project name, Created by ï Changed by, El. Signature ï Meaning (if applicable) and Computer Name 

 

 

Fig. 4.7: History of the Analytical Method  window 
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Clicking on Display opens the historical Edit Method window, named History, showing details including who 

Created and Changed by the given method, the Validated Properties and Annexes 

 

 
Fig. 4.8: Edit Method window in History 

 

4.3.3 ACCESS CONTROL      

 

All Administrators (see 2.4 and 9.5) automatically have access to all methods in the List of Methods. Access of 

Users and Hosts is managed through the Analytical Methods Access Control window.  

In this window, the Administrator can check checkboxes with names of individual Users and Hosts to which the 

currently selected method should be accessible (red) / inaccessible (grey). 

  

 
Fig. 4.9: Analytical Methods Access Control window 

 

4.3.4 EXPORT       

 

Exporting the List of Methods to TXT, CSV or XLS format: 
 

 
Fig. 4.10: Export from List of Methods window 
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Save in  - Target directory where the exported file is saved  

File name  - Name of the file with the exported data 

Save as type  - Type of exported file: TXT, CSV, XLS 

 
4.4 CLOSING THE ANALYTICAL METHOD AND THE  EFFIVALIDATION 3.0 APPLICATION     

 

Choose Close Method from the Analytical Methods menu to terminate the evaluation of the given Method 

Under Evaluation as the given user.  

 

To close the EffiValidation 3.0 window, choose Close EffiValidation 3.0 from the menu.  
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CHAPTER 

5 
VALIDATION  

This chapter covers the following topics: 
 

Á Validation types considered in EffiValidation 3.0 

Á Entering and handling data in the Data Table window 

Á Methods and procedures used to evaluate individual validation parameters 

Á Typical extents of validation parameters evaluation  

5.1 VALIDATION TYPES             

 

5.1.1 SELECTION OF THE ALGORITHM (VALIDATION PARAMETER)    

 

For the considered Analytical Method , choose the validation type from the Validation menu or click the 

corresponding icon in the EffiValidation 3.0 main window. Then select the algorithm (validation parameter): 

 

Exploratory - Aims to validate the Analytical Method  that is a candidate for consequent 

Full Validation. It comprises the evaluation of parameters that are most 

delicate (can most probably cause unsatisfactory validation results): 

  -  Selectivity   

    -  Robustness   

    -  Repeatability   

Full - Complete validation of a method based on the evaluation of all validation 

parameters: -  Repeatability 

    -  Reproducibility  

       -  Robustness   

       -  Accuracy 

    -  Selectivity   

    -  Sensitivity  

    -  Linearity  

    -  Limit of Detection and Limit of Quantification  

    -  Range  

    - Intermediate Precision 

    - Blank 

Full validation is performed after successful exploratory validation and for 

new methods it can be considered as a standard validation choice. 

System Suitability - Aims to check whether the earlier Full Validated method continues to 

provide results comparable to results from the Full validation. The 

parameters usually evaluated include:  

       -  Linearity (to check linearity of the method) 

    -  Sensitivity (to verify the calibration line) 

    -  Blank (to verify the response of the blank) 

Method Transfer - Validation performed when transferring a method (1) from a development 

to a receiving laboratory, or (2) from a standard to receiving laboratory. It is 

assumed that criteria such as Repeatability, Linearity, Limit of Detection, 

Limit of Quantification, etc. are presented in the standard. The minimum 

number of parameters checked during the Method Transfer is:  

    -  Accuracy  

    -  Reproducibility  

    -  Repeatability 

Retrospective - Validation of a method performed based on analysis of historical data.  
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 Usually includes the evaluation of: 

    - Repeatability 

    - Intermediate Precision 

    - Reproducibility       

Assay Determination - Validation of a method to determine assay with respect to Ph.Eur. and 

FDA requirements. Evaluation of: 

    - Repeatability  

    - Accuracy  

    - Selectivity  

    - Linearity  

    - Range  

    - Robustness  

Quantitative Impurity Determination - Validation of a method to determine an impurity with respect to Ph.Eur. 

and FDA requirements. Evaluation of: 

    - Repeatability  

    - Accuracy 

    - Selectivity  

    - Limit of Quantification  

    - Linearity  

    - Range  

    - Robustness  

Qualitative Impurity Determination - Validation of a method to determine an impurity with respect to Ph.Eur. 

and FDA requirements. Evaluation of: 

    - Selectivity 

    - Limit of Detection  

    - Robustness  

    (- Repeatability, Accuracy, Range) 

HPLC System Suitability ï FDA. - Evaluation of chromatographic characteristics of an HPLC (GC) method 

with respect to FDA requirements. Evaluation of: 

    - Repeatability of Injection 

    - Capacity Factor 

   - Resolution 

    - Tailing 

    - Theoretical Plate Number 

HPLC System Suitability ï Ph.Eur. - Evaluation of chromatographic characteristics of an HPLC (GC) method 

with respect to Ph.Eur. requirements. Evaluation of: 

    - Theoretical Plate Number 

    - Resolution 

    - Symmetry Factor 

 

Clicking the validation type to be evaluated, e.g. Full Validation, opens the Full Validation window containing 

the list of parameters to be evaluated, i.e. Repeatability, Accuracy, Linearity, Repeatability, Selectivity, Limit of 

Detection and Limit Quantification, Robustness, Sensitivity and Range: 

 

 
Fig. 5.1: Full Validation window ïSelection of the Algorithm tab 
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Names of parameters/methods in bold indicate that data were entered and saved to the database for this 

parameter/method (bold display can be set using Tools > General Settings > Use ñBOLDò text for 

Parameters/Methods Including Data). Click the name of the parameter/method, e.g. Repeatability > Level by 

Level from Multiple Measurements, to open the Data Table ï Repeatability: Level by Level from Multiple 

Measurements window, where the actual data are entered and evaluated (see chapter 5.2).  Click the Note tab in 

the Full Validation window to open the tab for notes regarding the given validation.  

 

5.1.2 NOTE      
 

This tab enables users to make a note regarding the (progress of the) selected type of validation. 

 

 
Fig. 5.2: Full Validation window ïNote tab 

 

5.1.3 SUMMARY PRINT     

 

This function enables users to print out all print reports for all evaluated validation parameters saved in the print 

Archive. Click the Summary Print tab in the Full Validation window: 

 

 
Fig. 5.3: Full Validation window ï Summary Print tab 

 

Select one of the radio-buttons below the Title bar to specify, based on what to create a Summary Print. Based 

on: Data   - Prints the contents of the selected Data Table windows  

 Data and Results  - Prints the contents of the selected Data Table and Results windows 

 Data and Graph  - Prints the contents of the selected Data Table and Graph windows 

 All    - Prints the contents of the selected Data Table, Results and Graph windows 

Names of validation parameters for which the print reports are available in the Archive (see 5.2.1) are displayed 

with a checkbox in front of the name. To print the contents of the selected print files, check the checkboxes. In 

the above example of Repeatability: 

ï Ǐ Level by Level from Multiple Measurements and Repeatability 

ï Ǐ From Parallel Measurements 
 

To make the selection easier, Date and Time of archiving is shown behind the validation parameter names.  

The Print button is disabled if no checkbox is checked. 
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5.2 DATA TABLE             

 
The Data Table window allows users to enter/edit data for evaluation of Validations, Inter-laboratory 

Comparisons, Control Charts, Calibrations and Uncertainties. The Data Table for validation of data can be 

opened from the Validation (e.g. Full), Inter-laboratory comparison, Control charts, Calibration or Uncertainty 

windows by clicking the name of the given parameter/method. For example, by clicking the Repeatability ï 

Level by Level from Multiple Measurements item, the following window is displayed:   

 

 
Fig. 5.4: Data Table window  

 

¶ The Title bar shows the title of the window: Data Table ï Repeatability: Level-by-Level from Repeated 

Measurements. 

¶ The Menu bar and Icon bar are displayed below the Title bar. 

¶ Units for the Validated Property and/or Measurements are displayed below the icon bar. Units can be 

selected from the predefined list or typed using the keyboard.  

¶ Next to Units, you can see Additional Parameters (Reference Precision, Slope of Calibration Line, 

etc.), if they are needed for the given Validation parameter, Control Chart or Uncertainty estimation 

(this is not the case for Repeatability). 

¶ The table for measurement results forms the main part of the window. Rows of the Data Table 

correspond to individual Levels of Validated Property (typically concentration, e.g. = 5, 25, 50 mg/l), 

the columns correspond to repeated Measurements (Measrt) of the Validated Property at the given 

Level (e.g. at the Level 5 mg/l are results of measurements: 5.31, 5.01, 4.97, etc., mg/l). Every row can 

be supplemented by a Description, i.e. note for users, e.g. Sampling 1, Standard n., Date. Part of the 

table corresponding to the minimum/recommended number of Measurements/Levels is in a red/green 

frame. For Repeatability: Level by Level from Repeated Measurements, the minimum number of 

Levels is 1, minimum number of Measurements is 2. The recommended number of 

Levels/Measurements is 3 and 6, respectively. Without entering the minimum number of data, the 

Calculation cannot be started. Recommended extents of the experiment can be set using the Tools > 

Data and Calculations menu selection.  

For some parameters (Accuracy, Linearity, etc.), the Data Table is extended by a column containing 

Reference Values, located between the Level and Measurement 1 columns. The meaning of Reference 

Values is described in Help, Instructions and this Userôs Guide (see Chapter 6). 

As with Microsoft Excel, Data Table can include more Sheets, one for each Validated (calibrated, 

regulated) Property. Validated Properties are defined in the List of Methods window (see chapter 4.1) or 

using the Sheet menu (see Chapter 5.2.1). 

 

Note: data entered in one type of validation (e.g. Exploratory) are not automatically transferred to another 

validation (e.g. Full). If necessary, use Clipboard to Copy/Paste data (Ctrl-C, Ctrl-V). 

 

¶ Instructions below the Data Table provide users with specific information for the given algorithm. 
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5.2.1 DATA TABLE MENU      

 

The menu bar Data Table window contains the following items: 

 

Sheet Edit Data transformation Results  

New                      Ctrl+N   Copy                 Ctrl+C Log 2 Calculate          F5 

Open                     Ctrl+O Paste                 Ctrl+V Log 10 Graph 

Save                      Ctrl+S Insert Row 1/x  

Save all                 Ctrl+A Delete Row 1/X^2  

Save as Delete Column X^2  

Close Sheet  Back  

Sheet Properties    

Print                      Ctrl+P    

Preview    

Edit Print Form      Ctrl+U    

Print to Archive     

Close    

 

The Sheet menu: 

New - Creates a new sheet with number N+1, where N = number of the last existing data sheet in 

the given method. The sheet name can be defined/changed from the Sheet Properties 

window (see text below in this chapter), using the Sheet menu or by right-clicking the sheet 

name.  

Open - Displays the Open Sheet window with a list of all existing closed Sheets included in the 

given method, or displays the message:  All Sheets are already opened. Users can select the 

Sheet to be opened from the list and click OK. 

 

 
Fig. 5.5: Open Sheet window 

 

Save - Saves current data in the given sheet of the Data Table window to database.  

Save all - Saves current data in all sheets of the Data Table window to database. 

Save as - Saves current data to a specified directory under the specified name in TXT, CSV or XLS 

format. 

Close Sheet - Closes the current Sheet. The sheet can be opened again using the Sheet > Open menu 

selection. 

Sheet Propert. - Displays the Sheet Properties window. On the General tab of this window, users can change 

the name of the Validated Property for the given Sheet and enter a Note. Users can also 

find out who and when Created and Last Updated the given Sheet: 

 

 
Fig. 5.6: Sheet Properties window - General tab 
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  On the History tab, the user can Display data as saved in the Data Table at a certain Date 

and Time. Record to History is carried out every time the Save command is used in Data 

Table:  

 

 
Fig. 5.7: Sheet Properties window ïHistory Measrt tab 

 

   Clicking the Display button displays the Data Table ï HISTORY window, which compares 

current and old data. Differences from the current data are highlighted in red. 

   

 
  Fig. 5.8: Data Table - HISTORY window 

 

  The Calculate icon in the Data Table ï HISTORY window can be used to run the 

calculation and to compare old and current results. All results for which the data is stored in 

Data Table ï HISTORY can be obtained again by clicking Calculate (F5). 
 

Print - Prints the contents of the currently opened windows. If only Data Table window is opened, 

prints the contents of this window only, when Graph and/or Results windows is also 

opened, it prints the contents of all windows as a combined Print Report in the order: Data, 

Results, Graph. The button choice Sheep > Print is the only way to print out the combined 

Print Reports. The Print buttons in the windows Results and Graph enable to print only 

Results or only Graph. 

  For details how to edit the combined Print Report see 5.2.4. 
 

Preview - Shows the print Preview for the current sheet, i.e. Data Table, eventually Graph and Results 
 

Edit Print Report - Editing the Data Table Print Report (for details on Editing Print Reports see 5.2.4) 

  Report specifies the location of items to be printed on the page, fonts used, size, colours, 

etc. Users can create a user-defined Print Reports. For every parameter/method included in 

the software EffiValidation, one Print Report is supplied for printing: Data, Results, Graph 

and their combinations: Data + Graph, Data + Results and Data + Results+ Graph. 
 

Print to Archive - Prints the contents of the currently opened windows Data Table, Results and Graph, 

corresponding to one validation parameter, to a print file, which can be later printed by 

means of Summary Print (see 5.1.3) 
 

Close - Closes the Data Table window for evaluation of the given method/parameter.  
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Main commands in the Sheet menu can also be accessed by right-clicking the tab with the Sheet name: 

 

 
The Edit menu  

 

Copy (Ctrl-C) - Copies the marked part of the Data Table into clipboard from where users can Paste the 

content to any Microsoft Windows application 

Paste (Ctrl-V) - Pastes the data copied to Clipboard at the actual position of the cursor 

Insert Row - Inserts a blank row at the current position of the cursor (and re-numbers the Levels). This is 

the equivalent to pressing the Insert key from the keyboard. 

Delete Row - Deletes the row at current position of the cursor 

(Ctrl-Delete) 

Delete Column - Deletes the column at the current position of the cursor. The software then moves all 

columns right from the column one column left.  

 

The Data Transformation menu  

 

Log 2 - Calculates Log2 from all values in Data Table 

Log 10 - Calculates Log10 from all values in Data Table 

1/x - Calculates 1/x from all values in Data Table 

1/x^2 - Calculates 1/x^2 from all values in Data Table 

x^2 - Calculates x^2 from all values in Data Table 

Back - Returns the values in the Data Table window to the state before the Data Transformation 

 

The Results menu  

 

Calculate (F5) - Performs the assigned calculation and displays the Results window.  

Graph - Performs the calculation needed to create the graph and displays the Graph window. 

 

5.2.2 TABLE FOR ENTERING DATA      

                      

Handling the Data Table is similar to spreadsheet applications, e.g. Microsoft Excel. Basic features are as 

follows: 

- The table can contain multiple sheets (256 maximum), each sheet is for one Validated Property. Instructions 

for handling the Sheets using the Data Table menu can be found in Chapter 5.2.1 

- Cursor and/or mouse allows users to move in any direction 

- The Delete key on the keyboard deletes the content of the current cell in the Data Table 

- The Insert key on the keyboard inserts a new row (Level) to the Data Table at the current cursor position 

- After deleting/inserting a row, the row numbers (Levels) are automatically updated (re-numbered).  

- By moving the cursor down in the Data Table, new blank rows (Levels) are automatically added.  

- To copy and paste, use the Ctrl-C and Ctrl-V hot keys  

- Data in Data Table can be mathematically transformed using the Data Transformation menu (Chapter 

5.2.1). 

- Further features concerning Edit data in Data Table are described in Chapter 5.2.1. 

 

Right clicking in the Data Table opens a menu with the following items (also described in the Edit menu ï 

Chapter 5.2.1): 
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Fig. 5.9: Data Table window ï cell menu  

 

Copy - Copies the contents of the marked part of the table (cell, column, ...) to Clipboard 

(equivalent to Ctrl-C). Then, choose Paste or press Ctrl-V to paste the content of Clipboard 

to Data Table at the position of cursor 

Paste - Pastes the contents of the Clipboard (copied with Copy from the menu or Ctrl-C hot key) at 

the position of the cursor (equivalent to Ctrl-V). 

Delete - Deletes the marked cell or row. 

Comment - Enables users to enter and edit a comment for the current cell. Displays a dialog box, where 

the comment is entered. The comment is saved by clicking the Save button.  

 

 
Fig. 5.10: Cell Comment window 

 

  The presence of a comment in a cell is indicated by red colour at the right upper corner of 

the cell.  

Delete Comment - Deletes an existing comment for the given cell. The indication in red at the right upper 

corner is removed. 

Comment History  - Opens the Comments History window  

 

 
Fig. 5.11: Comments History window  
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  History shows the Date and Time when the Comment was Created or Changed, by whom 

and on which Computer  

 

Annexes - Enables users to enter and edit links to files containing Annexes related to the given cell 

(similar to Annexes in the List of Methods). The annex file typically is a data file containing 

chromatogram, spectrum or another record or data file (Word document, Excel sheet, etc). 

Handling of annexes includes: addition of a New annex, Editing, Deletion, Opening (only 

for files executable on the given computer), Saving and Closing the window. 

 

 
Fig. 5.12: Annex window 

 

  The presence of an annex in a cell is indicated by green colour at the upper right corner of 

the cell.  

Delete Annexes - Deletes existing Annexes from the given cell. The green indication at the upper right corner 

of the cell is removed.  

Annex History - Opens the Annex History window 

 

 
Fig. 5.13: Annex History window  

 

  History shows the Date and Time when the Annex was Created or Changed, by whom and 

on which Computer. The lower part of the Annex History window displays Icon, 

Description and Path to the Annex 

 

Column Prop. - Displays a dialog to enter properties of the column (Measrt): 

 

 
Fig. 5.14: Column Property window  
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 Column Name  - Column name, e.g. Measrt 1. 

 Display Mask - Mask of the decimal format used to display data in the given 

column. Examples: 

   #.### - 3 decimal digits ð if the third decimal number is zero, 

only 2 digits are displayed 

   0.000  - 3 decimal digits ð if the third decimal number is zero, it 

is displayed 

   Note: Always use a decimal separator that is considered in 

Microsoft Windows 

 Example - Enables users to enter a number as an examples to be displayed 

 ### - Enter number to be displayed 

 

5.2.3 EVALUATION OF THE DATA TABLE    

 

The procedure to evaluate data in the Data Table window is presented in Repeatability.  First, the user should 

enter the required number of data for the given parameter/method. The minimum number of data in Data Table is 

indicated by a red frame, the recommended number by a green frame. Click the Calculate button to start the 

evaluation. The evaluation proceeds as follows: 

- The built-in controls are initiated to check the entered data for missing values, empty Levels, Levels with 

zero standard deviation, etc. If any of these controls does not pass, a sub-window is displayed in the lower 

part of the Data Table window (replacing the Instructions) called List of Error Controls in Data: 

-  
 

 

   Fig. 5.15: List of Error Controls in Data window  

 

The evaluation will not start unless all errors in data have been corrected. To correct the errors, click the 

individual error in the List of Error Controls in Data, the cursor in Data Table is moved to the position of 

the error 
 

- Statistical tests to detect Outliers and to evaluate Normality are performed: 

- Cochran test: detection of the Level where the variance of Measurements is statistically bigger than 

the variance of Measurements in the other Levels  

- Dixon test: detection of Outliers in individual Levels using the Dixonôs test 

- Grubbs test: detection of Outlier in individual Levels using the single Grubbôs test 

- Grubbs pair: detection of pair outlying Measurements in individual Levels using the pair Grubbôs 

test (2 min. or 2 max. values) 

and Normality testing: 

- Komolgovov-Smirnov test: testing of measurement Normality in a Level  

The software always initiates only Outlier/Normality tests that can be executed with the entered data. For 

four and more Measurements, all tests are initiated 

 

- Data evaluation of the given parameter/method is initiated 

 

- The Results and Graph windows are opened with numerical and graphical results. The upper part of the 

Results window contains detailed results (e.g. Average, Repeatability, Rel. Repeatability and n - Number of 

Measurements), while the lower part includes Conclusions, summarizing the data evaluation along the 

whole considered Range (i.e. Conclusion: Repeatability of the Analytical Method is #,##### units, i.e. ##,## 

%): 

 
Fig. 5.16: Results window  
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Fig. 5.17: Graph window  

 

In the Graph window, the user can zoom parts of the graph and change Chart and Series by clicking the Settings, 

i.e. Series, General, Axis, Titles, Legend, Panel, Paging, Walls and other controls in the Graph Setting window: 

 

 
Fig. 5.18: Graph Setting window  

 

In addition, the Results window shows the Outlier/Normality detection results on individual tabs. Several tabs 

presenting results of evaluating Data, Dixon and Grubbs test are shown below: 

 

 
Fig. 5.19: Dixonôs Test window  
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Fig. 5.20: Grubbsô window  

 

In the example above, the tests revealed the presence of one Outlier (Measurement 5) in Level 2 with a value of 

28.0. The Calculated Value of the Dixonôs criteria is 0.8232, which is higher than the Critical Value  = 0.628 

from the statistical tables. Accordingly, the Calculated Value for the Grubbôs test 2.0093 is higher than the 

Crit ical Value = 1.887 from the statistical table at the considered probability Level. 

 

The numerical results in the Results window can be Exported to a specified .txt, .csv or .xls file. The graphical 

results in the Graph window can be Saved as a .bmp, .gif, .jpg, .wmf or .html file. In both cases, the user should 

specify the Target directory, Filename and the file Format to be applied.  

 

Data, Results, and Graph or their combinations can be printed using a default or user-defined Print Report Form. 

The user definition/edition of the Print Reports is described below. 

 

All other Validation parameters, Inter-laboratory Comparisons, Calibrations, Control Charts and Uncertainties 

can be evaluated accordingly. The basic procedure is: (a) enter data, (b) perform calculations, (c) evaluate graph, 

(d) print reports. For more details, see chapter 5.3 and Userôs Tutorial EffiValidation 3.0.  

 

5.2.4  PRINT DATA TABLE    

 

The print options implemented in the EffiValidation 3.0 software are based on so called Print Reports. For every 

parameter/method, one default Print Report is supplied with the software for each language version.   

 

All predefined Print Reports are saved with the file extension RTM in the directory EffiValidation 3.0\RTM. 

User can edit or create a new Print Report by means of Report Builder. The Report Builder window is opened by 

clicking Edit Print Report, item which is always below the item Print and Preview.  

 

 
Fig. 5.21: Report Builder window ï Main of 1_UserDefined.RTM 

 



38/115 

5/5/2010  Userôs Guide EffiValidation 3.0  version: 2.505     

 
 

5.2.4.1 PREDEFINED PRINT REPORTS 

 

Predefined Print Reports are prepared for use in all language versions. They consist of two types of SubReports, 

the first are static (components which it includes cannot be changed), the second are dynamic SubReports (they 

refer to a file saved on disc, which includes the RTM report). The dynamic SubReport has in the file name the 

prefix ĂDSRñ (Dynamic SubReport). During generating the Print Report, DSR is located in the sequence and 

consecutively Printed or Previewed. All SubReport names are generated by the software, according to the 

selected language version. 

 

Warning: It is not recommended to Preview the DSR Subreport when editing the Print Report, because a part of 

DSR is saved in the main report. As a result, the RTM file is bigger and generation of the whole Print Report 

longer. To preview the Print Report, we recommend to use Preview  below Print. 

 

5.2.4.2 USER DEFINED PRINT REPORTS 

  

Creating User Defined reports assumes, that the same RTM file name is used, e.g. 1_UserDefined.RTM. The 

user can creaste a new Print Report (File > New Report) or delete SubReports, including DSR in the existing 

Print Report. 

 

5.2.4.3 BASIC DESCRIPTION 

 

There are three sections displayed in the new report: Header, Detail and Footer. The Header enables to create 

the Print Report header. It is expected to include here the Report name, logo of the company or headings of the 

individual columns in the section Detail. Co fill in Header, use the icon Text from the Report Builder icon bar. In 

the section Detail, place attributes which are repeated, but their values are changed. This is most easily done 

through the icons DBText or DBMemo. Every text can be formatted, i.e. changed Font, Size, Color, etc. Every 

DB component has to refer to a DataSource and attribute name. Only if both are assigned, the component 

displays data. Components without the prefix DB can be defined directly in the Report Builder.  

 

 
Fig. 5.22: Report Builder window ï new Print Report 

 

Footer is generated by software EffiValidation automatically and shows the page number, author, date and time 

of printing. 

 

Warning:  all used defined changes in the Footer will be deleted and automatically replaced by the software 

EffiValidation 

 

All changes in the Print Report can be viewed through the Preview function.  
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5.2.4.4 DESCRIPTION OF  INDIVIDUAL COMPONENTS 

 

Standard components: 

¶ Text 

¶ Memo 

¶ RichText 

¶ Image 

 

These components are used to enter fix values, i.e. values which are not changed during generation of the Print 

report. Typically, these components are column headers, notes, logos, and other parts of the Header. Text 

components enable to change Font, Size, Color, etc. 

 

DB (database) components: 

¶ DBText 

¶ DBMemo 

¶ DBImage 

 

DB components need for their correct function two parameters. The first is DataSource, the second is attribute. 

The values of these components are not fixed, but change during generating the Print Report (Detail section).  In 

case of using a numerical attribute, format of the number can be defined. 

 

 
Fig. 5.23: Report Builder window ï DSR: DATA1_UD.RTM of 1_UserDefined.RTM 

 

View components 

¶ Shape 

¶ Line 

 

Enable to tune the final design of the Print Report. 

 

 

All Print Reports within EffiValidation 3.0 are created in a similar way as Print Reports in the Data Table 

window. 
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5.3 VALIDATION  PARAMETERS            

 

 

5.3.1 REPEATABILITY     

 

Repeatability characterizes spread of Validated Property (Measurements) around the mean value caused by 

random errors. Data to evaluate Repeatability must be recorded under Repeatability conditions, i.e. measured in 

one laboratory, by one analyst, on one instrument, within a short time period.   

The EffiValidation 3.0 software includes 2 approaches to evaluate Repeatability: 

  o Level by Level from Multiple Measurements 

  o From Parallel Measurements   

The choice of method is described in Chapter 5.4. 

 

5.3.1.1 LEVEL BY LEVEL FROM MULTIPLE MEASUREMENTS 

 

Click Repeatability ï Level by Level from Multiple Measurements in the Validation (e.g. Full) window and then 

choose OK. The Data Table ï Repeatability: Level by Level from Multiple Measurements window is displayed.  

Rows of the Data Table correspond to individual Levels of Validated Property (typically concentration), the 

columns correspond to repeated Measurements (Measrt) of the Validated Property at the given Level. The 

minimum number of Measurements in a Level is 2 (the red box), the recommended number is 6 (the green box). 

The recommended number of Levels (rows) is 3: at the lower limit, in the middle and at the upper limit of the 

range.  

Click the Calculate icon or choose Results > Calculate to start the calculation of Repeatability and to display the 

Results window. For every Level of the Validated Property (sample), the following characteristics are presented: 

¶ Level   - Copy of the Level number column in Data Table  

¶ Description  - Copy of the Description column in Data Table  

¶ Average   - Average Measurement in a Level (row average) 

¶ Repeatability   - Measurement standard deviation in a Level (row STD) 

¶ Rel. Repeatability - 100*Repeatability/Average Measurement 

¶ n   - Number of Measurements in a Level (row) 

Conclusion: summarizes the Repeatability evaluation along the whole considered range. Repeatability and Rel. 

Repeatability are pooled averages of Repeatability values from the Results table, weighted with respect to the 

number of Measurements in the Level. 

On the Cochran, Dixon, Grubbs, Grubbs' pair and Normality tabs, the Outliers and Normality results are 

presented.  

Results can be Printed (Print, Preview, Edit Print Report) and Exported to other formats (TXT, CSV, XLS). 
The Graph window is displayed automatically and shows variability of multiple Measurements (y-axis) in the 

individual Levels of the Validated Property (x-axis).  

The Title and other Settings of the Graph (Axis, Legend, Colours, Styles, etc.) can be changed through the 

Settings button. The Default button re-sets the Graph to its initial Settings. A Graph can be Printed (Print, 

Preview, Edit Print Report) and Saved as other formats (BMP, GIF, JPEG, WMF, HTML). When the Data Table 

and/or Results windows are opened, the combination of Graph with Data/Results can be Printed using the Data 

Table window menu (select Sheet - Print (Preview, Edit Print Report). 

 

Data edit, Graph display and the use of Print features are the same for all other algorithms/methods.  

 

5.3.1.2 FROM PARALLEL MEASUREMENTS  

 

Click Repeatability ï From Parallel Measurements and then choose OK. The window Data Table ï 

Repeatability: From Parallel Measurements is opened.  

Rows of the Data Table correspond to individual Levels of Validated Property (concentration), the columns to 

parallel measurements (Measrt 1 and 2) of the Validated Property at the given Level. The required number of 

Measurements in a Level is 2. The recommended number of Levels (rows) is 6: at the lower limit, in the middle 

and at the upper limit of the Range. 

Click the Calculate icon or choose Results > Calculate to start the calculation of Repeatability and to display the 

Results window. For every Level of the Validated Property, the following characteristics are presented: 

¶ Level   - Copy of the Level number column in Data Table  

¶ Description  - Copy of the Description column in Data Table  
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¶ Average   - Average measurement in a Level (row average) 

¶ Repeatability   - Measurement standard deviation in a Level (row STD) 

¶ Rel. Repeatability - 100*Repeatability/Average Measurement 

¶ n   - Number of Measurements in a Level (row) 

Conclusion: summarizes the Repeatability evaluation along the whole considered Range. Repeatability and Rel. 

Repeatability are pooled averages of Repeatability values from the Results table, weighted with respect to the 

number of Measurements in a Level. 

The Graph window is displayed automatically and shows the variability of parallel Measurements (y-axis) in the 

individual Levels of the Validated Property (x-axis).  

 

 

5.3.2 INTERMEDIATE PRECISION     

 

Click Intermediate Precision and choose OK. The Data Table ï Intermediate Precision window is displayed. The 

Intermediate Precision characterizes the spread of Validated Property (Measurements) around the mean value 

caused by random errors. Data to evaluate Intermediate Precision must be recorded under the measurement 

conditions between Repeatability and Reproducibility conditions; this means e.g. different analysts, the same 

instrument, within an intermediate time period.   

 

Data handling and evaluation of Intermediate Precision are the same as in the case of Repeatability (see Chapter 

5.3.1).  

 

 

5.3.3 REPRODUCIBILITY    

 

5.3.3.1 DATA AVAILABLE  

 

Click Reproducibility ï Data Available and then choose OK. The Data Table ï Reproducibility: Data Available 

window is displayed. Reproducibility characterizes the spread of Validated Property (Measurements) around 

mean value caused by random errors. Data to evaluate Reproducibility must be recorded under Reproducibility 

conditions, i.e. measured by different analysts, on different instruments, within a long time interval, usual in an 

Inter-laboratory Comparison study.   

 

Data handling and evaluation of Reproducibility are the same as Repeatability (see Chapter 5.3.1). Rows of Data 

Table correspond to Measurements (Measrt) of the Validated Property in individual laboratories.  

 

5.3.3.2 RESULTS AVAILABLE  

 

Click Reproducibility ï Results Available and then choose OK. The Data Table ï Reproducibility: Results 

Available window is displayed. Enter the value of Reproducibility and choose OK. The data are saved in the 

database. No calculation is performed.  

 

 

5.3.4 ROBUSTNESS      

 

Robustness characterizes the resistance of the Analytical Method to small changes in the settings of experimental 

conditions (e.g. to changes in pH of the mobile phase in case of HPLC method, to changes in the detector 

temperature of a GC method, etc.). Robustness is evaluated by means of experimental design.  

 

Click Robustness in the Validation (e.g. Full) window and then choose OK. The Data Table ï Robustness 

window is displayed.  

In the box above the table enter the Number of Factors to test Robustness of the Method (in case of HPLC e.g. 

pH of mobile phase, flow of mobile phase, concentration of ion-pair reagent, etc.). With respect to this Number, 

the software will generate a table of an experimental design with a certain number of rows and columns. Every 

row corresponds to one experiment. All experiments are carried out with the same sample/standard (e.g. 

concentration = 25 mg/l), only the conditions of the experiment differ. The columns Factor 1 to Factor x (where 

x = Number of Factors considered) are filled with values +1 and -1, where +1 indicates that the given factor (e.g. 

pH) is for the given experiment set to the nominal Level (e.g. pH = 8.2) and -1 that the factor is set to the 

extreme Level (e.g. pH = 8.7). Values of the nominal (+1) and extreme Level (-1) are set before any experiment 
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starts. In the Results column in the Data Table window, enter the results of experiments obtained for individual 

settings of experimental conditions (given by +1 and -1). 

Click Calculate to start the calculation of Robustness and to display the Results window. Choose whether to 

include (YES = standard way) or to exclude (NO) Dummy variables in the calculation.  

In the Results window, the following characteristics are presented: 

¶ Factor  - Consecutive number of the Factor against which Robustness is tested 

¶ Effect   - Effect of the tested Factor on the Result when the Factor is changed from the  

  nominal to the extreme Level 

¶ E_crit    - Critical effect needed to compare E_crit   to Effect in order to evaluate significance  

  of the Factor 

¶ Hypothesis  - Result of testing the hypothesis that the Analytical Method tested is Robust against  
  the given Factor (Effect < E_crit ) 

Conclusion: summarizes the result of the hypothesis that the Method is robust against all Factors tested.  

The automatically opened Graph window shows a bar plot of Effects (y-axis) of individual Factors (x-axis) on 

experimental Results obtained when evaluating Robustness. The length of the bar is proportional to the size of 

the Effect. Horizontal lines in the Graph indicate the limits above which the Effects are statistically significant so 

that the Method is not robust against such a Factor. 

When it turns out that the Method is not Robust against some of the Factors tested, then the extreme tested Level 

is moved closer to the nominal Level (e.g. pH from 8.7 to 8.5) and the experiment and evaluation is repeated. If 

the tested factor (pH) becomes unimportant, it is necessary to ensure that the laboratory regulates the Factor 

within the established narrower limits (pH from 8.2 to 8.5). 

 

5.3.5 ACCURACY      

 

Accuracy characterizes the agreement between the Measurements of Validated Property and the accepted or 

declared Reference value. If testing proves that the difference between these values is not statistically significant, 

the Method is considered to provide accurate results. In case the difference is statistically important, the Method 

provides biased results (this means results including a systematic error).  

To evaluate Accuracy, several methods can be used: 

  o Limited Concentration Range ï Sample Reconstitution Possible (t-test) 

  o Limited Concentration Range ï Reference Material Available (t-test) 

  o Large Concentration Range ï Blank Material Available: t-test or Regression 

  o Large Concentration Range ï Blank Material Available: t-test or Regression 

  o Comparison of 2 Methods/Laboratories: t-test Level by Level or  t-test on Difference of Results 

The choice of method to evaluate Accuracy is described in Chapter 5.4. 

 

5.3.5.1 LIMITED CONCENTRATION RANGEðSAMPLE RECONSTITUTION POSSIBLE  

 

Click Accuracy and Limited Concentration Range ï Sample Reconstitution Possible in the Validation (e.g. Full) 

window. Then choose OK. The Data Table ï Accuracy: Limited Concentration Range ï Sample Reconstitution 

Possible window is opened.  

In the Reference column, type in the value of Validated Property in the calibration standards prepared using a 

(certified) reference material (known from weighing, pipetting, etc.) and blank. In the Measrt 1 to Measrt 30 

columns, enter values of repeatedly measured Validated Property using the validated Method at the given Level. 

The minimum number of Measurements in a Level is 2. The recommended number is 6. The recommended 

number of Levels (rows) is 3. 

Click Calculate to start the evaluation of Accuracy and to display the Results window. For every Level of the 

Validated Property, the following characteristics are presented:  

¶ Level  - Copy of the Level number column in Data Table  

¶ Description - Copy of the Description column in Data Table  

¶ Reference - Copy of the Reference column in Data Table  

¶ Measured - Row average of Measrt values from Data Table  

¶ Recovery - Method Recovery = 100*Measured/Reference 

¶ Precision - Row standard deviation of Measrt values from Data Table 

¶ n  - Number of Measrt values in the given Level (row) 

¶ t  - Calculated t for the Student's t-test 

¶ t-crit   - Critical t-value for the Student's test (from statistical tables) 

¶ Hypothesis - Result of testing the hypothesis that the Method is accurate on the given Level 
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Conclusion: summarizes the result of testing the hypothesis that the Analytical M ethod provides statistically 

accurate results along the whole considered Range.  

The automatically opened Graph window shows the plot of Measured (y-axis) against Reference (x-axis) 

values of Validated Property. The straight line on the main diagonal corresponds to the ideal (i. e. absolutely 

accurate) Method.  

  

5.3.5.2 LIMITED CONCENTRATION RANGE ï REFERENCE MATERIAL AVAILABLE  

 

Click Accuracy and Limited Concentration Range ï Reference Material Available in the Validation (e.g. Full) 

window and then choose OK. The Data Table ï Accuracy: Limited Concentration Range ï Reference Material 

Available window is displayed.  

In the Reference Precision box above the table, enter the precision value of the Validated Property 

(concentration) in the reference material. This value should be provided by the supplier in the certificate of the 

reference material.  

In the individual rows of the Data Table, enter data for the individual reference materials: in the Ref. Value 

column, type in the value of the Validated Property in the reference material. This value should be presented by 

the supplier in the certificate. In the columns Measrt 1 to Measrt 30, enter results of the repeated Measurements 

of the Validated Property of the reference material. The minimum number of Measurements is 2; the 

recommended number is 6. 

Click Calculate to start the evaluation of Accuracy and to show the Results window. For every reference 

material considered, the following characteristics are presented: 

¶ Level   - Copy of the Level number column in Data Table  

¶ Description  - Copy of the Description column in Data Table  

¶ Reference Value  - Copy of the Ref. Value column in Data Table  

¶ Measured  - Row average of Measrt values from Data Table  

¶ Recovery  - Method Recovery = 100*Measured/Reference 

¶ Precision  - Row standard deviation of Measrt values from Data Table 

¶ n   - Number of Measrt values in the given Level (row) 

¶ t   - Calculated t for the Student's t-test 

¶ t-crit    - Critical t-value for the Student's test (from statistical tables) 

¶ Hypothesis on Precision - Result of testing the hypothesis that the Method is sufficiently precise with  

      respect to Reference Precision 

¶ Hypothesis on Accuracy - Result of testing the hypothesis that the Method is accurate for the given  

      reference material 

Conclusion: summarizes the result of testing the hypothesis that the Analytical Method provides accurate 

results for all Reference Materials tested.  
The automatically opened Graph window shows the plot of Measured (y-axis) versus Reference (x-axis) values 

of Validated Property. The straight line on the main diagonal corresponds to the ideal (absolutely accurate) 

Method.  

  

5.3.5.3 LARGE CONCENTRATION RANGE ï BLANK MATERIAL AVAILABLE : t-test  

 

Click Accuracy and Large Concentration Range ï Blank Material Available ï t-test in the Validation (e.g. Full) 

window and then choose OK. The Data Table ï Accuracy: Large Concentration Range ï Blank Material 

Available ï t-test window is opened.  

In the Reference column, type in the value of Validated Property in the calibration standards, prepared using a 

(certified) reference material (known from weighing, pipetting, etc.) and blank. In the columns Measrt 1 to 

Measrt 30, enter values of repeatedly measured Validated Property using the validated Method at the given 

Level. The minimum number of Measurements in a Level is 2; the recommended number is 6. The 

recommended number of Levels (rows) is 3. 

Click the Calculate to start the evaluation of Accuracy and to show the Results window. For every Level of the 

Validated Property, the following characteristics are presented:  

¶ Level  - Copy of the Level number column in Data Table  

¶ Description - Copy of the Description column in Data Table  

¶ Reference - Copy of the Reference column in Data Table  

¶ Measured - Row average of Measrt values from Data Table  

¶ Recovery - Method Recovery = 100*Measured/Reference 

¶ Precision - Row standard deviation of Measrt values from Data Table 

¶ n  - Number of Measrt values in the given Level (row) 
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¶ t  - Calculated t for the Student's t-test 

¶ t-crit   - Critical t-value for the Student's test (from statistical tables) 

¶ Hypothesis - Result of testing the hypothesis that the Method is accurate on the given Level 

Conclusion: summarizes the result of testing the hypothesis that the Analytical M ethod provides statistically 

accurate results along the whole considered Range.  

The automatically opened Graph window shows the plot of Measured (y-axis) versus Reference (x-axis) values 

of Validated Property. The straight line on the main diagonal corresponds to the ideal (i. e. absolutely accurate) 

Method.  

 

5.3.5.4 LARGE CONCENTRATION RANGE ï BLANK MATERIAL AVAILABLE : REGRESSION  

 

Click Accuracy and Large Concentration Range ï Blank Material Available ï Regression in the Validation (e.g. 

Full) window and then choose OK. The Data Table ï Accuracy: Large Concentration Range ï Blank Material 

Available ï Regression window is opened.  

In the Reference column, type in the value of Validated Property in the reference material (known from 

weighing, pipetting, etc.). In the column Measrt 1 (2 - 30), enter values of measured Validated Property at the 

given Level. The minimum number of Measurements is 1 (the red box). The minimum number of Levels (rows) 

is 4, the recommended number is 6 (the green box). 

Click Calculate to start the evaluation of Accuracy and to open the Results window, showing for both 

parameters of the regression line (slope and intercept) the following: 

¶ Parameter  - Name of the regression parameter (Intercept/Slope)  

¶ Theoretical  - Theoretical value of the regression parameter (Intercept = 0, Slope = 1)  

      corresponding to the ideally accurate Method 

¶ Measured  - Regression parameter calculated from all average Measrt values  

¶ Recovery  - Method Recovery = 100*Measured/Theoretical 

¶ Precision  - Standard deviation of the regression parameter 

¶ Confidence interval - Calculated confidence interval for the regression parameter needed to  

      test the hypothesis  

¶ Hypothesis  - Result of testing the hypothesis that Slope = 1 and Intercept = 0 

Conclusion: summarizes the result of testing the hypothesis that the Analytical Method provides statistically 

accurate results.  
 

The automatically opened Graph window shows the plot of Measured (y-axis) versus Reference (x-axis) values 

of Validated Property. The straight line on the main diagonal corresponds to the ideal, absolutely accurate 

Method. 

 

5.3.5.5 LARGE CONCENTRATION RANGE ï BLANK MATERIAL NOT AVAILABLE : t-test  

 

Click Accuracy and Large Concentration Range ï Blank Material not Available ï t-test in the Validation (e.g. 

Full) window and then choose OK. The Data Table ï Accuracy: Large Concentration Range ï Blank Material 

not Available ï t-test window is opened.  

In the first row of the Data Table corresponding to the analysis of initial sample with a low Level of Validated 

Property (concentration), enter Addition = 0. In the columns Measrt 1 to 30 (min. 2) enter results of repeatedly 

measured Validated Property in the initial sample. In the second and next rows, fill the column Addition with 

the value of standard addition (concentration) added to the initial sample. In the columns Measrt 1 to 30 (min. 2) 

enter results of repeatedly measured Validated Property in the given sample with the added standard. 

Click Calculate to start the evaluation of Accuracy and to show the Results window. For every Level of the 

Validated Property, the following characteristics are presented:  

¶ Level   - Copy of the Level number column in Data Table  

¶ Description  - Copy of the Description column in Data Table  

¶ Addition    - Copy of the Addition column in Data Table  

¶ Measured   - Row average of Measrt from Data Table corrected for row average of  

      the initial sample (Level 1) 

¶ Recovery  - Method Recovery = 100*Measured/Addition  

¶ Precision  - Row standard deviation of Measrt values from Data Table 

¶ Confidence interval - Confidence interval of row average corrected for the average of  

      the initial sample (Level 1) 

¶ Addition    - Copy of the Addition column in Data Table  

¶ Hypothesis  - Result of testing the hypothesis that the Method is accurate in the given  

      Level 
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Conclusion: summarizes the result of testing the hypothesis that the Analytical Method provides accurate 

results along the whole considered Range.  

 

The automatically opened Graph window shows the plot of Measured (y-axis) values of the Validated Property 

corrected for the average in Level 1 (initial sample) versus the standard Addition values (x-axis). The straight 

line on the main diagonal corresponds to the ideal, absolutely accurate Method. 

 

5.3.5.6 LARGE CONCENTRATION RANGE ï BLANK MATERIAL NOT AVAILABLE : REGRESSION  

 

Click on Accuracy and Large Concentration Range ï Blank Material not Available ï Regression in the 

Validation (e.g. Full) window and then choose OK. The Data Table ï Accuracy: Large Concentration Range ï 

Blank Material not Available ï Regression window is opened.  

In the column Val. Pr., input the concentration values (Validated Property) of the prepared calibration standards 

in water or another inert solvent/material. In the column Measrt 1, input the responses obtained with the 

validated Analytical Method for samples with the given Level of Validated Property. In the column St. 

Addition , input values of standard addition, spiked to aliquot of the material (matrix) being analysed. To the 

column Measrt 2, input responses obtained with the validated Method on spiked samples. If the number of rows 

filled in columns Val. Pr. and Measrt 1 is not the same as in St. Addition and Measrt 2 columns, enter ñ-1ò 

values to empty cells to the last rows (at the end of the Table). 

 

Click Calculate to start the evaluation of Accuracy and to show the Results window, showing the following: 

¶ Parameter  - Name of the regression parameter (Slope)  

¶ Calibration   - Slope of the calibration line prepared in water or an inert solvent  

¶ Standard Addition  - Slope of the calibration line with the standard additions 

¶ Recovery  - Method Recovery = 100*Standard Addition /Calibration  

¶ Precision  - Standard deviation of the regression parameter 

¶ t   - Calculated t for the Student's t-test 

¶ t-crit    - Critical t-value for the Student's test (from statistical tables) 

¶ Hypothesis  - Result of testing the hypothesis that both Slopes are equal 

Conclusion: summarizes the result of testing the hypothesis that the Analytical Method provides statistically 

accurate results along the whole tested Range.  

 

The automatically opened Graph window compares the Calibration line and the Standard Addition line. In 

case the Slopes of both lines are not statistically different, the accuracy of the Method is confirmed. 

 

5.3.5.7 COMPARISON OF 2 METHODS/LABORATORIES: t-test Level by Level 

  

Click Accuracy and Comparison of 2 Methods/Laboratories: t-test Level-by-Level in the Validation (e.g. Full) 

window and then choose OK. The Data Table ï Accuracy: Comparison of 2 Methods/Laboratories: t-test Level-

by-Level window is opened.  

Rows in the Data Table correspond to individual Levels of Validated Property (typically concentration), the 

columns correspond to results obtained by repeatedly measured Validated Property in the given Level. In the 

columns Measrt 1_1 to 1_3, enter results of 3 times repeated Measurements using Method 1 or Laboratory 1 

(reference method/laboratory), in the columns Measrt 2_1 to 2_3 enter results obtained using Method 2 or 

Laboratory 2 (validated Method). All columns in the given row must be filled in, otherwise the algorithm cannot 

be started! 

 

Click the Calculate icon or choose Results > Calculate to start the calculation of Accuracy and to show the 

Results window. For every Level of the Validated Property, the following characteristics are presented: 

¶ Level  - Copy of the Level number column in Data Table  

¶ Description - Copy of the Description column in Data Table  

¶ Measured 1 - Average of Method 1 values in the given Level in Data Table  

¶ Measured 2 - Average of Method 2 values in the given Level in Data Table  

¶ Recovery - Method Recovery = 100*Measured 2/Measured 1 

¶ Precision 1 - Standard deviation of Method 1 values in the Level in Data Table  

¶ Precision 2 - Standard deviation of Method 2 values in the Level in Data Table  

¶ t  - Calculated t for the Student's t-test to compare Methods/Laboratories 

¶ t-crit   - Critical t-value for the Student's test (from statistical tables) 

¶ Hypothesis - Result of testing the hypothesis that the compared Methods are equal 
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Conclusion: summarizes the result of testing the hypothesis that both compared Methods/Laboratories give the 

same results in all Levels, i.e. the Analytical Methods is accurate compared to the reference Method.  

 

The automatically opened Graph window compares averages of Measured values of the Validated Property 

obtained using Method 1 (y-axis) and Method 2 (x-axis). The straight line on the main diagonal corresponds to 

the ideal, absolutely accurate Method.  

    

5.3.5.8 COMPARISON OF 2 METHODS/LABORATORIES: t-test on Difference of Results 
  

Click Accuracy and Comparison of 2 Methods/Laboratories: t-test on Difference of Results in the Validation 

(e.g. Full) window and then choose OK. The Data Table ï Accuracy: Comparison of 2 Methods/Laboratories: t-

test on Difference of Results window opened.  

Rows of the Data Table correspond to individual Levels of Validated Property (typically concentration). In the 

column Method 1 enter results of Validated Property obtained using Method 1 (reference method), in the 

column Method 2 enter results of Validated Property obtained using Method 2 (validated method). The number 

of filled in rows in both columns must be equal, otherwise the algorithm cannot be started. 
 

Click the Calculate icon or choose Results > Calculate to start the calculation of Accuracy and to show the 

Results window. Click Graph to display the corresponding graph. The Results window displays: 

¶ Mean Difference  - Mean difference between Method 1 and Method 2 in Data Table  

¶ Difference Precision - Standard deviation of differences between Method 1 and Method 2 in  

      Data Table 

¶ Confidence Interval - Confidence interval around the Mean Difference between Method 1  

      and Method 2 

¶ Hypothesis  - Result of testing the hypothesis that the compared methods are equal 

Conclusion: summarizes the result of testing the hypothesis that both compared Methods/Laboratories give the 

same results, i.e. the Analytical Methods are accurate compared to the reference Method.  

 

The automatically opened Graph window shows the plot of results obtained using Method 1 (y-axis) versus 

Method 2 (x-axis). The straight line on the main diagonal corresponds to the ideal, absolutely accurate Method.  

 

5.3.6 SELECTIVITY      

 

Selectivity characterizes the ability of the Method to provide a measured signal, which is selective with respect 

to the Validated Property of interest. If a Method is selective, the influence of potential interferences (matrix) on 

the results is negligible. When the influence of interferences is significant, then the Method cannot be considered 

selective. 
 

To evaluate Selectivity, the following methods can be used: 

o Comparison of Calibration Lines 

o Comparison of Results with a Standard 

o Comparison of Results with Measurements without Interference 

 

5.3.6.1 COMPARISON OF CALIBRATION LINES  

 

Click Selectivity and Comparison of Calibration Lines in the Validation (e.g. Full) window and then choose OK. 

The Data Table ï Selectivity: Comparison of Calibration Lines window is displayed. The minimum 

(recommended, respectively) number of Levels for Validated Property is 3 and 6. The number of interferences 

that are subject to testing must range from 1 to 9.  

In the Number of Inter ferences box above the table, enter the number of potential interferences against which 

the method Selectivity is tested. With respect to this number, the software will generate a number of column 

pairs equal to the number of interferences.  

In the Validated Property 0 and Measrt 0 columns, enter the concentration (Validated Property) and response 

(e.g. absorbance) corresponding to individual calibration standards (Levels - rows) without interference. In each 

of the following column pairs (i.e. Validated Property 1 and Measrt 1, Validated Property 2 and Measrt 2) 

enter data corresponding to calibration in the presence of Interference 1, Interference 2, etc. The amount of 

interference added to calibration standards is chosen with respect to the expected concentration of interferences 

in unknown samples. This amount can be constant or increasing with concentration of the standard.  

The number of calibration samples measured for each tested Interference is often not constant in practice 

(because under some experimental combinations results cannot be obtained). For this reason, fill in the empty 
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cells (results not available) at the end of the Data Table with ï1 values. These values are then omitted in the 

calculation. 

 

Click the Calculate icon or choose Results > Calculate to start the calculation of Selectivity and to display the 

Results window. Results compare the calibration without Interference to the calibration in the presence of 

Interference 1, 2, etc.:  
¶ Calibration   - Type of calibration: without/without Interference 

¶ Slope   - Numerical value of the calibration slope  

¶ t  - Calculated t-value used to compare the slope of the calibration line with and without 

     the Interference using the Student's test 

¶ t_crit   - Critical t-value of Student's t-test (from statistical tables) 

¶ Hypothesis - Result of testing the hypothesis that the Analytical Method tested is selective  

     against the tested interference (t < t-crit ) 

Conclusion: summarizes the result of the hypothesis that the Analytical M ethod provides selective results for 

all Interferences tested.  
 

The automatically opened Graph window compares the calibration line Without Interference to the calibration 

lines with individual Interferences. If the slope of the calibration line with Interference is not statistically 

different from the slope of the calibration line without Interference, then the Selectivity of the Method against 

the given Interference is confirmed. 

 

5.3.6.2 COMPARISON OF RESULTS WITH A STANDARD 

 

Click Selectivity and Comparison of Results with a Standard in the Validation (e.g. Full) window and then 

choose OK. The Data Table ï Selectivity: Comparison of Results with a Standard window is displayed.  

Rows of Data Table correspond to individual Levels of Validated Property (concentration). In the Reference 

column, type in the value of Validated Property in the reference material (known from weighing, pipetting, etc.). 

In the columns Measrt 1 to Measrt 30, enter values of repeatedly measured Validated Property in the given 

Level in the presence of the tested Interference. The minimum number of measurements in a Level is 2 (the red 

box), the recommended number is 6 (the green box). The recommended number of Levels (rows) is 3: at the 

lower limit, in the middle and at the upper limit of the Range. 

 

Click the Calculate icon or choose Results > Calculate to start the calculation of Selectivity and to show the 

Results window. For every Interference/amount of Interference (row), the following characteristics are 

presented: 

¶ Level  - Copy of the Level number column in Data Table  

¶ Description - Copy of the Description column in Data Table  

¶ Reference - Copy of the Reference column in Data Table  

¶ Measured - Row average of Measrt values from Data Table  

¶ Precision - Row standard deviation of Measrt values from Data Table 

¶ n  - Number of Measrt values in the given Level (row) 

¶ t  - Calculated t for the Student's t-test 

¶ t-crit   - Critical t-value for the Student's test (from statistical tables) 

¶ Hypothesis - Result of testing the hypothesis for the given Interference/amounts 

Conclusion: summarizes the result of testing the hypothesis that the Analytical Method is selective against all 

Interferences and amounts tested.  
 

The automatically opened Graph window shows the plot of Measured values recorded in the presence of the 

tested Interference (y-axis) against the Reference (x-axis) values of Validated Property obtained without the 

presence of Interference. The straight line on the main diagonal corresponds to the situation where the 

Interference has no influence on the results, so that the tested Method is selective against the Interference tested 

in the tested amounts. 

  

5.3.6.3 COMPARISON OF RESULTS WITH MEASUREMENTS WITHOUT INTERFERENCE 

 

Click Selectivity and Comparison of Results with Measurements without Interference in the Validation (e.g. Full) 

window and then choose OK. The Data Table ï Selectivity: Comparison of Results with Measurements without 

Interference window is displayed. The minimum (recommended) number of Levels is 1 (3). The number of 

Measurements without and with Interference must be 3, otherwise the algorithm cannot be started! 
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Rows in the Data Table correspond to individual Levels of Validated Property (typically concentration) or 

amount of Interference, the columns correspond to results obtained by repeatedly measured Validated Property 

in the given Level. In the Without Int. 1  to 3 columns, enter results of 3 times repeated Measurements of 

Validated Property in the sample without Interference. In the With int. 1  to 3 columns, enter results of 3 times 

repeated Measurements of Validated Property in the same sample after addition of Interference. 

 

Click the Calculate icon or choose Results > Calculate to start the calculation of Selectivity and to show the 

Results window. For every Interference/amount of Interference (row), the following characteristics are 

presented: 

¶ Level  - Copy of the Level number column in Data Table  

¶ Description - Copy of the Description column in Data Table  

¶ Without Int.  - Average of Without Int. 1 to 3 values in the Level in Data Table  

¶ With Int.  - Average of With Int.  1 to 3 values in the Level in Data Table  

¶ t  - Calculated t for the Student's t-test to compare Without Int. and With Int.   

¶ t-crit   - Critical t-value for the Student's test (from statistical tables) 

¶ Hypothesis - Result of testing the hypothesis that the average Without Int.  is equal to With  Int.   

Conclusion: summarizes the result of testing the hypothesis that all average values with and without Interference 

are the same, i.e. the Analytical Method is selective against all Interferences and amounts tested. 

 

The automatically opened Graph window compares average results of the Validated Property obtained With (y-

axis) and Without (x-axis) the tested Interference. The straight line on the main diagonal corresponds to the 

situation where the Interference has no influence on the results; i. e. the Analytical Method is selective against 

the tested Interferences in the tested amounts. 

 

5.3.7 SENSITIVITY      

 

Sensitivity is defined by IUPAC as the change in signal caused by a unit change of Validated Property (i.e. slope 

of calibration line). Alternatively, Sensitivity is evaluated as the minimum difference in Validated Property 

between two samples that can be reliably distinguished with the given Method. 

 

To evaluate Sensitivity, two algorithms can be used: 

o From Calibration Line 

o Minimum Difference in the Validated Property 

 

5.3.7.1 FROM CALIBRATION L INE  

 

Click Sensitivity and From Calibration Line in the Validation (e.g. Full) window and then choose OK. The Data 

Table ï Sensitivity: From Calibration Line window is opened. The minimum/recommended number of Levels is 

3/6. The minimum and recommended number of Measurements is 1. 

In the Val. Pr. column, enter the values of Validated Property (concentration) in individual standards (rows). In 

the Measrt 1 (2 to 30) column, enter the response values (absorbance, peak areas, etc.) recorded for individual 

standards. The minimum number of Levels (rows) is 3 (the red box), the recommended number is 6 (the green 

box).  

 

Click the Calculate icon or choose Results > Calculate to start the calculation of Sensitivity and to show the 

Results window. Click Graph to display the corresponding graph.  

The Results window shows the Sensitivity of the validated Analytical Method calculated as a slope of the 

calibration line  

Conclusion: summarizes the evaluation of Sensitivity of Analytical Method determined as the Slope of the 

calibration line. 

 

The automatically opened Graph window shows the calibration data fitted with a straight line. The slope of the 

calibration line defines Sensitivity of the Method. 

 

5.3.7.2 MINIMUM  DIFFERENCE IN THE VALIDATED PROPERTY  

 

Click Sensitivity and Minimum Difference in the Validated Property in the Validation (e.g. Full) window and 

then choose OK. The Data Table ï Sensitivity: Minimum Difference in the Validated Property window is 

opened.  

In the window, enter the following data: 
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Repeatability of the Validated Property - Repeatability of Validated Property evaluated by the 

                      EffiValidation 3.0 software 

Number of repetitions for repeatability - Number of measurements applied to evaluate Repeatability 

Confidence Level 100*(1-alfa)  - Confidence Level (1-alfa)*100, i.e. 95 or 99 % 

 

Click Calculate to start the calculation of Sensitivity and to display the Results window.  

The Results window shows the Sensitivity (value) of the validated Method determined as the Min. difference in 

Validated Property (concentration). This is the difference that allows to distinguish two different samples. 

 

Click Print to print data and results and/or to display Preview.  

 

5.3.8 LINEARITY       

 

  o Correlation and QC Coefficient  

  o ANOVA for Lack-of-Fit 

  o Significance of the Quadratic Term ï F-test 

   o Sign Test 

The choice of method to evaluate Linearity is described in Chapter 5.4. 

 

5.3.8.1 CORRELATION AND QC COEFFICIENT  

 

Click on Linearity and Correlation and QC coefficient in the Validation (e.g. Full) window and then choose OK. 

The Data Table ï Linearity: Correlation and QC coefficient window is displayed.  

In the Val. Pr. column, enter the values of Validated Property (concentration) in individual standards (rows). In 

the Measrt 1 (2 to 30) column, enter the response values (absorbance, peak areas, etc.) recorded for individual 

standards. The minimum number of Levels (rows) is 3 (the red box), the recommended number is 6 (the green 

box).  

 

Click the Calculate icon or choose Results > Calculate to start the calculation of Linearity and to display the 

Results window. Click Graph to display the corresponding graph. The Results window shows: 

¶ Calculated R  - Correlation Coefficient calculated from data in Data Table  

¶ Reference R  - Correlation Coefficient used for comparison to Calculated R to test  

      linearity (usually 0.99) 

¶ Calculated QC  - QC Coefficient calculated from data in Data Table  

¶ Reference QC  - QC Coefficient used for comparison to Calculated QC to test linearity 

      (usually 5.0 %) 

¶ Hypothesis  - When Calculated R > Reference R and Calculated QC < Reference QC 

      then the relationship between Val. Property and Measurements is  

      considered to be linear 

Conclusion: summarizes the result of evaluating the hypothesis about the Linearity of the Method based on 

the Correlation and QC coefficient. 
 

The automatically opened Graph window shows the Linearity data fitted with a straight line. 

 

5.3.8.2 ANOVA  FOR LACK OF FIT  

 

Click Linearity and ANOVA for Lack of Fit in the Validation (e.g. Full) window and then choose OK. The Data 

Table ï Linearity: ANOVA for Lack of Fit window is displayed.  

In the Val. Pr. column, enter the values of Validated Property (concentration) in individual standards (rows). In 

the Measrt 1 to 30 columns (min. 2 - the red box; recommended 3 - the green box), enter the response values 

(absorbance, peak areas, etc.) recorded for the individual standards. The minimum number of Levels (rows) is 3 

(the red box), the recommended number of Levels is 6 (the green box).  

 

Click the Calculate icon or choose Results > Calculate to start the evaluation of Linearity and to display the 

Results window. Click Graph to display the corresponding graph. The Results window shows for two sources of 

variance in data, i.e. Repetition and Lack-of-Fit, the following characteristics: 

¶ Source   - Name for the source of variance considered  

¶ Sum of Squares  - Sum of squared residuals from the given source of variance  

¶ Degrees of Freedom - Number of degrees of freedom associated with the given source of variance 

¶ Average Sum of Squares - Average sum of squares Sum of Squares/Degrees of Freedom 
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¶ F   - Calculated F to evaluate Linearity using Fischer's t-test 

¶ F-crit    - Critical F-value for the Fischer's test (from statistical tables) 

¶ Hypothesis  - Result of testing the hypothesis that the fitness of data by a linear  

      relationship is acceptable. When F < F-critical , then the hypothesis  

      is accepted. 

Conclusion: summarizes the result of testing the hypothesis about the Linearity of the Method based on 

ANOVA for Lack-of -Fit.  

 

The automatically opened Graph window shows the multiple Linearity data fitted with the straight line. 

 

5.3.8.3 SIGNIFICANCE OF THE QUADRATIC TERM ï F-TEST  

 

Click Linearity and Significance of the Quadratic Term in the Validation (e.g. Full) window and then choose 

OK. The Data Table ï Linearity: Significance of the Quadratic Term window is displayed.  

In the Val. Pr. column, enter the values of Validated Property (concentration) in individual standards (rows). In 

the Measrt 1, enter the response values (absorbance, peak areas, etc.) recorded for individual standards. The 

minimum number of Levels (rows) is 6 (the red box), the recommended number is 8 (the green box).  

 

Click the Calculate icon or choose Results > Calculate to start the evaluation of Linearity and to display the 

Results window. Click Graph to display the corresponding graph. The Results window compares the fitness of 

data using two models, linear and quadratic: 

¶ RSS l  - Residual sum of squares for the linear model 

¶ RSS k  - Residual sum of squares for the quadratic model  

¶ F  - Calculated F of Fischer's t-test to evaluate the significance of the quadratic term 

¶ F-crit   - Critical F-value for the Fischer's test (from statistical tables) 

¶ Hypothesis - Result of testing the hypothesis that the fitness of data using a linear and a quadratic 

     model is comparable. When F < F-critical  , then the hypothesis is accepted. 

Conclusion: summarizes the result of testing the hypothesis about the Linearity of the Method based on F-test 

testing the significance of the quadratic term. 

 

The automatically opened Graph window shows the Linearity data fitted with a straight line, which can be used 

to evaluate the (non) linearity of the relationship tested. 

 

5.3.8.4 SIGN TEST  

 

Click Linearity and Sign Test in the Validation (e.g. Full) window and then choose OK. The Data Table ï 

Linearity: Sign Test window is displayed.  

In the Val. Pr. column, enter the values of Validated Property (concentration) in individual standards (rows). In 

the Measrt 1 column, enter the response values (absorbance, peak areas, etc.) recorded for individual standards. 

The minimum number of Levels (rows) is 15 (the red box).  

 

Click the Calculate icon or choose Results > Calculate to start the calculation of Linearity and to display the 

Results window. Click Graph to display the corresponding graph. The Results window shows: 

¶ Number of Positive Residuals - Number of residuals which have a positive sign when data are  

       fitted by a straight line 

¶ Number of Negative Residuals - Number of residuals which have a negative sign when data are  

       fitted by a straight line 

¶ Like Signs   - Number of sign changes when data are fitted with a straight line  

¶ Critical Value    - Critical value for the sign test (from statistical tables) 

¶ Hypothesis   - Result of testing the hypothesis that the frequency of changes  

       in residual signs along the straight line is sufficient  

Conclusion: summarizes the result of testing the hypothesis about the Linearity of the Method based on Sign 

test. 

 

The automatically opened Graph window shows the linearity data fitted with a straight line.  

 

5.3.9 RANGE       

 

Click Range in the Validation (e.g. Full) window and choose OK to open the Range window. Range 
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characterizes the range of Validated Property within which validation parameters, such as Repeatability, 

Accuracy, Linearity, etc. have been evaluated and verified.  

In this window, enter data as follows: 

Lower validated limit for the Validated Property  - Lower limit that is subject to validation  

Upper validated limit for the Validated Property  - Upper limit that is subject to validation  

Click Save to save data to database and to open the Results window. 

Click Print and/or Preview to start printing or to display the print-ready data on screen. 

 

5.3.10 LIMIT  OF DETECTION AND LIMIT  OF QUANTIFICATION   

 

Limit of Detection is a Level above which the signal of a sample can be reliable distinguished from a blank; this 

means that starting from this Level a qualitative determination can be carried out. Limit of Quantification is a 

Level above which a quantitative determination can be carried out with sufficient reliability. Both Limits are 

determined as a multiple of standard deviation of blank, from the calibration line or from noise in 

chromatography. 

 

To evaluate the Limits, the following methods can be used: 

  o 3s - IUPAC  

  o 3s ï Every Sample Corrected for Blank 

  o 3s ï Continuously Measured Blank 

  o From Calibration Line 

  o From Signal of Blank in Chromatography 

The choice of method to evaluate Limit of Detection and Limit of Quantification is described in chapter 5.4. 

 

5.3.10.1   3S - IUPAC  

 

Click Limits and 3s - IUPAC in the Validation (e.g. Full) window and then choose OK. The Data Table ï Limits: 

3s - IUPAC window is opened.  

In the Slope box above the table, type in the Slope of calibration line Measurement (e.g. absorbance) versus 

Validated Property (concentration), estimated with e.g. EffiValidation 3.0 software. The Units considered for 

Slope have to be compatible with Units for Measurements. (The slope entered will be used to recalculate Limit 

of Detection and Limit of Quantification from Units of Measurements to Units of Validated Property. In case the 

Slope is not known, enter Slope = 1. Otherwise, the calculation cannot be carried out.) 

In the first row, enter results of repeatedly measured blank in Measrt 1 to 30. This is the sample that is 

considered to have a zero Level of the Validated Property. The minimum number of Measurements is 2 (the red 

box), the recommended number of Measurements is 6 (the green box).  

  

Click the Calculate icon or choose Results > Calculate to start the calculation of Limit of Detection and Limit of 

Quantification and to open the Results window. Click Graph to display the corresponding graph. The Results 

window shows: 

¶ Measurement on the Limit of Detection  - Measurement (e.g. absorbance) on the Limit of  

         Detection calculated from data in Data Table  

¶ Measurement on the Limit of Quantification - Measurement (e.g. absorbance) on the Limit of  

         Quantification calculated from data in Data Table  

¶ Validated Property on the Limit of Detection - Val. Property (e.g. concentration) on the Limit of  

    Detection calculated from the Measurement on the  

  Limit of Detection and Slope of calibration line 

¶ Validated Property on the Limit of Quantification  - Val. Property (e.g. concentration) on the Limit of  

     Quantification calculated from the Measurements  

    on Limit of Quantification  and Slope calibration 

Conclusion: summarizes the numerical values of Limit Detection and Limit of Quantification estimated using 

the 3S -  IUPAC method. 

 

The automatically displayed Graph shows the variability of repeated blank Measurements, and the position of 

the Limit of Detection and the Limit of Quantification. 

 

5.3.10.2   3S ï EVERY SAMPLE CORRECTED FOR BLANK  

 

Click Limits and 3 S ï Every Sample Corrected for Blank in the Validation (e.g. Full) window and then choose 

OK. The Data Table ï Limits: 3 S ï Every Sample Corrected for Blank window is displayed.  
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In the Slope box above the table, type in the Slope of calibration line Measurement (e.g. absorbance) versus 

Validated Property (concentration), estimated with e.g. EffiValidation 3.0 software. The Units considered for 

Slope have to be compatible with Units for Measurements. (The slope entered will be used to recalculate Limit 

of Detection and Limit of Quantification from Units of Measurements to Units of Validated Property. In case the 

Slope is not known, enter Slope = 1. Otherwise, the calculation cannot be carried out.) 

In the first row, enter results of repeatedly measured blank in Measrt 1 to 30. This is the sample that is 

considered to have a zero Level of the Validated Property. The minimum number of Measurements is 2 (the red 

box), the recommended number of Measurements is 6 (the green box).  

  

Click the Calculate icon or choose Results > Calculate to start the calculation of Limit of Detection and Limit of 

Quantification and to open the Results window. Click Graph to display the corresponding graph. The Results 

window shows: 

¶ Measurement on the Limit of Detection  - Measurement (e.g. absorbance) on the Limit of  

         Detection calculated from data in Data Table  

¶ Measurement on the Limit of Quantification - Measurement (e.g. absorbance) on the Limit of  

         Quantification calculated from data in Data Table  

¶ Validated Property on the Limit of Detection - Val. Property (e.g. concentration) on the Limit of  

    Detection calculated from the Measurement on the  

  Limit of Detection and Slope of calibration line 

¶ Validated Property on the Limit of Quantification  - Val. Property (e.g. concentration) on the Limit of  

     Quantification calculated from the Measurements  

    on Limit of Quantification and Slope of calibration 

Conclusion: summarizes the numerical values of Limit Detection and Limit of Quantification estimated using 

the 3s - Every Sample Corrected for Blank method. 
 

The automatically displayed Graph shows the variability of repeated blank Measurements, and the position of 

the Limit of Detection and the Limit of Quantification. 
 

Note: in case the Limits are validated using 3 S ï Every Sample Corrected for Blank, then every sample must be 

routinely measured with blank and corrected for. Otherwise the procedure to evaluate limits is not well selected. 
 

5.3.10.3   3S ï CONTINUOUSLY MEASURED BLANK  
 

Click Limits and 3 S ï Continuously Measured Blank in the Validation (e.g. Full) window and then choose 

OK. The Data Table ï Limits: 3 S ï Continuously Measured Blank window is displayed.  

In the Slope box above the table, type in the Slope of calibration line Measurement (e.g. absorbance) versus 

Validated Property (concentration), estimated with e.g. EffiValidation 3.0 software. The Units considered for 

Slope have to be compatible with Units for Measurements. (The slope entered will be used to recalculate 

Limit of Detection and Limit of Quantification from Units of Measurements to Units of Validated Property. 

In case the Slope is not known, enter Slope = 1. Otherwise, the calculation cannot be carried out.) 

In the first row, enter results of repeatedly measured blank in Measrt 1 to 30. This is the sample that is 

considered to have a zero Level of the Validated Property. The minimum number of Measurements is 2 (the 

red box), the recommended number of Measurements is 6 (the green box).  
  

Click the Calculate icon or choose Results > Calculate to start the calculation of Limit of Detection and 

Limit of Quantification and to open the Results window. Click Graph to display the corresponding graph. 

The Results window shows: 

¶ Measurement on the Limit of Detection - Measurement (e.g. absorbance) on the Limit of  

         Detection calculated from data in Data Table  

¶ Measurement on the Limit of Quantification - Measurement (e.g. absorbance) on the Limit of  

         Quantification calculated from data in Data Table  

¶ Validated Property on the Limit of Detection - Val. Property (e.g. concentration) on the Limit of  

    Detection calculated from the Measurement on the  

  Limit of Detection and Slope of calibration line 

¶ Validated Property on the Limit of Quantification  - Val. Property (e.g. concentration) on the  

     Limit of Quantification calculated from the  

Measurements on Limit of Quantification and 

Slope of calibration 

Conclusion: summarizes the numerical values of Limit Detection and Limit of Qua ntification estimated 

using the 3s ï Continuously Measured Blank method. 
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The automatically displayed Graph shows the variability of repeated blank Measurements, and the position of 

the Limit of Detection and the Limit of Quantification. 

 

Note: in case the Limits are validated using 3  ï Continuously Measured Blank, then the blank must be 

routinely measured and measurements for samples corrected for blank. Otherwise the procedure to evaluate 

Limits is not well selected. 

 

5.3.10.4 FROM CALIBRATION LINE  

 

Click Limits and From Calibration Line in the Validation (e.g. Full) window and then choose OK. The Data 

Table ï Limits: From Calibration Line window is opened.  

 

In the Val. Pr. column, enter the values of Validated Property (concentration) in individual standards (rows). In 

the Measrt 1 (2 to 30) column, enter the response values (absorbance, peak areas, etc.) recorded for individual 

standards. The minimum number of Levels (rows) is 3 (the red box), the recommended number is 6 (the green 

box).  

Click the Calculate icon or choose Results > Calculate to start the calculation of the Limit of Detection and 

Limit of Quantification and to show the Results window. Click Graph to display the corresponding graph. The 

Results window shows: 

¶ Measurement on the Limit of Detection  - Measurement (e.g. absorbance) on the Limit of  

         Detection calculated from data in Data Table  

¶ Measurement on the Limit of Quantification - Measurement (e.g. absorbance) on the Limit of  

         Quantification calculated from data in Data Table  

¶ Validated Property on the Limit of Detection - Val. Property (e.g. concentration) on the Limit of  

    Detection calculated from the Measurement on the  

  Limit of Detection and Slope of calibration line 

¶ Validated Property on the Limit of Quantif ication - Val. Property (e.g. concentration) on the Limit of  

     Quantification calculated from the Measurements  

    on Limit of Quantification and Slope of calibration 

Conclusion: summarizes the numerical values of Limit Detection and Limit of Quantifi cation estimated using 

the method of Calibration Line. 

 

The automatically displayed Graph shows the calibration line with the Limit of Detection and Limit of 

Quantification. 

 

Note: If the Limits are validated using the From Calibration Line procedure, the calibration must be used in a 

routine application of the Method. It is not recommended to evaluate Limits from e.g. 15 standards calibration, 

but use only 5 standards calibration in routine (Limits calculated would be over optimistic). 

 

5.3.10.5 FROM SIGNAL OF BLANK IN CHROMATOGRAPHY  

 

Click Limits and From Signal of Blank in Chromatography in the Validation (e.g. Full) window and then choose 

OK. The Data Table ï Limits: From Signal of Blank in Chromatography window is displayed.  

In this window, enter the following values: 

 Max. Deviation of Baseline  - Max. deviation of the baseline (in [mV]) read on the chromatogram 

         of blank in the range defined as 20-times half-width of the peak  

         of interest (e.g. in the range from 3 to 15 min.) 

 Slope of Calibration Line   - Slope of calibration line ñPeak height ï Concentrationò, in Units  

         compatible with Units used for the Max. Deviation of Baseline 

 

Click the Calculate button to start the calculation of Limit of Detection and Limit of Quantification and to open 

the Results window. The Results window shows:   

¶ Measurement on the Limit of Detection  - Measurement (e.g. absorbance) on the Limit of  

         Detection  

¶ Measurement on the Limit of Quantification - Measurement (e.g. absorbance) on the Limit of  

         Quantification  

¶ Validated Property on the Limit of Detection - Val. Property (e.g. concentration) on the Limit of  

    Detection  

¶ Validated Property on the Limit of Quantification  - Val. Property (e.g. concentration) on the Limit of  

     Quantification  
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Conclusion: summarizes the numerical values of Limit Detection and Limit of Quantification based on 

Chromatographic blank. 

 

To print data from Data Table or results from the Results window, click Print or Preview. 

 

5.3.11 BLANK       

 

Click Blank in the Full Validation window and then choose OK. The Data Table ï Blank window is displayed.  

In the first row, enter results of repeated measurements (Measrt, e.g. absorbance) of Blank (i.e. a sample with a 

zero Level of the Validated Property). The minimum number of Measurements is 2 (the red box), the 

recommended number is 6 (the green box).  

 

Click the Calculate button to start the calculation of average and standard deviation of Blank and to show the 

Results window. The Results window includes:   

¶ Average Blank  - Average Measurement in Level 1 (row average) 

¶ Standard Deviation  - Blank standard deviation, i.e. standard deviation of Measrts in Level 1 

¶ Rel. Standard Deviation - 100*Standard Deviation/Average Blank 

¶ n   - Number of measurements in Level 1  

Conclusion: summarizes the evaluation of Blank, i.e. Average Blank of the Method and the corresponding 

Standard Deviation. 

 

The automatically displayed Graph window shows the variability (y-axis) of repeatedly (x-axis) measured Blank.  

 

5.3.12  REPEATABILITY OF INJECTION - FDA    

 

Repeatability of Injection characterizes the best precision of injection that can be achieved with an HPLC 

Analytical Method. Click Repeatability of Injection in the HPLC ï System Suitability ï FDA window and then 

choose OK. The Data Table ï Repeatability of Injection - FDA window is opened.  

Rows in the Data Table correspond to individual injections; the columns correspond to repeatedly measured 

responses (Measrt) of injection. The minimum number of injections for a sample is 2 (the red box), the 

recommended number is 6 (the green box). The recommended number of samples (rows) is 3: at the lower limit, 

in the middle and at the upper limit of the Range.  

 

Click the Calculate icon or choose Results > Calculate to start the calculation of Repeatability of Injection and to 

show the Results window. Click Graph to display the corresponding graph. For every Level of the Validated 

Property (sample) the following characteristics are presented in the Results window: 

¶ Level   - Copy of the Level number in Data Table  

¶ Description  - Copy of the Description in Data Table  

¶ Average   - Average Measrt in a Level (row average) 

¶ Repeatability   - Measurement standard deviation in a Level (STD row) 

¶ Rel. Repeatability - 100*Repeatability/Average  

¶ n   - Number of measurements in a Level (row) 

Conclusion: summarizes the Repeatability of Injection evaluation. Repeatability and Rel. Repeatability are 

pooled (weight) averages of the Repeatability of Injection values from the table above, weight with respect to the 

number of measurements in a Level. The resulting Rel. Repeatability is compared to the general requirement for 

Rel. Repeatability of Injection (see Chapter 9.5). 

  

The automatically displayed Graph window shows the variability of multiple injections (y-axis) for individual 

samples/sample volumes (x-axis). 

 

5.3.13  CAPACITY FACTOR - FDA     

 

Capacity Factor characterizes the dead volume of the used chromatographic system. Click Capacity Factor in 

the HPLC ï System Suitability ï FDA window and then choose OK. The Data Table ï Capacity Factor - FDA 

window is opened. The minimum/recommended number of experiments to evaluate Capacity Factor is 1/3. 

Enter Ret. (Retention) Time and Dead Vol. (Volume). Rows in the Data Table correspond to repeated 

injections of the sample/standard.  
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Click the Calculate icon or choose Results > Calculate to start the calculation of the Capacity Factor and to show 

the Results window.  

 Results of evaluation Capacity Factor - FDA: The Results window shows for every experiment (row): 

¶ Description  - Copy of the Description column in Data Table  

¶ Capacity factor   - Capacity Factor obtained in the given experiment 

Conclusion: summarizes the evaluation of Capacity Factor by comparing the average Capacity Factor from all 

experiments with the generally considered criterion for Capacity Factor (see Chapter 9.5). 

 

5.3.14  RESOLUTION - FDA      

Resolution characterizes the degree of peak separation in chromatography. Click Resolution in the HPLC ï 

System Suitability ï FDA window and then choose OK. The Data Table ï Resolution - FDA window is 

displayed. The minimum/recommended number of experiments to evaluate Resolution is 1/3. 

Enter Ret. (Retention) Time 1 and 2 (min.) and Half -W. (Half Width) 1 and 2 (min.) for peaks 1 and 2. Rows 

in the Data Table correspond to repeated injections of the sample/standard. 

 

Click the Calculate icon or choose Results > Calculate to start the calculation of peak Resolution and to show 

the Results window.  

Results of evaluation Resolution: The Results window shows for every experiment (row): 

¶ Description  - Copy of the Description column in Data Table  

¶ Resolution   - Resolution obtained in the given experiment 

Conclusion: summarizes the evaluation of Resolution by comparing the average Resolution obtained from all 

experiments with the generally considered criterion for Resolution. 

 

5.3.15  TAILING  - FDA     

 

Tailing characterizes the degree of peak tailing in chromatography. Click Tailing in the HPLC ï System 

Suitability ï FDA window and then choose OK. The window Data Table ï Tailing - FDA is opened. The 

minimum/recommended number of experiments to evaluate the peak Tailing is 1 (3 respectively). 

Enter Peak Width at 5% height from baseline and the time Difference Max. - Start.  

Rows in the Data Table correspond to repeated injections of the sample/standard.  

 

Click the Calculate icon or choose Results > Calculate to start the calculation of Peak Resolution and to show 

the Results window.  

Results of evaluation Tailing - FDA: Results window shows for every experiment (row): 

¶ Description  - Copy of the Description column in Data Table  

¶ Tailing     - Tailing obtained in the given experiment 

Conclusion: summarizes the evaluation of Tailing - FDA, i.e. average Tailing from all experiments and 

compares it to the generally considered Criterion for Tailing (see Chapter 9.5). 

 

5.3.16  THEORETICAL PLATE NUMBER - FDA     

 

Theoretical Plate Number characterizes the separation abilities of the chromatographic Method used. Click 

Theoretical Plate Number in the HPLC ï System Suitability ï FDA window and then choose OK. The window 

Data Table ï Theoretical Plate Number - FDA is displayed. The minimum/recommended number of experiments 

to evaluate Theoretical Plate Number is 1 (3 respectively). 

Enter Ret. (Retention) Time and Peak Width at Baseline. Rows in the Data Table correspond to repeated 

injections of the sample/standard.  

 

Click the Calculate icon or choose Results > Calculate to start the calculation of Theoretical Plate Number and 

to show the Results window.  

Results of evaluation Theoretical Plate Number - FDA: The Results window shows for every experiment 

(row): 

¶ Description  - Copy of the Description column in Data Table  

¶ Theoretical Plate Number - Theoretical Plate Number obtained in the given experiment 

Conclusion: summarizes the evaluation of Theoretical Plate Number - FDA, i.e. average number of Theoretical 

Plate Numbers and compares it to the generally considered criterion for Theoretical Plate Number (see Chapter 

9.5).  
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5.3.17  THEORETICAL PLATE NUMBER - PH.EUR.    

 

Theoretical Plate Number characterizes the separation abilities of the chromatographic Method used. Click 

Theoretical Plate Number in the HPLC ï System Suitability ï PhEur window and then choose OK. The Data 

Table ï Theoretical Plate Number - PhEur window is opened. The minimum/recommended number of 

experiments to evaluate Theoretical Plate Number is 1/3. 

Enter Ret. (Retention) Time and Peak Half-Width . Rows in the Data Table correspond to repeated injections 

of the sample/standard.  

 

Click the Calculate icon or choose Results > Calculate to start the calculation of Peak Resolution and to show 

the Results window.  

Results of evaluation Theoretical Plate Number - PhEur: The Results window shows for every experiment 

(row): 

¶ Description   - Copy of the Description column in Data Table  

¶ Theoretical Plate Number - Theoretical Plate Number obtained in the given experiment 

Conclusion: summarizes the evaluation of Theoretical Plate Number ï PhEur, i.e. average number of 

Theoretical Plates and compares it to the generally considered criterion for Theoretical Plate Number (see 

Chapter 9.5).  

 

5.3.18  RESOLUTION - PH.EUR.      

 

Resolution characterizes the degree of peak separation in chromatography. Click Resolution in the HPLC ï 

System Suitability ï PhEur window and then choose OK. The Data Table ï Resolution ï PhEur window is 

displayed. The minimum/recommended number of experiments to evaluate Resolution is 1/3. 

Enter Ret. (Retention) Time 1 and 2 (min.) and Half -W.  (Half-Width) 1  and 2 (min.) for peaks 1 and 2. Rows 

in the Data Table correspond to repeated injections of the sample/standard. 

 

Click the Calculate icon or choose Results > Calculate to start the calculation of peak Resolution and to show 

the Results window.  

Results of evaluation Peak resolution - Ph.Eur.: The Results window shows for every experiment (row): 

¶ Description   - Copy of the Description column in Data Table  

¶ Tailing      - Tailing obtained in the given experiment 

Conclusion: summarizes the evaluation of Peak resolution ï Ph.Eur., i.e. average Resolution from all 

experiments and compares it to the generally considered criterion for peak Resolution (see Chapter 9.5).  

 

5.3.19  SYMMETRY FACTOR ï PH.EUR     

 

Symmetry Factor characterizes the symmetry of the peak of interest in chromatography. Click Symmetry Factor 

in the HPLC ï Symmetry Factor ï PhEur window and then choose OK. The Data Table ï Symmetry Factor ï 

PhEur window is displayed. The minimum/recommended number of experiments to evaluate Symmetry Factor 

is 1, resp. 3. 

Enter Peak Width at 5% height of the peak and Distance. Rows in the Data Table correspond to repeated 

injections of the sample/standard.  

 

Click the Calculate icon or choose Results > Calculate to start the calculation of Symmetry Factor and to show 

the Results window.  

Results of evaluation Symmetry Factor - Ph.Eur.: The Results window shows for every experiment (row): 

¶ Description   - Copy of the Description column in Data Table  

¶ Symmetry Factor   - Symmetry Factor obtained in the given experiment 

Conclusion: summarizes the evaluation of Symmetry Factor, i.e. average Symmetry Factor from all 

experiments.  

 

5.4 SELECTION OF THE EVALUATION M ETHOD         

 

Validation parameters Reproducibility, Accuracy, Linearity, Limit of Detection/Quantification, Sensitivity and 

Reproducibility can be evaluated in different ways. Selection of the evaluation method depends on the type of 

validated Analytical Method, intended goal of Validation, on the extent of data (available or not available), and 

on particular requirements of the sample submitter.  
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5.4.1 REATABILITY       

 

(a) Level by Level from Multiple Measurements: 

Application area: when results of multiple repeated measurements can be measured/are available.  

Procedure: carry out (6 ï 10) repeated measurements of several samples or standards (usually 3) covering the 

whole considered Range and evaluate results. 

Statistical evaluation method: calculation of standard deviation and relative standard deviation. 

(b) From Parallel Measurements: 

Application area: when results of parallel measurements are available.  

Procedure: carry our parallel (2) measurements of a set of samples or standards (min. 6) covering the whole 

considered Range and evaluate results. 

Statistical evaluation method: calculation of standard deviation and relative standard deviation from parallel 

measurements differences. 

 

5.4.2 ACCURACY      

 

(a) Limited Concentration Range ï Sample Reconstitution Possible: 

Application area: pharmaceuticals (chemistry) ï validation of Analytical Methods to determine assay in a 

relatively narrow concentration range (e.g. 80-120 %).  

Application assumption: standard of the analyte of interest with known purity must be available.  

Procedure: prepare a set of standards with a known concentration (e.g. 3), carry out repeated measurements (e.g. 

6 times) with every standard and evaluate results. 

Statistical evaluation method: Level-by-Level t-test. 

 (b) Limited Concentration Range - Reference Material Available: 

Application area: all Analytical Methods where reference materials are available (e.g. in metallurgy).  

Application assumption: reference material (materials) with a known reference value of the Validated Property 

and a known precision are available.  

Procedure: measure repeatedly (e.g. 6 times) the reference materials available and evaluate results. 

Statistical evaluation methods: t-test for every reference material considered. 

Warning: validation of the Analytical Method is valid only for the materials with the same matrix as the 

reference material and comparable to the Level of Validated Property. 

(c) Large Concentration Range ï Blank Material Available: 

Application area: chemistry, pharmaceuticals, environmental analysis, and medicine. 

Application assumption: material with a null value of the Validated Property, i.e. blank, is available (e.g. sample 

of blood plasma with a null concentration of the analyte of interest). A Standard of the analyte of interest must be 

available. 

Procedure: add a known amount of the analyte of interest to blank. In this way, prepare a set (3 to 8) of standards 

covering the whole Range considered. Analyse repeatedly these standards and evaluate the results. 

Statistical evaluation methods:  

  t-test: for sets of max. 5 standards with more then 3 repeated Measurements 

 Regression: for sets of min. 5 standards with a small number of repeated Measurements (1-3).  

(d) Large Concentration Range ï Blank Material not Available: 

Application area: environmental analysis, medicine, analysis of biological materials, where blank is not available 

(e.g. determination of iron in blood). 

Application assumption: standard of the analyte of interest is available. 

Procedure: known amount of the analyte of interest is added to the initial sample with a low concentration of the 

analyte (Validated Property) of interest. In this way, a set of (3 to 8) standards prepared, covering the whole 

concentration Range considered. The standards are (repeatedly) analysed using the Analytical Method and 

results are evaluated. 

Statistical evaluation method:  

  t-test: for sets of max. 5 standards with more then 3 repeated Measurements 

 Regression: for set of min. 5 standards with l amount of repeated Measurements (1-3). Moreover, 

calibration in water (in the given inert solvent) must be available. 

(e) Comparison of 2 Methods/Laboratories: 

Application area: when a set of Measurements from 2 Methods/Laboratories is available, or when another 

method to evaluate accuracy is not applicable. 

Assumption of application: a set of results for the Validated Property measured with 2 Methods (with the Method 

being validated and a standard Method)/Laboratories is available. 
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Procedure: analyse repeatedly a set of standards/samples with the two Methods/Laboratories and compare the 

results. 

Statistical evaluation method: 

t-test Level by Level: for a set of max. 5 standards with 2-3 repeated Measurements 

  t-test on Difference of Results: for a set of min. 5 standards without the repeated Measurements 

 

5.4.3 SELECTIVITY      

 

(a) Comparison of Calibration Lines: 

Application area: cases when all the considered Range is evaluated without and with the presence of individual 

tested Interferences. 

Assumption of application: calibration standards without and with the tested Interferences are available. 

Procedure: analyse repeatedly calibration standards without and with Interferences (the amount of Interference 

added to standards is defined by the  analyst) and compare both results. 

Statistical evaluation method: statistical comparison of calibration lines. 

(b) Comparison of Results with a Standard: 

Application area: cases where the influence of one Interference only is evaluated on several concentration 

standards. 

Assumption of application: concentration standards without and with the tested Interference are available. 

Procedure: a known amount of the tested Interference (defined by the analyst) is added to a standard with a 

known concentration of the analyte of interest and the mixture is analysed. Statistical evaluation allows the user 

to conclude whether or not the addition of the known amount of Interference has a significant influence on the 

determined concentration.  

Statistical evaluation method: t-test. 

(c) Comparison of Results with Measurements without Interference: 

Application area: cases when the influence of tested Interferences is evaluated by repeated Measurements of 

standards/samples without and with the Interference in several concentration Levels sets. 

Assumption of application: the set of concentration standards/samples on which the influence of Interference is 

tested is available as well as the tested Interference. 

Procedure: analyse the set of standards/samples 3 times without and with the Interference (the amount of 

Interference added to standards/samples has to be defined by the analyst) and evaluate results. 

Statistical evaluation method: t-test. 

 

5.4.4 LINEARITY       

  

(a) Correlation and QC Coefficient: 

Application area: where required, or when other methods to evaluate Linearity are not applicable. 

Assumption of application: set of min. 6 standards with a known value of Validated Property and min. 1 

response result for each standard must be available (measured). 

Procedure: analyse the set of standards with the known value of Validated Property and calculate the Correlation 

and QC Coefficient between the Validated Property and response. 

(b) ANOVA for Lack-of-Fit: 

Application area: where required (in combination with Correlation and QC Coefficient). 

Assumption of application: a set of 4-7 standards with a known value of the Validated Property and 2-3 results of 

repeated Measurements of the response are available. 

Procedure: a set of 4-7 standards with a known value of the Validated Property is analysed min. 2 times to obtain 

a response. The results are statistically evaluated by the statistical method of Analysis of Variance for Lack of 

Fit. 

(c) Significance of the quadratic term ï F-test:  

Application area: where required, especially when quadratic non-linearity can be expected (in combination with 

Correlation and QC Coefficient). 

Application assumption: a set of min. 8 standards with a known value of the Validated Property is available with 

min. 1 Measurement of response. 

Procedure: the response for the set of min. 8 standards with the known value of the Validated Property is 

measured and the t-test for quadratic term applied. 

(d) Sign test: 

Application area: where required (in combination with Correlation and QC Coefficient). 

Application assumption: a set of min 15 standards with a known value of the Validated Property is available with 

min. 1 Measurement of response.  
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Procedure: the response for the set of min. 15 standards with the known value of the Validated Property is 

measured and the sign test applied. 

 

5.4.5 LIMIT  OF DETECTION AND LIMIT  OF QUANTIFICATION   

 

(a) 3s - IUPAC: 

Application area: where required, typically for AAS and procedures recommended by IUPAC. 

Application assumption: results of 6-8 repeated Measurements of the response of blank are available. 

Procedure: the response of blank is measured repeatedly 6-8 times and the Limit of detection and Limit of 

Quantification are determined. 

(b) 3s ï Every Sample Corrected for Blank: 

Application area: where required, typically for AAS and when blank is measured prior to every sample and 

corrected for. 

Application assumption: blank is measured with every sample. 

Procedure: measure blank with every sample. Correct the signal of sample for blank and evaluate Limit of 

Detection and Limit of Quantification. 

(c) 3s ï Continuously Measured Blank: 

Application area: where required, typically for AAS and when blank is measured continuously. 

Assumption of application: continuously measured blank is available. 

Procedure: continuously measure blank, correct for it every sample and use this to evaluate Limit of Detection 

and Limit of Quantification. 

(d) From Calibration Line: 

Application area: where required (and the Method is not chromatography). 

Application assumption: blank or a sample with a low Level of the Validated Property is available. 

Procedure: prepare a set a calibration standards within the Range for which the Method is intended, measure 

them and use results to construct the calibration line and to evaluate Limit of Detection and Limit of 

Quantification. 

(e) From Signal of blank in Chromatography: 

Application area: chromatography (and other separation Methods) 

Application assumption: chromatogram of blank and Slope of the calibration line ñpeak height ï concentrationò 

is available. 

Procedure: on the chromatogram of blank, determine the maximum variability of baseline in the range defined as 

20-times half-width of the peak of interest measured symmetrically from the Retention Time of that peak. 

Evaluate Limit of Detection and Limit of Quantification. 

 

5.4.6 SENSITIVITY      

 

(a) From Calibration Line: 

Application area: standard IUPAC approach (applicable when not required otherwise). 

Method assumption: calibration standards must be available. 

Procedure: measure calibration standards and evaluate Sensitivity from the calibration line. 

(b) Minimum Difference in the Validated Property: 

Application area: where required. 

Method assumption: Repeatability of the Method, number of measurements used to evaluate Repeatability, Slope 

of the calibration line and permitted Alfa and Beta risks (usually 5%) must be available. 

Procedure: determine the Repeatability of the Method and Slope of the calibration line. Evaluate the Sensitivity 

of the Method. 

 

5.4.7 REPRODUCIBILITY     

 

(a) Data Available: 

Application area: when data from an Inter-laboratory Comparison are available for the given Analytical Method. 

Method assumption: data to evaluate Reproducibility of the considered laboratories must be available. Note: the 

Method used in all laboratories must be the same! 

Procedure: data are entered in Data Table and Reproducibility is evaluated the same way as Repeatability. 

(b) Results Available: 

Application area: when the laboratory is a participant in an Inter-laboratory Comparison for the given Analytical 

Method, but data obtained by other participating laboratories are not available to the given participant. 

Application assumption: participation in the Inter-laboratory Comparison. 
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Procedure: results obtained from the organizer of the Inter-laboratory Comparison are entered in the software to 

archive the Reproducibility value. 

 

5.4.8 CHROMATOGRAPHIC CHARACTERISTICS    

 

(a) Ph.Eur.: 

Application area: where Ph.Eur. requirements are applied. 

(b) FDA: 

Application area: where USP/FDA requirements are applied. 

 

5.5 EXTENT OF EVALUATION VALIDATION PARAMETERS         

 

Depending on the selected type of validation (Exploratory, Full, etc.), the list of validation parameters in the 

window Validation changes, so that the generally considered parameters are shown. Instructions on what to 

evaluate in what situation can be found in USP and ICH guidelines: 

 

Validation Parameters 

Category 

Assay/Purity 

Impurities  
Physical/Chemical 

Parameters 
Quantitative 

Analyses 
Limit Test 

Precision + + *  + 

Accuracy + + *  *  

Selectivity + + + *  

Limit of Detection   + *  

Limit of Quantification  +  *  

Linearity + +  *  

Range + + *  *  

Robustness + + + + 

Parameters indicated + are required, parameters indicated * may be required. 
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CHAPTER 

6 
INTER-LABORATORY COMPARISON  

This chapter contains: 

 

Á A description of methods to evaluate inter-laboratory studies 

o Mandelôs Statistics h 

o Mandelós Statistics k 

o Collaborative Studies ï evaluation of Repeatability and Reproducibility 

 

6.1 M ANDELóS STATISTICS H            

 

Mandelôs Statistics h characterizes how similar the results of the given Laboratory are for the given sample 

(concentration Level) in comparison with results of other Laboratories participating in the Inter-laboratory 

Comparison. It means that ñhò in fact characterizes Accuracy of the given Laboratory.  

The procedure to evaluate Mandelôs statistics h originates from the ISO 5725 standard. 

 

Click Mandelôs Statistics h in the Inter-laboratory Comparison menu. The Data Table ï Mandelôs Statistics h 

window is opened.  

Rows of the Data Table correspond to individual Laboratories participating in the comparison. In the column 

pairs of measurements (Measrt x_1 and Measrt x_2), enter results of parallel Measurements for individual 

samples (concentration Levels). For details see ISO 5725. The minimum/recommended number of Laboratories 

is 2/4 or more. The minimum/recommended number of samples (concentration Levels) is 1/3.  

 

Click the Calculate icon or choose Results > Calculate to start the calculation of Mandel's Statistics h and to 

show the Results window. Click Graph to display the corresponding graph.  

The following characteristics are presented in the Results window: 

¶ Level  - Level of Validated Property (sample) in Data Table for cases where h > h-critical  

¶ Laboratory  - Laboratory number in Data Table for cases where h > h-critical  

¶ h  - Calculated Mandel's statistics h, for cases where h > h-critical 

¶ h-crit   - Critical h from statistical tables needed for the Mandel's test  

Conclusion: summarizes cases where the calculated h exceeds the critical h from statistical tables, indicating 

that the results obtained by the given Laboratory at the given Level is not accurate compared to the other results. 

 

The automatically displayed Graph shows the Mandel's Statistics h (y-axis) for all participating Laboratories 

and all Levels (x-axis). This means that h for all Levels measured in Laboratory 1 are shown first, then h for all 

Levels measured in Laboratory 2, etc. Two horizontal lines indicate the critical Levels for Mandelôs Statistics h. 

If h is inside the limits, the result for the given laboratory can be considered accurate. 

6.2 M ANDELôS STATISTICS K            

 

Mandelôs Statistics k characterizes how variable the results of the given Laboratory are for the given sample 

(concentration Level) in comparison with results of other Laboratories participating in the Laboratory 

Comparison. This means that ñkò characterizes Precision of the given Laboratory.  

The procedure to evaluate Mandelôs statistics k originates from the ISO 5725 standard. 

 

Click Mandelôs Statistics k in the Inter-laboratory Comparison menu. The Data Table ï Mandelôs Statistics k 

window is opened.  

Rows of the Data Table correspond to individual Laboratories participating in the comparison. In the column 

pairs of measurements (Measrt x_1 and Measrt x_2), enter results of parallel Measurements for individual 
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samples (concentration Levels). For details see ISO 5725. The minimum/recommended number of Laboratories 

is 2/4 or more. The minimum/recommended number of samples (concentration Levels) is 1/3.  

 

Click the Calculate icon or choose Results > Calculate to start the calculation of Mandel's Statistics k and to 

show the Results window. Click Graph to display the corresponding graph.  

The following characteristics are presented in the Results window: 

¶ Level  - Level of Validated Property (sample) in Data Table for cases where k > k-critical  

¶ Laboratory  - Laboratory number in Data Table for cases where k > k-critical  

¶ h  - Calculated Mandel's statistics k for cases where k > k-critical 

¶ h-crit   - Critical k from statistical tables needed for the Mandel's test 

Conclusion: summarizes cases where the calculated k exceeds the critical k from statistical tables, indicating 

that the results obtained by the given Laboratory at the given Level are not precise compared to other results. 

 

The automatically displayed Graph shows the Mandel's Statistics k (y-axis) for all participating Laboratories 

and all Levels (x-axis). This means that k for all Levels measured in Laboratory 1 are shown first, then k for all 

Levels measured in Laboratory 2, etc. Two horizontal lines indicate the critical Levels for Mandelôs Statistics k. 

If k is inside the limit, the result for the given Laboratory can be considered precise. 

 

6.3 COLLABORATIVE STUDIES           

 

Collaborative Studies enable users to estimate Repeatability and Reproducibility of the Method from an inter-

laboratory comparison. The procedure to evaluate collaborative studies originates from the ISO 5725 standard. 

 

Click Collaborative Study in the Inter-laboratory Comparison menu. The window Data Table ï Collaborative 

Study is opened.  

Rows of the Data Table correspond to individual Laboratories participating in the comparison. In the column 

pairs of measurements (Measrt x_1 and Measrt x_2), enter results of parallel Measurements for individual 

samples (concentration Levels). For details see ISO 5725. The minimum/recommended number of Laboratories 

is 2/4 or more. The minimum/recommended number of samples (concentration Levels) is 1/3.  

 

Click the Calculate icon or choose Results > Calculate to start the evaluation of the Collaborative Study, i.e. the 

calculation of Repeatability and Reproducibility. Click Graph to display the corresponding graph.  

 

The following characteristics are presented in the Results window for every Level of the Validated Property: 

¶ Level   - Level/sample number in Data Table  

¶ Average in Level  - Average measurement for the given Level (sample), i.e. row average 

¶ Repeatability (r)   - Repeatability from the Inter-laboratory Comparison 

¶ Rel. Repeatability (%) - Rel. Repeatability = 100*Repeatability/Average in Level 

¶ Reproducibility (R)  - Reproducibility from the Inter-laboratory Comparison 

¶ Rel. Reproducibility (%)  - Rel. Reproducibility = 100*Reproducibility /Average in Level 

Conclusion: summarizes the Repeatability and Reproducibility evaluation from the collaborative study. 

 

The automatically displayed Graph shows the Repeatability and Reproducibility values (y-axis) for all 

samples/Levels (x-axis). Repeatability and Reproducibility values for sample/Level 1 are shown first, 

Repeatability and Reproducibility for sample/Level 2 follow.  
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CHAPTER 

7 
QC TOOLS 

This chapter contains: 

 

Á A description of main QC Tools considered in EffiValidation 3.0 

o Control Charts 

o Calibration 

o Uncertainties 

              

 

Construction of Control Charts, development of Calibration models and estimation of Uncertainties are activities 

that are daily carried out by an accredited laboratory and which are related to the Analytical Method Validation:  

- Variability of Method with time is monitored by means of control charts. 

- Validation parameter Sensitivity evaluated according to IUPAC is determined as the slope of the calibration 

line. Linearity, Limit of Detection and Limit of Quantification can be evaluated from the calibration line. 

- Validation characteristics can be used to estimate Uncertainty of analytical results. 

7.1 CONTROL CHARTS           

 

Control charts enable users to monitor/control the stability of Analytical Method in time by means of repeated 

analysis of reference materials or laboratory standards.  

 

As described in ISO 8258 standard, four types of Control Charts can be distinguished based on data available: 

o  Individual Measurements ï Characteristics Determined 

o Individual Measurements ï Characteristics not Determined  

o Repeated Measurements ï Characteristics Determined 

o Repeated Measurements ï Characteristics not Determined  

 

Control Charts for repeated Measurements are applicable only in cases when Measurements in each 

measurement point are repeated. If this is not the case, it is recommended to use Control Charts for Individual 

Measurements. 

 

Control Charts with Characteristics Determined are used in cases when the target values (central line) and 

variance of measurements are known (given) beforehand. If they are not determined, it is necessary to apply 

Control Charts with Characteristics not Determined. 

 

In addition, the EffiValidation 3.0 software also allows users to construct Hotelling T2 Multivariate Control 

Chart. With this chart, multivariate data can be controlled/monitored/evaluated. 

 

7.1.1 INDIVIDUAL  MEASUREMENTS ï CHARACTERISTICS DETERMINED  

 

Click Individual Measurements ï Characteristics Determined in the Control Charts window and then choose 

OK. The Data Table ï Control Charts: Individual Measurements ï Characteristics Determined window is 

opened.  

In the window, the data are entered as follows:   

 Central Line   - Target value to control (regulate) the given Method  

 Standard Deviation - Characteristics of the variance of Measurements considered to control  

     (regulate) the given Method (basis for the construction of Control Limits) 

 Description   - User note, e.g. date 5.5. 2003 
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 Measrt 1     - The measured values to be controlled (regulated). Min. number of Measrt 1  

        (rows in Data Table) is 15 

Click the Rules icon or choose Results > Rules to open the window The Rules to Evaluate Control Charts to 

specify (checkboxes) which of the eight Western-Electric rules will /will not be applied to the data. 

 

Click X-diagram to show the X-chart (Control Chart for Average), click R-diagram to show the R-chart (Control 

Chart for Range). The Result window is displayed with numerical values of Control Limits: 

¶ Upper Control Limit - UCL  - Upper Control Limit given by Central Line and Standard  

       Deviation in Data Table 

¶ Upper Warning Limit - UWL  - Upper Warning Limit given by Central l ine and Standard  

       Deviation in Data Table 

¶ Limit +1s   - Limit +1s given by Central line and Standard Deviation entered  

       in Data Table 

¶ Central Line     - Central Line from Data Table 

¶ Limit - 1s   - Limit ï1s given by Central Line and Standard Deviation entered 

¶        in Data Table 

¶ Lower Warning Limit - LWL  - Lower Warning Limit given by Central Line  and Standard  

       Deviation in Data Table 

¶ Lower Control Limit - LCL  - Lower Control Limit given by Central Line and Standard  

       Deviation in Data Table 

 

The automatically displayed Graph shows the Control Chart with data points corresponding to Measured values. 

The straight lines in the graph parallel with the x-axis are Control Limits.  

The Statistics tab shows the results of evaluation Control Chart: statistical characteristics and results of 

application of Western-Electric rules. 

 

7.1.2 INDIVIDUAL  MEASUREMENTS ï CHARACTERISTICS NOT DETERMINED  

 

Click Individual Measurements ï Characteristics not Determined in the Control Charts window and then choose 

OK. The Data Table ï Control Charts: Individual Measurements ï Characteristics not Determined window is 

displayed.  

In that window, the data are entered as follows:   

 Description    - User note, e.g. date 5.5. 2003 

 Measrt 1      - The measured values to be controlled (regulated). Min. number of  

           Measrt 1 (rows in Data Table) is 20 

Click the Rules icon or choose Results > Rules to open the window The Rules to Evaluate Control Charts to  

specify (checkboxes) which of the eight Western-Electric rules will /will not be applied to the data. 

 

Click X-diagram to show the X-chart (Control Chart for Average), click R-diagram to show the R-chart (Control 

Chart for Range). The Result window is displayed with numerical values of Control Limits: 

¶ Upper Control Limit - UCL  - Upper Control Limit calculated from data in Data Table 

¶ Upper Warning Limit - UWL  - Upper Warning Limit calculated from data in Data Table  

¶ Limit +1s   - Limit +1s calculated from data in Data Table 

¶ Central Line     - Central Line calculated from data in Data Table 

¶ Limit - 1s   - Limit ï1s calculated from data in Data Table 

¶ Lower Warning Limit - LWL  - Lower Warning Limit calculated from data in Data Table  

¶ Lower Control Limit - LCL  - Lower Control Limit calculated from data in Data Table 

 

The automatically displayed Graph shows the Control Chart with data points corresponding to Measured values. 

The straight lines in the graph parallel with the x-axis are Control Limits.  

The Statistics tab shows the results of evaluation Control Chart: statistical characteristics and results of 

application of Western-Electric rules. 

 

7.1.3 REPEATED MEASUREMENTS ï CHARACTERISTICS DETERMINED  

 

Click Repeated Measurements ï Characteristics Determined in the Control Charts window and then choose OK. 

The Data Table ï Control Charts: Repeated Measurements ï Characteristics Determined window is displayed.  

In that window, the data are entered as follows:   

 Central Line   - Target value to control (regulate) the given Method  
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 Standard Deviation - Characteristics of the variance of Measurements considered to control  

     (regulate) the given Method (basis for the construction of Control Limits) 

 Description - User note, e.g. date 5.5. 2003 

 Measrt 1-30     - The measured values to be controlled (regulated). Min. number of Measrt  

        1- 30 is 2, min. number of rows is 15 

Click the Rules icon or choose Results >Rules to open the window The Rules to Evaluate Control Charts to 

specify (checkboxes) which of the eight Western-Electric rules will /will not be applied to the data. 

 

Click X-diagram to show the X-chart (Control Chart for Average). Click R-diagram to show the R-chart 

(Control Chart for Range). The Result window is displayed with numerical values of Control Limits: 

¶ Upper Control Limit - UCL  - Upper Control Limit given by Central Line and Standard  

       Deviation in Data Table 

¶ Upper Warning Limit - UWL  - Upper Warning Limit given by Central Line and Standard  

       Deviation in Data Table 

¶ Limit +1s   - Limit +1s given by Central Line and Standard Deviation in Data 

       Table 

¶ Central line    - Central Line from Data Table 

¶ Limit -1s   - Limit ï1s given by Central Line and Standard Deviation in Data 

¶        Table 

¶ Lower Warning Limit - LWL  - Lower Warning Limit given by Central Line and Standard  

       Deviation in Data Table 

¶ Lower Control Limit - LCL  - Lower Control Limit given by Central Line and Standard  

       Deviation in Data Table 

 

The automatically displayed Graph shows the Control Chart with data points corresponding to Measured values. 

The straight lines in the graph parallel with the x-axis are Control Limits.  

The Statistics tab shows the results of evaluation Control Chart: statistical characteristics and results of 

application of Western-Electric rules. 

 

7.1.4 REPEATED MEASUREMENTS ï CHARACTERISTICS NOT DETERMINED  

 

Click Repeated Measurements ï Characteristics not Determined in the Control Charts window and then choose 

OK. The window Data Table ï Control Charts: Repeated Measurements ï Characteristics not Determined is 

displayed.  

In that window, the data are entered as follows:   

 Description    - User note, e.g. date 5.5. 2003 

 Measrt 1-30      - The measured values to be controlled (regulated). The minimum 

number  

        of Measrt 1 to 30 is 2, the minimum number of rows is 20. 

Otherwise,  

      reliable limits cannot be constructed. 

Click the Rules icon or choose Results > Rules to open the window The Rules to Evaluate Control Charts to 

specify (checkboxes) which of the eight Western-Electric rules will /will not be applied to the data. 

 

Click X-diagram to show the X-chart (Control Chart for Average). Click R-diagram to show the R-chart 

(Control Chart for Range). The Result window is displayed with numerical values of Control Limits: 

¶ Upper Control Limit - UCL  - Upper Control Limit calculated from data in Data Table 

¶ Upper Warning Limit - UWL  - Upper Warning Limit calculated from data in Data Table  

¶ Limit +1s   - Limit +1s calculated from data in Data Table 

¶ Central line    - Central line calculated from data in Data Table 

¶ Limit - 1s   - Limi t ï1s calculated from data in Data Table 

¶ Lower Warning Limit - LWL  - Lower Warning Limit calculated from data in Data Table  

¶ Lower Control Limit - LCL  - Lower Control Limit calculated from data in Data Table 

 

The automatically displayed Graph shows the Control Chart with data points corresponding to Measrt values. 

The straight lines in the graph parallel with the x-axis are Control Limits. The Statistics tab shows the results of 

evaluation Control Chart: statistical characteristics and results of the application of Western-Electric rules. 
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7.1.5 X-CHART (CONTROL CHART FOR AVERAGE)   

 

Control Chart for Average can be constructed based on individual Measurements or averages of repeated 

Measurements.  

Horizontal straight lines in the chart are the Control Limits needed to interpret the chart: Central Line in the 

middle of the chart corresponds to the target control value entered in data (Control Charts Characteristics 

Determined) or to the average of data in Data Table (Control Charts Characteristics not Determined). 

UCL and LCL : Upper and Lower Control Limit derived from the entered Standard Deviation of Measurements 

around the Central Line (Characteristics Determined) or calculated from variability of Measurements in Data 

Table (Characteristics not Determined). 

UWL and LWL : Upper and Lower Warning Limit derived from the entered Standard Deviation of 

Measurements around the Central Line (Characteristics Determined) or calculated from variability of 

Measurements in Data Table (Characteristics not Determined). 

+1s and -1s: 1s Limits derived from the entered Standard Deviation of Measurements around the Central Line 

(Characteristics Determined) or calculated from variability of Measurements in Data Table (Characteristics not 

Determined). 

UCL , LCL , UWL , LWL , +1s and -1s are displayed in order to evaluate Control Charts by means of Western-

Electric rules. The rules can be selected in The Rules to Evaluate Control Charts window after clicking Rules in 

Data Table.  

The user can zoom in to and zoom out of any part of the Control Chart by pressing the left mouse button and 

dragging from the upper left required corner to the lower right required corner of the zoomed chart. 

The tab Statistics of the Graph window shows numerical values of the Control Limits, i.e. Upper and Lower 

Control/Warning Limit, +1s and ï1s Limits, and results of evaluation Control Charts by means of Western-

Electric rules.  

 

7.1.6 R-CHART (CONTROL CHART FOR RANGE)    

 

Control Chart for Range can be constructed based on individual Measurements or averages of repeated 

Measurements.  

Horizontal straight lines in the chart are the Control Limits needed to interpret the chart: the lower line is the 

Central Line of the chart calculated as the average Range calculated from data in Data Table. 

UCL , UWL  and +1s: Upper Control Limit, Upper Warning Limit and +1s Limit are calculated from variability 

of Measurements in Data Table. They are displayed in order to evaluate Control Charts by means of Western-

Electric rules. The rules can be selected in The Rules to Evaluate Control Charts window after clicking Rules in 

Data Table.  

The user can zoom in to and zoom out of any part of the Control Chart by pressing the left mouse button and 

dragging from the upper left required corner to the lower right required corner of the zoomed chart. 

The Statistics tab of the Graph window shows numerical values of the Control Limits, i.e. Upper 

Control/Warning Limit, +1s limit and results of evaluation of the Control Chart by means of Western-Electric 

rules.  

 

7.1.7 RULES TO EVALUATE  CONTROL CHARTS (WESTERN-ELECTRIC RULES)  

 

Western-Electric rules to evaluate Control Charts can be selected by clicking the Rules icon in Data Table or 

choosing Evaluation > Rules. In the displayed The Rules to Evaluate Control Charts window, the user can select 

rules to be applied by mean of checkboxes. The regulated/control data are considered to be ñout of controlò in 

the following cases:  

 1. One point outside UCL or LCL. 

 2. Nine points in a row on one side of the CL.  

 3. Six decreasing (or six increasing) points in a row.  

 4. Fourteen points in a row, alternating up and down.  

 5. Two out of three points outside UWL or LWL.  

 7. Four out of five points are outside the 1s limit on the same side of the CL.  

 7. Fifteen points in a row within the two 1s limits.  

 8. Eight points in a row beyond either of the two 1s lines. 

The results of evaluation of Control Charts using Western-Electric rules are displayed on the Statistics tab of the 

Results window and the Graph window.  
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7.2 CALIBRATION             

 

Although Calibration is not a part of Validation, both issues are closely related:  

(i) Validation parameter Sensitivity is, according to IUPAC definition, given by the Slope of Calibration line. 

(ii) Linearity and Limit of Detection/Quantification can be evaluated from Calibration line.  

Algorithms implemented in EffiValidation 3.0 are in compliance with ISO 8466 ï Part 1 and 2. 

 

The window Data Table - Calibration can be opened using the QC Tools menu in the main EffiValidation 3.0 

window, accordingly as Control Charts and Uncertainties. The window is designed to enter, edit, evaluate and 

Print data and to open the Graph window. 

 

7.2.1 DATA TABLE      

 

Click the Calibration icon in the main EffiValidation 3.0 window or choose QC tools > Calibration to open the 

Data Table ï Calibration window.  

The menu and panel of icons in this window is similar to other Data Table windows. Only Statistics and Linear 

Model and Quadratic Model icons are specific. 

 

Enter data recorded for Calibration Standards in the upper table. In the lower table, enter data for Unknown 

Samples, which are the subject of determination of Validated Property (typically concentration) from Measured 

values. 

Upper table of Calibration Standards: 

  Description  - User note, e.g. date 5.5. 2003 

 Val. Pr.  - Level of the Validated Property, e.g. concentration, in the calibration standard in the  

      given Level, e.g. 5, 10, 20, 40, 60, é. mg 

 Measrt 1-30   - Results of repeated Measurements of response/signal (e.g. absorbance, peak area) for  

      the given Calibration Standard in the given Level. 

 

Table of Unknown Samples: 

 Description  - User note, e.g. sample XY 

 Val. Pr.  - Validated Property of the Unknown Sample estimated from Measrt of Unknown  

      Sample 

 Measrt 1-30    - Results of repeated Measurements of response/signal (e.g. absorbance, peak area) for  

      the given Unknown Sample. Measrt 1-30 are used to estimate Val. Pr. of the given  

      Unknown Sample. 

 

Click Calculate icon or Results > Calculate to start the evaluation of calibration data and to show the Results 

window. Click Graph to display the corresponding Graph.  

 

7.2.2 RESULTS      

 

The Results ï Calibration window shows: 

¶ Level   - Copy of the Level number column in Data Table  

¶ Description  - Copy of the Description column in Data Table  

¶ Validated Property - Estimated value of the Validated Property for the given Unknown Sample  

       determined from Measrt values of the Unknown Sample in Data Table 

¶ +-    - Estimated +- for the Unknown Sample (bases for the Confidence Interval)  

¶ Confidence Interval - Confidence Interval for the Unknown Sample. When the Validated  

  Property is below the Detection Limit, the text "Not Detected" is shown.    

  When the estimate value of Validated Property is below the Limit of  

  Quantification, the text "Not Quantified" is shown. 

 

Characteristics of the calibration model are shown on the Statistics tab: 

 

1. Calibration Model 

------------------------------------------------------------------------------------------------------------------------  

¶ In tercept (Estimate)   - Intercept estimated from data in Data Table 

¶ Slope (Estimate)   - Slope estimated from data in Data Table 

¶ Intercept Standard Deviation (Estimate) - Estimated intercept standard deviation from data  



68/115 

5/5/2010  Userôs Guide EffiValidation 3.0  version: 2.505     

 
 

¶ Slope Standard Deviation (Estimate) - Estimated slope standard deviation from data  

¶ Confidence Interval for Intercept - Confidence interval constructed for intercept from data 

¶ Confidence Interval for Slope  - Confidence interval constructed for slope from data 

 

 2. Data Fitting: 

------------------------------------------------------------------------------------------------------------------------  

¶ Residual Variance (Estimate)  - Estimated residual variance from data in Data Table 

¶ Residual Standard Deviation (Estimate) - Estimated residual standard deviation 

¶ Correlation Coefficient   - Estimated correlation coefficient 

¶ QC Coefficient    - Estimated QC coefficient 

 

 3. Calibration Limits:  

------------------------------------------------------------------------------------------------------------ ------------ 

¶ Measurement on the Limit of Detection  - Limit of Detection in Measurements units 

estimated from Data Table 

¶ Concentration on the Limit of Detection - Limit of Detection in Validation Property units 

estimated from Data Table 

¶ Measurement on the Limit of Quantification  - Limit of Quantification in Measurements units 

estimated from Data Table 

¶ Concentration on the Limit of Quantification  - Limit of Quantification in Validation Property 

units estimated from Data Table 

 

7.2.3 GRAPH       

 

The automatically displayed Graph window shows the calibration data fitted by a calibration model (straight line 

or a second order polynomial). When data are fitted with a straight line, the Limit of Detection and the Limit of 

Quantification are displayed.  

 

The user can zoom in to and zoom out of any part of the calibration relationship by pressing the left mouse 

button and dragging from the upper left required corner to the lower right required corner of the zoomed chart. 

 

7.3 UNCERTAINTIES             

 

Click the Uncertainties icon in the main EffiValidation 3.0 window or select QC Tools ï Uncertainties from the 

main menu to open the Uncertainties window. In this window, select one of the algorithms to be applied (e.g. 

From Precision Data ï Multiple Measurements) to evaluate uncertainties:  

o From Precision Data ï Multiple Measurements  

o From Precision Data ï Parallel Measurements  

o From Control Charts ï Individual Measurements  

o From Control Charts ï Repeated Measurements  

o Expert Estimate (recorded in database) 

o From Partial Uncertainties (according to EURACHEM/CITAC Guide, Quantifying Uncertainty in 

Analytical Measurement, Second Edition, June 1999) 

Click OK to confirm the selection. The Data Table ï Uncertainty: From Precision Data ï Multiple Measurements 

window is opened.  

 

All algorithms to estimate Uncertainties assume that all considered sources of Uncertainty are included in the 

data, which is achieved by measurement procedures. Expert Estimate enables users to archive the entered 

Uncertainty. When applying the algorithm of Partial Uncertainties according to Eurachem, the user must define 

the formula to calculate the property of interest from inserted variables and then to estimate Uncertainties of the 

individual variables considered in the formula. Based on these data, the combined Uncertainty of the result is 

estimated. 

 

7.3.1 FROM PRECISION DATA ï MULTIPLE MEASUREMENTS    

 

In the Data Table ï Uncertainty: From Precision Data ï Multiple Measurements window, enter data to estimate 

Uncertainty: 
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 Coverage Factor - Factor used to calculate the Expanded Uncertainty from Standard Uncertainty, 

usually 1.96 (i.e. Studentôs t for infinitive number of Measurements), rounded to 2. 

 The Other Unc. (%)  - Uncertainties (relative) not included in the Precision Data. The Other Unc. are 

combined with Uncertainty from Precision Data to give Combined Uncertainty 

 Measrt 1-30 - Precision data considered to evaluate Uncertainty. Rows of the Data Table 

correspond to individual samples analysed within the Precision study, i.e. Levels of 

Validated Property (concentration). Columns correspond to repeatedly measured 

(Measrt) values of the Validated Property at the given Level. 

 

Click Calculate to open the Results window with the following characteristics: 

¶ Calculated Value   - Calculated average of Measrt values from data in Data Table 

¶ St. Uncertainty   - Standard Uncertainty calculated from data in Data Table  

¶ Rel.  St. Uncertainty  - 100*St. Uncertainty/Calculated Value 

¶ Coverage Factor   - Coverage Factor entered in Data Table  

¶ Expanded St. Uncertainty - St. Uncertainty*Coverage Factor  

¶ Rel. Expanded Uncertainty - Rel. St. Uncertainty*Coverage Factor 

Conclusion: summarizes the evaluation of Uncertainties, i.e. Expanded St. Uncertainty and Relative 

Expanded Uncertainty. 

The automatically displayed Graph window shows the variability (Uncertainty) of Multiple Measurements on 

individual Levels (for individual samples).  

 

7.3.2 FROM PRECISION DATA ï PARALLEL MEASUREMENTS   

 

In the Data Table ï Uncertainty: From Precision Data ï Parallel Measurements window, enter data to estimate 

Uncertainty: 

 Coverage Factor - Factor used to calculate the Expanded Uncertainty from Standard Uncertainty, 

usually 1.96 (i.e. Studentôs t for infinitive number of Measurements), rounded to 2. 

 The Other Unc. (%)  - Uncertainties (relative) not included in the Precision Data. The Other Unc. are 

combined with Uncertainty from Precision Data to give combined St. Uncertainty 

 Measrt 1-2 - Precision data considered to evaluate Uncertainty. Rows of the Data Table 

correspond to individual samples analysed within the Precision study, i.e. Levels of 

Validated Property (concentration). Columns correspond to repeatedly measured 

(Measrt) values of the Validated Property at the given Level. 

 

Click Calculate to open the Results window with the following characteristics: 

¶ Calculated Value   - Calculated average of Measrt values from data in Data Table 

¶ St. Uncertainty   - Standard Uncertainty calculated from data in Data Table  

¶ Rel.  St. Uncertainty  - 100*St. Uncertainty/Calculated Value 

¶ Coverage Factor   - Coverage Factor entered in Data Table  

¶ Expanded St. Uncertainty - St. Uncertainty*Coverage Factor  

¶ Rel. Expanded Uncertainty - Rel. St. Uncertainty*Coverage Factor 

Conclusion: summarizes the evaluation of Uncertainties, i.e. Expanded St. Uncertainty and Relative 

Expanded Uncertainty. 

 

The automatically displayed Graph window shows the variability (uncertainty) of Parallel Measurements on 

individual Levels (for individual samples).  

 

7.3.3 FROM CONTROL CHART ï INDIVIDUAL MEASUREMENTS   

 

In the Data Table ï Uncertainty: From Control Charts ï Individual Measurements window, enter data to estimate 

Uncertainty: 

 Coverage Factor - Factor used to calculate the Expanded Uncertainty from Standard Uncertainty, 

usually 1.96 (i.e. Studentôs t for infinitive number of Measurements), rounded to 2. 

 The Other Unc. (%)  - Uncertainties (relative) not included in the Control Chart data. The Other Unc. are 

combined with Uncertainty from Control Chart data to give combined St. 

Uncertainty 

 Measrt 1                    - Control Chart data used to evaluate Uncertainty. Rows of the Data Table correspond 

to Individual Measurements.  

 

Click Calculate to open the Results window with the following characteristics: 
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¶ Calculated Value   - Calculated average of Measrt values from data in Data Table 

¶ St. Uncertainty   - Standard Uncertainty calculated from data in Data Table  

¶ Rel.  St. Uncertainty  - 100*St. Uncertainty/Calculated Value 

¶ Coverage Factor   - Coverage Factor entered in Data Table  

¶ Expanded St. Uncertainty - St. Uncertainty*Coverage Factor  

¶ Rel. Expanded Uncertainty - Rel. St. Uncertainty *Coverage Factor 

Conclusion: summarizes the evaluation of Uncertainties, i.e. Expanded St. Uncertainty and Relative 

Expanded Uncertainty. 

 

The automatically displayed Graph window shows the Control Chart of Individual Measurements used to 

estimate Uncertainty.  

 

7.3.4 FROM CONTROL CHART ï MULTIPLE MEASUREMENTS    

 

In the Data Table ï Uncertainty: From Control Charts ï Multiple Measurements window, enter data to estimate 

Uncertainty: 

 Coverage Factor - Factor used to calculate the Expanded Uncertainty from Standard Uncertainty, 

usually 1.96 (i.e. Studentôs t for infinitive number of Measurements), rounded to 2. 

 The Other Unc. (%)  - Uncertainties (relative) not included in the Control Chart data. The Other Unc. are 

combined with Uncertainty from Control Chart data to give combined St. 

Uncertainty 

 Measrt 1-30              - Control Chart data considered to evaluate Uncertainty. Rows of the Data Table 

correspond to the Repeated Measurements in time, columns to the Repeated 

Measurements at the given time point. 

 

Click Calculate to open the Results window with the following characteristics: 

¶ Calculated Value   - Calculated average of Measrt values from data in Data Table 

¶ St. Uncertainty   - Standard Uncertainty calculated from data in Data Table  

¶ Rel.  St. Uncertainty   - 100*St. Uncertainty/Calculated Value 

¶ Coverage Factor   - Coverage Factor entered in Data Table  

¶ Expanded St. Uncertainty - St. Uncertainty*Coverage Factor  

¶ Rel. Expanded Uncertainty - Rel. St. Uncertainty*Coverage Factor 

Conclusion: summarizes the evaluation of Uncertainties, i.e. Expanded St. Uncertainty and Relative 

Expanded Uncertainty. 

  

The automatically displayed Graph window shows the Control Chart of Multiple Measurements used to estimate 

Uncertainty.  

 

7.3.5  EXPERT ESTIMATE        

 

In the window Uncertainty: Expert Estimate, enter the following values: 

 Combined St. Uncertainty - Combined Standard Uncertainty estimated by an expert.  

 Coverage Factor - Factor used to calculate the Expanded Uncertainty from Standard 

Uncertainty, usually 1.96 (i.e. Studentôs t for infinitive number of 

Measurements), rounded to 2. 

 

Click Save to save data and/or Click Calculate to run the calculation and to show the window Results:   

¶ St. Uncertainty   - Standard Uncertainty entered in data  

¶ Coverage Factor   - Coverage Factor entered in data  

¶ Expanded St. Uncertainty - St. Uncertainty*Coverage Factor 

Conclusion: summarizes the evaluation of Expanded Standard Uncertainty. 

 

7.3.6 FROM PARTIAL UNCERTAINTIES      

 

Partial Uncertainties are Uncertainties of variables contributing to the total Standard Uncertainty of the analytical 

result. Calculation is carried out in compliance with the EURACHEM/CITAC Guide, Quantifying Uncertainty in 

Analytical Measurement, Second Edition, June 1999. 
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In the window Data Table ï Uncertainty: From Partial Uncertainties: 

 Coverage Factor - Factor used to calculate the Expanded Uncertainty from Standard Uncertainty, 

usually 1.96 (i.e. Studentôs t for infinitive number of Measurements), rounded to 2. 

Formula - Mathematical function describing the relationship between the individual sources of 

Uncertainty xi (x1, x2, x3) and the results. 

 

The Formula can include constants, basic mathematical operators +, -, *, / and the following mathematical 

functions: 

 ABS - absolute value 

 SIN - sine 

 COS ï cosine 

 TAN - tangens 

 ARCTAN ï arcustangens 

 EXP - exponent 

 LN - natural logarithm 

 PI - Ludolfôs number 

 SQR - square  

 SQRT - square root. 

 

Sources of Uncertainty, i.e. variables xi are specified in the table below the Formula: 

 Source  - Mathematical symbol for the given source of uncertainty: x1, x2, é 

 Value  - Value of the considered variable xi, e.g. x1 = 5 

 St. Uncertainty - Estimated Standard Uncertainty from the given source of Uncertainty, e.g. 0.02 

      

Click Calculate to open the Results window with the following characteristics: 

¶ Calculated Value - Analytical result estimated by entering Values from Data Table to  

Formula 

¶ St. Uncertainty - Standard Uncertainty estimated by applying St. Uncertainties from 

Data Table to Formula and using the rules to calculate Uncertainties 

¶ Rel. St. Uncertainty (%) - 100*St. Uncertainty/Calculated Value 

¶ Coverage Factor - Coverage Factor entered in Data Table  

¶ Expanded St. Uncertainty - St. Uncertainty*Coverage Factor  

¶ Rel. Expanded Uncertainty - Rel. St. Uncertainty*Coverage Factor 

Conclusion: summarizes the evaluation of Uncertainties, i.e. Expanded St. Uncertainty and Relative 

Expanded Uncertainty. 

 

The automatically displayed Graph window shows the bar chart of Relative St. Uncertainties for the considered 

sources of Uncertainty and compares it to the Relative Uncertainty of the result, which is displayed on the right 

side of the chart.  

 

The algorithm described in this chapter originates from the  EURACHEM/CITAC Guide, Quantifying 

Uncertainty in Analytical Measurement, Second Edition, June 1999. 
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CHAPTER 

8 
ELECTRONIC RECORD BOOKS 

 

This chapter describes the electronic record books of the EffiValidation 3.0 software: 

 

o Book of Samples (Simple and Advanced) 

o Book of Specifications 

o Book of Equipment (Simple and Advanced) 

o Book of Documents 

o Book of Deviations  

o Book of Contacts  

o Book Reference Standards 

o Book of Chemicals 

o Book of Volumetric Solutions 

              

 

Management of documentation and laboratory records is one of the basic requirements of quality systems in 

calibration/testing and GxP laboratories.  

8.1 BOOK  OF SAMPLES           

 

In the EffiValidation 3.0 main menu, choose Record Books > Books of Samples. The Book of Samples window is 

opened. Simple Book of Samples is selected in Tools > General Settings ï Books tab, radio-button Simple.  

 

8.1.1 SIMPLE BOOK OF SAMPLES       

 

In the upper part of the Book of Samples window, descriptive items of the samples are summarized. In the lower 

par of the window, the results for the given sample are presented: 

 

 
Fig. 8.1: Book of Samples window 

 

The descriptive items can be entered/edited after clicking the New/Edit button:  

 Sample #   - Number used in all laboratory records to trace the sample  

 Submitter   - Name of the sample submitter 

 Order no.   - Number of the order used by the sample submitter 

 Receipt Date   - Date when the sample was received by the laboratory 



73/115 

5/5/2010  Userôs Guide EffiValidation 3.0  version: 2.505     

 
 

 Receipt Time  - Time when the sample was received by the laboratory 

 Sampling Date  - Date when the sample was taken 

 Sampling Time  - Time when the sample was taken 

 Description   - Description of the sample  

 Receipt by   - Name of the person who received the sample from the sample submitter 

 Name   - Sample name 

 Matrix    - Material or matrix being analysed  

 Specification   - Reference to a specification, if it exists 

 Recorded by   - Name of the person who entered the data 

 Conclusion   - Result of the sample evaluation (complies/rejected), with respect to the  

       specification (if any exists)   

 To be Finished by  - Date when the analysis should be finished 

 Finished on   - Date when the analysis was finished (last quality parameter determined) 

Note    - Note for the given sample 

 

 
 Fig. 8.2: New/Edit Sample window 

 

New records can be entered and/or edited using the New, Edit, Copy, Delete and Close buttons. Refresh enables 

users to update displayed data when working in a network application, Print to print the complete Book or 

individual records, Export to export the complete Book or individual records and History to follow the 

development of the record in time. 

 

 
Fig. 8.3: History window of Book of Samples 

 

The lower half of the window allows users to enter results for the quantitative parameters characterizing the 

sample: 

 Parameter   - Name of the parameter determined 

 Unit     - Units considered for the given parameter 

 Specification   - Specification for the given parameter and matrix (e.g. max).  

 Link     - Link to a related document, if necessary (if document exists) 

 Result   - Measured result for the given parameter (result of determination) 

 Conclusion   - Conclusion with respect to specification 

 Analyst   - Name of analyst who carried out the analysis  
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 Approved   - Name of the person who approved the result (if necessary) 

 Note    - User note, i.e. text for the operator 

 

 
Fig. 8.4: New/Edit Result window of Book of Samples 

 

In the Simple Book of samples, the parameters of each sample are not saved in a common data table, but 

individually.  

 

8.1.2 ADVANCED BOOK OF SAMPLES       

 

Choose Record Books > Book of Samples to display the Book of Samples window: 

 

 
Fig. 8.5: Book of Samples - Advanced window  

 

Enter all descriptive items for the given sample; Click New to add a new sample to the book or Click Edit to edit 

it: 

 
Fig. 8.6: New/Edit Sample window  
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 Sample #   - Number used in all laboratory records to trace the sample 

 Submitter   - Name of the sample submitter 

 Project   - Name of the project to which the sample belongs  

 Sampling Date  - Date when the sample was taken 

 Sampling Time  - Time when the sample was taken 

 Receipt Date   - Date when the sample was received by the laboratory 

 Receipt Time  - Time when the sample was received by the laboratory 

 Receipt by   - Name of the person who received the sample from the sample submitter 

 Recorded by   - Name of the person who recorded all input data 

 Sampled by   - Name of the person who sampled the sample  

 Name   - Sample name 

 Matrix    - Material or matrix being analysed  

 Parameters   - List of parameters to be determined for the given sample 

 Note    - Note for the given sample 

 To be Finished by  - Date when the analysis should be finished 

 Finished on   - Date when the analysis was finished (last quality parameter determined) 

 

In the New/Edit window, the user can define a group of parameters that will be required for the given sample. 

Click the Parameters button to display the Sample Parameters window. In contrast to Simple Book of Samples, 

the result for the measured parameters of individual samples (rows) is saved in one composite table (in 

individual columns): 

 

 
Fig. 8.7: Sample Parameters window  

 

This structure of the table can be especially useful for laboratories where the parameters being determined are 

mostly the same. The table is, with respect to the memory requirements, limited to 250 columns (parameters).  

In this Book of Samples, the records can be Filtered with respect to Receipt Date, Sampling Date, Sample #, 

Submitter and Project: 

 

 
Fig. 8.8: Sample Filter window  

8.2 BOOK  OF SPECIFICATIONS           

 

Book of Specifications is connected with the Book of Samples. For each sample in the Book of Samples - 

Simple, the user can select one of the specifications listed in the Book of Specifications. 

 

Choose Record Books > Book of Specifications to display the Book of Specifications window: 
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Fig. 8.9: Book of Specifications window  

 

The upper part of this window shows a list of all specifications included in the Book: 

 Description   - Name or description of the given specification 

 

The lower part of the window shows List of Specifications including the following data: 

 Parameter   - Name of parameter in the specification (e.g. concentration X) 

 Link     - Link to the document containing the specification (analytical method) 

 Specification   - Required value of the given parameter of the sample to consider it  

       compliant (e.g. max. 0.1% impurity, etc.)  

 Note    - User note 

 

New specifications can be entered and/or edited using the New, Edit, Copy, Delete, and Refresh features. The 

specifications can also be Printed , History displayed and/or records Exported. 

 

 
Fig. 8.10: Edit/New Specification window  

 

8.3 BOOK  OF EQUIPMENT            

 

Choose Record Books > Book of Equipment to display the Book of Equipment window. As with the Book of 

Samples, the user can choose Simple or Advanced Book of Equipment in the General Settings window (Tools > 

General Settings > Books). 
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8.3.1 SIMPLE BOOK OF EQUIPMENT       

 

The upper part of the Book of Samples ï Simple window contains a list of equipment included in the book and 

descriptive data: 

 

 
Fig. 8.11: Book of Equipment window  

 

 
Fig. 8.12: New/Edit Equipment window  

 

 Equipment Name  - Name of the given equipment used in all records and documentation 

 Put into Operation  - Date when the equipment was put into operation 

 Location   - Name of the laboratory or another location where the equipment is placed 

 Register Number  - Number of the equipment used in all records and documentation,  

 Responsible   - Name of the person responsible for the given equipment 

 Prod. Number  - Production number of the equipment assigned by the manufacturer 

 Service   - Contact to the organization responsible for servicing the equipment 

 Link     - Link to the document that is related to the given equipment 

 Note    - User note (any text) 

 

The lower part of the Book of Samples window is a Sheet of Equipment with the list actions carried out with the 

given equipment: 
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Fig. 8.13: New/Edit Equipment Sheet window  

 

 Date    - Date of action/calibration 

 Action   - Description of the action 

 Carried    - Name of the person who carried out the action 

 Result   - Result of the action 

 Verified    - Name of the person who verified the action 

 Note    - User note 

New equipment can be entered and/or edited using the New, Edit, Copy, Delete and Refresh features. Records of 

the equipment can also be Printed, History shown and/or records Exported. 

 

8.3.2 ADVANCED BOOK OF EQUIPMENT      

 

The Book of Equipment - Advanced window includes 2 tabs: ñAll Equipmentò and ñBy Categoriesò. Based on 

categories, the equipment is divided into 3 groups:  

¶ With Valid Calibration 

¶ With Invalid Calibration  

¶ Out of Registration 

  

 
Fig. 8.14: Book of Equipment - Advanced window  

 

New equipment can be entered and/or edited using the New, Edit, Delete and Copy functions. In the New/Edit 

Equipment window the user can specify all descriptive data for the individual equipment. 
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Fig. 8.15: New/Edit Equipment window  

 

Checkboxes: 

 Out of Register  - Includes/excludes the equipment from/to the group ñOut of Registrationò  

 Permanently out  - Assigns the attribute ñPermanently Outò to Equipment  ñOut of  

        Registrationò  

 

The Main Tab: 

 Equipment Name  - Name of the given equipment used in all records and documentation 

 Equipment Type  - Type of the equipment  

 Equipment Category  - Category in which the equipment is included 

 Description   - Description of the equipment 

 Assign to Another Equip. - Assignment of the given equipment (e.g. thermometer) to other Equipment 

 Identification Number  - Identification number 

 Inventory Number   - Inventory number 

 Prod. Number  - Production number of the equipment assigned by the manufacturer 

 Range   - Range for which the equipment is designed and calibrated 

 Precision/Uncertainty - Classification with respect to precision/uncertainty 

 Department   - Department where the equipment is located  

 Group   - Group of the given laboratory where the equipment is located  

 Room number  - Number of the room where the equipment is located 

 Responsible   - Name of the person responsible for the given equipment 

 User    - Name of the equipment user  

 Year of Prod.  - Year of production  

 Put into Operation  - Date when the equipment was put into operation 

 Status when in Operation - Status of the equipment when put into operation   

 Manufacturer   - Manufacturer of the equipment  

 Supplier   - Supplier of the equipment  

 Service   - Contact to the organization responsible for servicing the equipment 

 Link     - Link to the document that is related to the given equipment 

 Limit the U se  - Option to indicate that the equipment is temporarily limited in use 

 Note    - User note (any text) 
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The Calibration  tab: 

 

 
Fig. 8.16: New/Edit Calibration window  

 

 Date of Last Calibration - Date of the last calibration 

 Result   - Result of the last calibration  

 Calibration Interval   - Interval of calibration  

 Without Limi t  - Checkbox indicating that the calibration is valid until the equipment is used  

 Date of Next Calibration - Last date for the next calibration  

 Date of Warning Calibration  - Date when the equipment is changed to red colour, indicating the end of  

       calibration 

 Contact   - Address of the testing/calibration laboratory 

 Contact Person  - Name of the contact person 

 Testing Lab. Number  - Number of the testing/calibration laboratory  

 Calibration Protocol  - Calibration protocol number  

 Calib. Procedure  - Reference to the calibration procedure  

 Note    - User note (any text) on the calibration  

 

The Other tab : 

 Date    - Date of action  

 Action   - Action (installation, qualification, maintenance, repair, etc.) 

 Carried by    - Name of the person who carried out the action 

 Result   - Result of the carried action 

 Verified by    - Name of the person who verified the result 

 Note    - User note (any text) on the action 

8.4 BOOK  OF DOCUMENTS           

 

Choose Record Books > Book of Documents to open the Book of Documents window: 

 

 
Fig. 8.17: Book of Documents window  



81/115 

5/5/2010  Userôs Guide EffiValidation 3.0  version: 2.505     

 
 

 

The following items are included in the book for each document: 

Document Name  - Name of the document 

Identific. Document  - Document number assigned with respect to laboratory rules (e.g. SOP.0023) 

Link     - Link to this document (if needed) 

Version   - Document version number 

Document Author   - Name of the author 

Issue Date   - Issue date 

Effective Date  - Effective date  

Number of Copies  - Number of printed copies 

Approved    - Names of persons who approved the document 

Distribution List   - Names of document holders 

 Note    - User note (any text) on the document 

 

 
Fig. 8.18: New/Edit Document window  

 

New documents can be entered and/or edited using the New, Edit, Copy, and Delete features. The list can be 

Refreshed and documents may be Printed, Exported or Opened. 

8.5 BOOK  OF DEVIATION  AND CLAIMS          

 

Choose Record Books ï Book of Deviations and Claims to display the Book of Deviations and Claims window 

 

 
  Fig. 8.19: Book of Deviations window  
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The following items are included in the Book for each deviation/claim: 

 

 
 Fig. 8.20: New/Edit Deviation window  

 

Claim Number  - Deviation/claim number used in all laboratory records and documentation 

Subject of Claim  - Subject of the deviation or claim 

Date of Claim  - Date of deviation/claim 

Material/ Analysis  - Specification on whether subject of investigation is quality of material  

  or result of analysis) 

Reclaiming   - Name of the person who claims 

Responsible   - Name of the person responsible for handling the claim (responsible for  

      corrective actions) 

Result of Claim  - Result of the claim investigation 

To be Finished by  - Date when the claim investigation is to be finished 

 Note    - User note (any text) on the deviation/claim 

 

New deviations/claims can be entered and/or edited using the New, Edit, Copy, and Delete features. The list can 

be Refreshed and deviations/claims Printed or Exported. 

8.6 BOOK  OF CONTACTS           

 

Choose Record Books > Book of Contacts to display the Book of Contacts window. In the book, the user can 

define Groups of contacts, Items (Firms) and individual Contact Persons 

 

 
 Fig. 8.21: Book of Contacts window  
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Description of Group: 

 Title     - Group title, e.g. suppliers, contract labs, etc. 

 Note    - User note (any text) on the group 

 

Description of Subject (e.g. supplier, which belongs to one group): 

subject is defined by: 

  - Contact Address    

Subject name  - Name of the subject 

Street   - Street 

City     - City 

Abb.    - Abbreviation of the subject, if it exists 

Country    - Country 

Account   - Bank account no. 

Bank   - Bank name 

ID N.   - Identification number 

VAT N.    - VAT number 

Report   - Additional information about the subject 

Type of payment  - Type of payment to be applied 

 Note    - User note (any text) on the contact 

  - Contact information: 

 Tel. 1   - Telephone numbers 

 Tel. 2, Tel. 3, Tel. 4 

FAX   - Fax number 

Mobil   - Mobile phone number 

E-mail   - E-mail address 

WWW   - Web site 

 

- Contact Persons: 

   Family name   - Family name of the contact person 

   First name   - First name of the contact person 

   Function   - Function of the contact person in the subject 

   Street    - Street 

   ZIP, City    - Zip (Post) code and city name 

   Tel. 1, Tel. 2   - Telephone numbers 

   Mobil     - Mobile phone number 

   E-mail   - E-mail address 

   Note    - User note (any text) on the contact 

 

New records can be entered and/or edited using the New, Edit, Copy, and Delete features. The list can be 

Refreshed. 

8.7 BOOK  OF REFERENCE STANDARDS         

 

Choose Record Books > Book of Reference Standards to display the Book of Reference Standards window: 

 

 
 Fig. 8.22: Book of Reference Standards window  



84/115 

5/5/2010  Userôs Guide EffiValidation 3.0  version: 2.505     

 
 

 

The upper part of the window displays the List of standards with the following descriptive data: 

Name   - Name of the standards 

Notation   - Notation of the standard (code) 

Supplier   - Name of the standard supplier 

Receipt date   - Date when the standard was received by the laboratory  

Amount   - Supplied amount of the standard 

Units   - Units considered for the amount 

Expiry date   - Expiry date for the given standard 

 Note    - User note (any text) 

 

 
 Fig. 8.23: New/Edit Standard window  

 

The lower part of the window displays the Sheet of the standard with the following consumption data: 

Date    - Date when a new standard was supplied 

Amount   - Supplied amount of the standard 

Action   - Action with the standard, e.g. consumption  

Carried    - Name of the person who carried out the action  

Final amount  - Final amount after the action (consumption) 

 Note    - User note (any text) 

 

New records can be entered and/or edited using the New, Edit, Copy, and Delete features. The list of standards 

can be Refreshed and standards may be Printed or Exported. 

8.8 BOOK  OF CHEMICALS            

 

Click Record Books ï Books of Chemicals to display the Book of Chemicals window: 

 

  
Fig. 8.24: Book of Chemicals window  
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This book allows users to keep records on chemicals: 

 

 
Fig. 8.25: New/Edit Chemical window  

 

Name   - Name of the chemical 

Formula   - Summary formula 

CAS n.   - CAS number 

Delivery Date  - Date when the chemical was delivered to the laboratory 

Consumed on  - Date when the chemical was used up 

Amount   - Amount of the chemical supplied by the supplier 

Units   - Units for the amount 

Supplier   - Name of the supplier 

Link     - Link to a related document, if needed 

R-S sentences  - List of Risk and Safety sentences for the given chemical 

 Note    - User note (any text) 

 

New records can be entered and/or edited using the New, Edit, Copy, and Delete features. The list of chemicals 

can be Refreshed and chemicals may be Printed or Exported. 

8.9 BOOK  OF VOLUMETRIC  SOLUTIONS         

 

Choose Record books > Book of Volumetric Solutions to display the Book of Volumetric Solutions window: 

 

 
Fig. 8.26: Book of Volumetric Solutions window  

 

This book allows users to keep records on volumetric solutions: 

Name    - Name of the volumetric solution 

Concentration  - Prepared concentration 

Prepared by    - Name of the person who prepared the volumetric solution 

Prepared on   - Date of solution preparation 
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Evaluated on   - Date when the factor of the volumetric solution was determined 

Expiry date   - Expiry date of the volumetric solution 

Factor   - Factor  

 Note    - User note (any test) 

 

 
Fig. 8.27: New/Edit Solution window  

 

New records can be entered and/or edited using the New, Edit, Copy, and Delete features. The list of volumetric 

solutions can be Refreshed and chemicals may be Printed or Exported. 



87/115 

5/5/2010  Userôs Guide EffiValidation 3.0  version: 2.505     

 
 

 CHAPTER 

9 
TOOLS 

This chapter describes User and Administrator tools implemented in the software: 

 

o Statistical Tables  

o Installation and Operational Qualification  

o General Settings of the software 

o Data and Calculation settings 

o List of Software Users 

o List of Analysts 

o Password and Electronic Signature Policy 

o Database ï backup and restore 

o Database Manager ï management of databases  

o Global Audit Trials  

 

9.1 STATISTICAL  TABLES           

 

The EffiValidation 3.0 software includes built-in statistical tables that enable automatic evaluation of all 

statistical hypothesis applied in the software. The statistical tables can be displayed by choosing Tools > 

Statistical Tables. In the Statistical Tables window the user can check whether the tables in individual tabs are 

correct compared to the literature. For example, by clicking the Studentós t tab, the user can view the critical t for 

the double-sided Studentós t-test, for n from 1 to 120, on the Probability Level 100*(1-Alfa) = 95 or 99 %, i.e. 

for the Alpha Risk 5 or 1%: 

 

 
Fig. 9.1: Statistical Tables window 

9.2 INSTALLATION  QUALIFICATION  (IQ)          

 

In the main menu of EffiValidation 3.0, choose Tools > Installation Qualification. The Installation Qualification 

window is opened, summarizing basic information regarding the files needed for correct functioning of the 

software 
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Fig. 9.2: Installation Qualification window 

 

¶ File   - Name of the File 

¶ Version   - Version of the File 

¶ Size   - Size of the File 

¶ Date   - Date of the last File update  

¶   Results - Result of the IQ check, i.e. comparison of the current File information with 

the reference information saved in a Reference data File 

¶ Description  - Description of the File function  

 

The Result of Installation Qualification in the form of the Report should be Printed out, signed and archived. IQ 

can then be considered complete.  

9.3 OPERATION  QUALIFICATION  (OQ)         

 

In the main menu of EffiValidation 3.0, choose Operational Qualification. The Operational Qualification 

window is opened, Operational Qualification tab: 

 

 
Fig. 9.3: Operational Qualification window 

 

Click Run to start the Operational Qualification procedure. For each algorithm (see the example below), an OQ 

data file is loaded, the calculation is carried out, obtained results are compared to the reference results saved in a 

reference result file and conclusions are displayed. The OQ report is as follows: 
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O P E R A T I O N A L   Q U A L I F I C A T I O N 
----------------------------------------------------------------------------------------------------------------------------------------------------------------- 
Date: 5-6-03 23:18:41 
  
EffiValidation 3.0 
----------------------------------------------------------------------------------------------------------------------------------------------------------------- 
  
The 1st INSTALLED VERSION 
----------------------------------------------------------------------------------------------------------------------------------------------------------------- 
  EffiValidation 3.0, build 3.0.2281 
  
   DIRECTORY WITH THE SOFTWARE INSTALLATION 
----------------------------------------------------------------------------------------------------------------------------------------------------------------- 
  C:\Program Files\EffiValidation 3.0 2281\ 
  
   DIRECTORY WITH THE REFERENCE DATA 
----------------------------------------------------------------------------------------------------------------------------------------------------------------- 
  C:\Program Files\EffiValidation 3.0 2281\OQ 
  
2. SUMMARY OF THE OPERATIONAL QUALIFICATION RESULTS 
----------------------------------------------------------------------------------------------------------------------------------------------------------------- 
Complies - Repeatability: Level by Level from Repeated Measurements 
Complies - Repeatability: From Parallel Measurements 
Complies - Intermediate Precision 
Complies - Reproducibility: Data Available 
Complies - Accuracy: Limited Concentration Range - Sample Reconstitution Possible 
Complies - Accuracy: ŋimited Concentration Range - Reference Material Available 
Complies - Accuracy: Large Concentration Range - Blank Material Available: t-test 
Complies - Accuracy: Large Concentration Range - Blank Material Available: Regression 
Complies - Accuracy: Large Concentration Range - Blank Material not Available: t-test 
Complies - Accuracy: Large Concentration Range - Blank Material not Available: Regression 
Complies - Accuracy: Comparison of 2 Methods/Laboratories: t-test Level by Level 
Complies - Accuracy: Comparison of 2 Methods/Laboratories: t-test on Difference of Results 
Complies - Linearity: Correlation and QC Coefficient 
Complies - Linearity: ANOVA for Lack-of-Fit 
Complies - Linearity: Significance of the Quadratic Term - F-test 
Complies - Linearity: Sign Test 
Complies - Limits: 3s - IUPAC 
Complies - Limits: 3s - Every Sample Corrected on Blank 
Complies - Limits: 3s - Continuously Measured Blank 
Complies - Limits: From Calibration Line 
Complies - Selectivity: Comparison of Calibration Lines 
Complies - Selectivity: Comparison of Results with a Standard 
Complies - Selectivity: Comparison of Results with Measurements without the Interference 
Complies - Robustness 
Complies - Sensitivity: From Calibration Line 
Complies - Blank 
Complies - Calibration: Calibration Standards 
Complies - Control Charts: Individual Measurements - Characteristics Determined 
Complies - Control Charts: Individual Measurements - Characteristics not Determined 
Complies - Control Charts: Repeated Measurements - Characteristics Determined 
Complies - Control Charts: Repeated Measurements - Characteristics not Determined 
Complies - Hotelling T2 Multivariate Control Chart 
Complies - Uncertainties: From Reproducibility - Multiple Measurements Available 
Complies - Uncertainties: From Reproducibility - Parallel Measurements Available 
Complies - Uncertainties: From Control Chart - Individual Measurements Available 
Complies - Uncertainties: From Control Chart - Repeated Measurements 
Complies - Uncertainties: From Partial Uncertainties 
Complies - Mandel's Statistics h 
Complies - Mandel's Statistics k 
Complies - Interlaboratory Comparison - Reproducibility and Repeatability 
Complies - Repeatability of Injection - FDA 
Complies - Capacity Factor - FDA 
Complies - Peak Resolution - FDA 
Complies - Tailing Factor - FDA 
Complies - Theoretical Plate Number - FDA 
Complies - Peak Resolution - Ph.Eur. 
Complies - Theoretical Plate Number - Ph.Eur. 
Complies - Symmetry Factor - Ph.Eur. 
  
  
3. OPERATIONAL QUALIFICATION RESULTS 
----------------------------------------------------------------------------------------------------------------------------------------------------------------- 
Operational Qualification was successfully completed. 
All the algorithms of EffiValidation 3.0 resulted into expected results with OQ data. 
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The Result of OQ in the form of the Report should be Printed out, signed and archived. OQ can be considered 

complete. The OQ Report is copied to the main EffiValidation 3.0 window, Information Panel, Validation 

Report tab 

 

 
Fig. 9.4: main EffiValidation 3.0 window: Information Panel: Validation Report tab 

 

and saved in the database of EffiValidation 3.0. All OQ Reports can be viewed in the List of OQ Reports tab of 

the Operation Qualification window: 

 

 
Fig. 9.5: Operational Qualification window: List of OQ Reports tab 

 

Where: 

¶ Date   - Date when the given OQ was carried out 

¶ Computer Name  - Name of the computer where OQ was carried out 

      This enables to see if all users in the network have qualified the software 

¶ Date of Printing  - Date when the OQ report was printed out 

¶ Created by ï Changed by - Login Name of the user who carried out OQ 

 

Report   - Copy of the whole OQ report as obtained from the OQ procedure 

 

If non-compliance is found during the OQ procedure, check whether the installed version agrees with the 

delivered documentation. This can be done with the IQ procedure. If IQ also does not comply, contact the local 

supplier or technical support at support@effichem.com. 

mailto:support@effichem.com
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9.4 GENERAL  SETTINGS           

 

Choose Tools ï General Settings to display the General Settings window. In this window, the System 

Administrator can set the following: 

 

The General tab:  

 
Fig. 9.6: Program Settings window: General tab 

 

Use the Last Method when Running Next Time - Enables automatic loading of the last evaluated  

         Analytical Method 

Use óBOLDó Text for Parameters/Methods    - Displays name of methods/parameters in BOLD 

    Including Data     where data were entered  

Shaded Menu     - Switches between the shaded and normal menu 

Display Window Results in Control Charts  - Switches the Results window in Control Charts 

          on/off 

Language      - Enables language selection: English/Czech  

          version of the EffiValidation 3.0 software 

The Books tab:  

Books of Samples  - Enables switching between the Simple and Advanced Book of Samples 

Book of Equipment  - Enables switching between the Simple and Advanced Book of Equipment 

 

9.5 DATA  AND CALCULATIONS           

 

Choose Tools > Data and Calculations to display the Data and Calculations window. In this window, the 

System Administrator can set up the minimum and recommended number of Levels and Measrt 

(Measurements) for the evaluated parameters/methods. These settings appear in the corresponding Data Table 

window as the red/green frame. In addition, for some methods the Administrator can also set up other 

parameters needed to evaluate the considered Hypothesis, e.g. min. Correlation Coefficient and max. QC 

Coefficient to evaluate Linearity. Meanings of these additional settings: 

 

 
Fig. 9.7: Data and Calculations window 
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Linearity: Correlation and QC Coefficient:  
- Correlation Coefficient to evaluate the hypothesis about Linearity of the Method (see chapter 5.3.8.1). Default 

value: 0.99 

- QC Coefficient to evaluate the hypothesis about Linearity of the Method. Default value: 5%. 

 

Limits: 3s:  

- constant used to calculate Limit of Detection. Default value: 3 

- constant used to calculate Limit of Quantification . Default value: 10 

 

HPLC ï FDA:  

- Repeatability of Injection to evaluate the hypothesis about Precision of the Method (see 5.3.12). Default 

value: 1%. 

- Capacity Factor to evaluate the hypothesis about acceptable Capacity Factor of the HPLC method (see 

5.3.13). Default value: 2. 

- Resolution to evaluate the hypothesis about acceptable Resolution of the HPLC method (see 5.3.14). Default 

value: 1.5. 

- Tailing to evaluate the hypothesis about acceptable Tailing of the HPLC method (see 5.3.15). Default value: 2. 

- Theoretical Plate Number to evaluate the hypothesis about acceptable Theoretical Plate Number of the HPLC 

method (see 5.3.16). Default value: 2 000. 

  

HPLC ï PhEur:  

- Resolution to evaluate the hypothesis about acceptable Resolution of the HPLC method (see 5.3.17). Default 

value: 1. 

- Theoretical Plate Number to evaluate the hypothesis about acceptable Theoretical Plate Number of the HPLC 

method (see 5.3.18). Default value: 2 000. 

 

Other Parameters (Student, Fischer, Cochran, Dixon, Grubbs, Grubbs 2, Normality):  
- Confidence Level  (1-alfa)*100: considered confidence level to apply statistical hypothesis; influencing the 

critical values t, F, C, Q and G. Default value: 95%. Alternative value: and 99%. 

- Confidence Level  (1-beta)*100: confidence level to evaluate Sensitivity: Minimum Difference in the 

Validated Property. Default value: 95%. Alternative value: and 99%. 

 

The buttons Close and Save enable users to maintain the values in the Data and Calculations window. The button 

History opens the window History, enabling users to see by who, when, and what was changed in the Data and 

Calculations window: 

 

 
Fig. 9.8: History window in Data and Calculations 

 

9.6 LIST  OF SOFTWARE USERS          

 

System Administrator can choose Tools ï List of Software Users to display the List of Users window: 
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Fig. 9.9: List of Users window 

 

Where 

¶ Usersô Full Name - Full name of the user not used to Login to the software 

¶ Group   - Group to which the user belongs regarding his access rights 

¶ Login name  - Name used to Login to EffiValidation 3.0 

¶ User Status  - Actual status of the user: Active, Deactivated or Removed. For details see  

      below 

 

In the List of Users window, Administrator can define New users, Edit and Copy names of existing users, 

change their Passwords and change their status. 

 

9.6.1 NEW USER      

 

Choose New to display the User window:  

 

 
Fig. 9.10: User window 

Enter: 

Usersô Full Name - Full name of the user not used to Login to the software, but to fully identify the user. 

This name will be displayed in the List of Users and in the Status bar of the main 

EffiValidation 3.0 window 

Login name - Name used to Login to the software 

Group - Group to which the user should belong: software Administrator, User, Host (see 

Chapter 2.4) 

Password - Password used to Login to the software. If Electronic Records and Electronic 

Signatures are applied, the Password has to comply with the rules described in 

Chapter 9.8. 

Verify Password - Verification that the considered Password has been entered correctly 

Access Control - Checkboxes enabling the control of access of users to the software functionalities. 

The Check All button can be used to select all checkboxes, UnCheck All to de-select 

all checkboxes. 

 

Only in cases when the entered Password and Verification Password are the same and the rules considered for 

Electronic Records and Signatures are fulfilled (see 9.8) is the button Save enabled. 
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By clicking Edit or Copy from the List of Users window, Software Administrator can open the User window 

(Fig. 9.10), edit entered data including password and save it as described above. 

 

9.6.2 CHANGE PASSWORD     

 

System Administrator can choose Password in the List of Users window (see 9.6) to open Change Password 

window:  

 

 
Fig. 9.11: Change Password window 

 

Enter  

New Password - New Password (replacing the current Password) used to Login to the software next 

time. If Electronic Records and Electronic Signatures are applied, the Password has 

to comply with the rules described in Chapter 9.8. 

Confirm Password - Confirmation that the considered New Password has been entered correctly 

 

Only in cases when the entered New Password and Confirmation Password are the same, and the rules 

considered for Electronic Records and Signatures are fulfilled (see 9.8), is the button Save enabled. 

 

9.6.3 CHANGE USER STATUS      

 

In the List of Users window, the System Administrator can set the User Status by repeatedly clicking 

Ac/DeA/Rem button as follows: 

Act  - Active User can login to EffiValidation 3.0 using his active Login Name and Password  

DeA  - Deactivated User has a deactivated Login Name and Password. This is due to Password 

Expiry Period being exceeded, exceeded Number of Un-successful Logins to EffiValidation 

3.0 or because System Administrator deactivated the given user (for details see Chapter 

9.8) 

Rem  - Removed User had an active Login Name and Password in the past, but it has been 

blocked and cannot be activated again (requirement of 21 CFR Part 11, see also Chapter 

9.8). A typical reason for the User Removal is that the given user has left the laboratory. 

9.7 LIST  OF ANALYSTS           

 

Choose Tools ï List of Analysts to display the List of Analysts window. In this window, new Analyst names can  

be entered and existing Analyst names edited or deleted: 

 

 
Fig. 9.12: List of Analysts window 
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The buttons on the right side of the window have the following meanings: 

Close  - Closing the List of Analysts window 

New  - Defining a new Analyst (see Chapter 9.7.2) 

Edit - Editing an existing Analyst (see Chapter 9.7.2) 

Delete - Reversible deletion of the selected Analyst from the actual List of Analysts to the recycle 

Bin. The deleted Analyst can be restored from the Bin by clicking Restore 

 

 

9.7.1 NEW ANALYST      

 

Choose List of Analysts - New to display the Analysts window. In this window, new Analyst names can be 

entered: 

 
Fig. 9.13: Analysts window 

 

First name - First Name of the new Analyst  

Surname  - Surname of the new Analyst 

9.8 PASSWORD AND ELECTRONIC  SIGNATURE  POLICY        

 

The Password and electronic signatures policy enables the limiting of access of users to software and to prevent 

non-authorized data modification. Another possibility to limit access of a user to individual software 

functionalities is to un-check the appropriate checkboxes in the new User window (see Chapter 9.6.1).  

Secondly, access to individual Analytical Method can be control via the method Access Control window (see 

Chapter 4.3.3). 

 

System Administrator can choose Tools ï Password and Electronic Signatures Policy to display the Password 

and Electronic Records Policy window. In this window, the rules to secure electronic records and signatures can 

be set up. In case the System Administrator wants to comply with 21 CFR Part 11 (Final Rule), it is 

recommended to select the first checkbox: Electronic Signature Required. Consequently, all the 

checkboxes/rules below are selected and applied. If the System Administrator does not want to comply with 21 

CFR Part 11, he/she can still select any combination of the checkboxes/rules in the window and apply a partial 

password policy. óESô refers to items required for Electronic Signatures, óERô refers to items required for 

Electronic Records: 

 

Electronic Records Required - Electronic Records are applied in compliance 

with 21 CFR Part 11 

Two ID Components Required for 1st Sign-off - For first electronic signature, both user 

identification components (Login Name and 

Password) are required 

One ID Component Required for next Sign-off - For second and next electronic signatures, one 

identification component (Password) is required 

Accepted Sign-off Inactivity Delay (default 10) min. - Accepted delay of inactivity during signing-off. 

If this is exceeded, identification components have 

to be entered again 

Unique Login Name Required - Unique Login Name enforcement to ensure that 

two users do not use the same Login Name 

Unique Password Required - Unique Password enforcement to ensure that two 

users do not use the same Password 

Password Expiry Period (default 365) days - Password expiry period applied to ensure 

Password is changed at regular intervals 

Minimum Password Length (default 6) characters - Minimum password length considered as secure 

Password has to include a Numeral  - Requirement to include a numeral in Password to 

increase its security 
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Password has to Include Capital and Lower-case Let. - Requirement to include Upper and Lower-case 

letters in Password to increase its security 

Maximum Number of Unsuccessful Logins - Number of tolerated unsuccessful login attempts 

to prevent unauthorized access 

 

 
Fig. 9.14: Password and Electronic Signature Policy window 

 

In case e.g. the Password Validity Period expires, the User is asked to enter a New Password: 

 

 
Fig. 9.15: Change Password window 

 

9.9 DATABASE             

 

Choose Tools ï Database to display the Database ï Backup window. In this window, the user can perform the 

following operations: 

 

 
Fig. 9.16: Backup window 
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Start Backup -  Starts backup of the database 

Restore from Backup -  Starts restoring the database from Backup, the path to the file is shown in  the 

last row of the window, default C:\Program Files\EffiValidation 3\BF.gbk 

Close -  Closes the Backup window 

 

9.10 DATABASE  MANAGER            

 

9.10.1 LIST OF DATABASES      

 

System Administrator can choose Tools ï Database Manager to display the List of Databases window. In this 

window, databases can be handled: 

 

 
Fig. 9.17: List of Databases window 

 

The buttons on the right side of the window have the following meanings: 

Close  -  Closing the List of Databases window 

Create -  Creating a new database (see Chapter 9.10.2) 

New -  Connecting to a new, existing database (see Chapter 9.10.3) 

Edit -  Editing connection to an existing database (see Chapter 9.10.2) 

 

Delete -  Irreversible deletion of an existing database from the List of Databases window. The 

database remains on the hard disc however 

Default -  Setting the selected database as the default database  

 

 

9.10.2 NEW DATABASE       

 

System Administrator can choose Create in the List of Databases window (Fig. 9.16) to create a new database 

for EffiValidation 3.0 software: 

 

 
Fig. 9.18: New Database window 
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Database Name -  Name of the new database to be created 

Server -  Name of the server where database will be located 

Protocol -  Type of protocol considered (typically TCP/IP) 

Primary Database File -  Path and name of the file where the new database will be created and saved 

Backup File -  Path and name of the file where the database backup file will be saved 

Page Size  -  1024, 2048, 4096, 8192 or 16384. Usually 4096 

Char Set -  None, ISO 8859_1, ISO 8859_2, WIN1250, WIN1251, WIN1252, WIN1253 

or WIN1254. Usually WIN1250 

Collation  -  PXW_CSY, PXW_HUN, PXW_HUNDC, PXW_PLK, PXW_SLOV, 

WIN1250. Usually WIN1250 

 

9.10.3 ADD DATABASE       

 

System Administrator can choose Add in the List of Databases window (Fig. 9.16) to add an existing database 

(e.g. from another EffiValidation user) to the List of Databases: 

 

 
Fig. 9.19: Add Database window 

 

Database Name  - Name of the existing database that will be added to the List of Databases 

Server - Name of the server where database is located 

Protocol - Type of protocol considered (typically TCP/IP) 

Backup File - Path and name of the file where the database backup file will be saved 

Primary Database File - Path and name of the file where the existing database is located 

Char Set -  None, ISO 8859_1, ISO 8859_2, WIN1250, WIN1251, WIN1252, WIN1253 

or WIN1254. Usually WIN1250 

Collation  -  PXW_CSY, PXW_HUN, PXW_HUNDC, PXW_PLK, PXW_SLOV, 

WIN1250. Usually WIN1250 

 

9.10.4 EDIT DATABASE       

 

System Administrator can choose Edit in the List of Databases window (Fig. 9.16) to edit an existing database 

in the List of Databases: 

 

 
Fig. 9.20: Edit Database window 

 

Database Name -  Name of the existing database that will be added to the List of Databases 

Server -  Name of the server where database is located 

Protocol -  Type of protocol considered (typically TCP/IP) 
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Backup File -  Path and name of the file where the database backup file will be saved 

Primary Database File -  Path and name of the file where the existing database is located 

Char Set -  None, ISO 8859_1, ISO 8859_2, WIN1250, WIN1251, WIN1252, WIN1253 

or WIN1254. Usually WIN1250 

Collation  -  PXW_CSY, PXW_HUN, PXW_HUNDC, PXW_PLK, PXW_SLOV, 

WIN1250. Usually WIN1250 

 

9.11 GLOBAL  AUDIT  TRIALS  (GAT)           

 

System Administrator can choose Tools ï Global Audit Trials to display the Global Audit Trials window. It 

enables users to see who (what user) has done what (viewing/editing) and where (in what software window): 

 

 
Fig. 9.21: Global Audit Trials window 

 

ID#    - Identification number of the recorded action in Global Audit Trials window 

Date  - Date of the action  

Time  - Time of the action 

Computer Name  - Name of the computer where the action was carried out 

Created by ï Changed by - Login Name of the user that Created/Changed the record 

Time Spent  - Time spent in the window/action 

Description  - Name of the window, viewed/edited  

Transaction  - Transaction type: View, Edit, Apply 

 

The buttons on the right side of the Global Audit Trials window are described below. 

 

Other functions in Global Audit Trials: 

  Filter of Audit Trials 

  Audit Trials and History of Records Settings 

  Display Record in Audit Trials 

 

9.11.1 FILTER OF AUDIT TRIALS      

 

System Administrator can choose Global Audit Trials - Filter to open the Filter of Audit Trials window. In this 

window, records in GAT can be filtered with respect to Date, Time, Computer Name, User, Algorithm and 

Validation: 



100/115 

5/5/2010  Userôs Guide EffiValidation 3.0  version: 2.505     

 
 

 
Fig. 9.22: Filter of Audit Trials window 

 

For Date and Time, the intervals From to To can be specified. For the rest, selection from predefined groups can 

be used. 

 

9.11.2 AUDIT TRIALS AND HISTORY OF RECORDS SETTINGS   

 

System Administrator can choose Global Audit Trials ï Settings to open the Audit Trials and History of 

Records Settings window. In this window, what will be recorded can be selected 

 

 
Fig. 9.23: Audit Trials and History of Records Settings window 

 

Global Audit Trials   - Switching Global Audit Trials policy On/Off 

Date    - Switching History recording On/Off 

 

9.11.3 DISPLAY RECORD IN AUDIT TRIALS     

 

System Administrator can choose Global Audit Trials ï Display (when the button is active) to open the 

window in the form in which it was at the given Date and Time 

 

 

Fig. 9.24: Audit Trials and History of Records Settings window 
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CHAPTER 

10 
HELP 

This chapter describes: 

 

o The Help menu of the EffiValidation 3.0 software 
 

10.1 SOFTWARE HEL P            

 

Choose Help > Software Help to display the EffiValidation 3.0 Help window with basic information about the 

EffiValidation 3.0 software. 

10.2 CONTENTS AND INDEX            

 

Choose Help > Contents and Index to display the Contents and Index window. The Contents tab includes the 

text of this User's guide. On the Index tab, the user can enter a string that he wants to search for and click the 

Display button. All Help pages containing the given string are shown on the screen.  

10.3 TIPS AND TRICKS             

 

Choose Help > Tips and Tricks to display the Tips and Tricks window. In this window, users can navigate using 

the Next or Close buttons. 

 

 
Fig. 10.1: Tips and Tricks window 

10.4 HOTLINE  E-MAIL             

 

Choose Help > Hotline e-mail to display the Outlook window for sending an e-mail to EffiValidation support. 

10.5 ABOUT  THE  SOFTWARE           

 

Choose Help > About the Software to display the About window. This window shows basic contact information 

about the software developer. 
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CHAPTER 

11 
USER SUPPORT 

 

This chapter describes: 

 

Á EffiChem printed documents  

Á Electronic support for EffiValidation 3.0 users 

 

11.1 PRINTED  DOCUMENTS           

 

The EffiValidation software includes documentation in printed form. This documentation can be obtained from 

the software developer/local distributors via postal services or e-mail, or it may be downloaded from the 

www.effichem.com Website. 

 

11.2 ELECTRONIC  SUPPORT           

 

EffiChem provides electronic support for the EffiValidation software at the www.effichem.com Website.  

List of files that can be downloaded: 

Installation file:   
- EffiValidation 3.0: full installations of the EffiValidation 3.0 software. Can be used by registered users of 

EffiValidation (HW key holders) or as a DEMO version. ñBuildò of the current version is shown on the 

Website 

Documentation:  

- User's Guide EffiValidation 3.0 and Tutorial EffiValidation 3.0 

- Book of Reference Examples EffiValidation 3.0 

Installation of WinSock 2:  

- Installation of WinSock 2 for Windows enables users to run the software EffiValidation 3.0 in the Microsoft 

Windows 95 environment. 

 

EffiChem provides an electronic reply service to questions posted on the www.effichem.com Website. In case 

you encountered a trouble with the software EffiValidation 3.0, the contact email should include at minimum the 

following information: 

- operating system used 

- version and build number, e.g. EffiValidation 3.0.2340 

- description of the problem 

- Error.log file from the EffiValidation 3.0 mother directory as attachment 

http://www.effichem.com/
http://www.effichem.com/
http://www.effichem.com/
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CHAPTER 

12 
USERôS TUTORIAL  

 

This chapter includes a Tutorial for EffiValidation 3.0 software describing how to: 

 

Á start the software 

Á create a New Method  

Á evaluate Validation data 

Á use electronic Record Books 

 

12.1 START THE  SOFTWARE          

 

Click Start ï Programs - EffiValidation 3.0 and EffiValidation 3.0 to start the software. The window User 

Verification is opened. Enter Login Name and Password and click OK: 

 

 
Fig. 12.1: User Verification window 

 

The EffiValidation 3.0 main window is opened: 

 

 
Fig. 12.2: EffiValidation 3.0 window 
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This window shows from top to bottom: Title bar, Menu bar, Method Under Evaluation bar, Icon panel (on 

the left side), Info panel (on the right side) and the Status bar. 

12.2 CREATE  A NEW METHOD           

 

In the menu of the main EffiValidation 3.0 window, click Analytical Methods > New Method. The window New 

Method is opened:  

 

 
Fig. 12.3: New Method window ï empty 

Enter the following items: 

Material    Drinking water 

Series    1 

Project    Nitrates and Nitrites 

Number   CH.0003 

Method Used   UV 

Date    5. 5. 2003  

Version    1.01  

Standard   ISO 4182:1979 

Analyst Smith George (click icon on the right, which opens the window List of 

Analysts. Click New to open the window Analyst. Enter First Name and 

Surname of the analyst, click Save and OK).  

  

Enter names of validated properties (analytes) to be included in the given project ï click New. In the opened 

window Validated Property, enter Nitrates: NO3- and click Save. Click New again, enter Nitrites: NO2- and 

click Save: 

 

 
Fig. 12.4: New Method window ï with data entered 
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Save the created New Method (the new project including validated properties Nitrates and Nitrites ) by clicking 

Save. The database of Analytical Methods, including only the "DEMO project" method, is extended by the 

Method: "Drinking Water ï UV ï Nitrates and Nitrites ï 1 ï 5.5. 2003". Make sure of this by clicking List of 

Methods from the menu Analytical Methods and Refresh: 

 

 
Fig. 12.5: List of Methods window 

 

In the List of Methods window, see the DEMO method delivered with the software and the new Nitrates and 

Nitrites method. Try sorting of methods by clicking the column header and searching for an inserted string 

entered from the keyboard, e.g. ñDrinking waterò. 

  

Click "Drinking Water ï UV ï Nitrates and Nitrites ï 1 ï 5.5. 2003ò and Apply. The method is selected as the 

Method Under Evaluation. This appears in the main EffiValidation 3.0 window. 

 

12.3 EVALUATE  VALIDATION  DATA          

 

In the main EffiValidation 3.0 window, click Validation and Full Validation. The window Full Validation is 

opened. In this window, click the name of the validation parameter you want to evaluate: Repeatability. 

 

12.3.1 REPEATABILITY     

 
Click Repeatability - Level by Level from Multiple Measurements in the Full Validation window to open Data 

Table - Repeatability: Level by Level From Multiple Measurements. Enter data to evaluate Repeatability: 

 

Level 5 5,31 5,01 4,97 5,33 5,08 5,01 

Level 25 25,02 24,95 24,86 24,38 28 24,95 

Level 50 49,81 50,45 50,35 50,11 49,68 50,45 

 

Rows of the Data Table correspond to individual Levels of Validated Property (concentration, e.g. = 5, 25, 50 

mg/l), the columns correspond to repeated Measurements (Measrt) of the Validated Property at the given Level 

(e.g. at the Level 5 mg/l, the results of measurements are: 5.31, 5.01, 4.97, etc.). Enter Units considered in the 

Data Table: mg/l.  

The more data are entered into the table, the better estimate of Repeatability is obtained. 

Part of the table corresponding to the minimum number of Measurements/Levels is marked with a red frame 

(one row, two columns). If data in this frame are not entered, the calculation cannot be performed. 

Recommended number of Measurements/Levels is indicated by a green frame: three rows, six columns. 
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Fig. 12.6: Data Table ï Repeatability: Level-by-Level from Multiple Measurements window 

 

Instructions below the Data Table provide users with specific information for the given algorithm.  

 

If you want to edit data in the Data Table window, use the menu Edit: Insert Row (or Insert from the keyboard), 

Delete Row (or Ctrl-Del from the keyboard), Delete Column, Copy (Ctrl-C), Paste (Ctrl-V), arrows from the 

keyboard or Delete.  

After entering data, click Edit > Save or directly the icon Save (Ctrl-S) and Results > Calculate, or click directly 

the icon Calculate (F5). The window Graph - Repeatability: Level by Level from Multiple Measurements is 

opened: 

 

 
Fig. 12.7: Graph ï Repeatability: Level-by-Level from Multiple Measurements window 

 

For every concentration Level (x-axis), Deviation from the Average at the given Level is displayed (y-axis) for 

all Measurements influencing the Repeatability value.  

Besides the Graph window, the window Results ï Repeatability: Level by Level from Multiple Measurements is 

automatically opened: 
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Fig. 12.8: Results ï Repeatability: Level-by-Level from Multiple Measurements window 

 

For every Level of the Validated Property (row), the following characteristics are presented: Average 

Measurement (5.1183, ...), i.e. row average of all Measurements, Repeatability (0.1603), i.e. Measurement 

standard deviation on a Level (row STD), Rel. Repeatability (3.13%, ...), i.e. 100*Repeatability/Average 

Measurement, and the number of Measurements on a level (row) n (6). The Conclusion below the table shows 

the pooled Repeatability (0.778) and Rel. Repeatability (3.52%) values obtained along the whole concentration 

range, i.e. Repeatability averages weight with respect to the number of Measurements in the Level. 

 

Under the individual tabs Cochran, Dixon, Grubbs, Grubbs' pair and Normality, the outliers and normality 

results are presented. E.g. with the Grubbs and Normality test, the following results were found in the given 

case: 

 

 
Fig. 12.9: Results ï Repeatability: Grubbs test ï to detect Outliers tab of the Results window 

 

The Measurement number 6 on Level 2 is outlying because the calculated value of the statistical criteria C = 

2.0093 is larger than the critical value Ccrit from tables = 1.887. 

 

 
Fig. 12.10: Results ï Repeatability: Komolgovov-Smirnov test ï to evaluate Normality tab of Results window 

 

The presence of the detected outlier also influences the data distribution. As a result, on Level 2 the Gauss 

normal distribution is not met as detected by the Komolgovov-Smirnov test. The calculated value 0.4358 is 

larger than the critical value 0.323 from statistical tables. 

 

The statistical testing shows that Measurement 6 on Level 2 is outlying. The user has to decide whether or not to 

eliminate (Delete) such a result. The decision should be based on both chemical (real outlier should be removed) 

and statistical grounds (considering the selected probability level). If the outlier is removed (Delete), the 

evaluation of Repeatability has to be repeated. In this case, the Repeatability is decreased to 0.254 and Rel. 

Repeatability is decreased to 1,93%.  
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Click Close and Close to return to the window Data Table ï Repeatability: Level by Level from Multiple 

Measurements. Mark all values in this window using the Shift key and arrows. Click Edit > Copy, or Ctrl-C. 

Data from this Data Table are copied and will be used to evaluate Accuracy. Click Sheet > Close and confirm 

Yes to Save data. This is the way to return to the Full Validation window. 

  

12.3.2 ACCURACY    

 

In the opened window, select the algorithm to be used to evaluate Accuracy: Large Concentration Range ï 

Blank Material Available ï t-test and click OK. The choice of evaluation method is described in chapter 5.4.  

The Data Table ï Accuracy: Large Concentration Range ï Blank Material Available ï t-test window is opened.  

In the cell Measrt 1 on Level 1, enter the earlier copied data using Edit > Paste or Ctrl-V. In the first column 

(which remained empty) - Addition , enter the concentration of NO3
-
 in the samples: 5, 25 and 50. Prior to 

initiating the calculation, the table should look as follows: 

 

 
Fig. 12.11: Data Table ï Accuracy: Large Concentration Range ï Blank Material Available: t-test window 

 

Click Calculate to start the evaluation of Accuracy and to show the window Results ï Accuracy: Large 

Concentration Range ï Blank Material Available: t-test: 

 

 
Fig. 12.12: Results ï Accuracy: Large Concentration Range ï Blank Material Available: t-test window 

 

The last column of the table shows results of testing the Hypothesis about the Accuracy of the Method on the 

given Level. Because the calculated values t = 1.808, 1.451 and 1.039 are lower than the critical values tkrit = 

2.571 and 2.776, the Hypothesis about the Accuracy of the method on all Levels is accepted. The Analytical 

Method therefore provides statistically accurate results along the whole tested range (results without bias).  

Click Close ï Close and Sheet > Close to return to the Full Validation window.  
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12.3.3 LINEARITY    

  

In the opened window, select the algorithm to be used to evaluate Linearity: Correlation and QC Coefficient and 

click OK. The choice of evaluation method is described in chapter 5.4. 

The Data Table ï Linearity: Correlation and QC Coefficient window is opened. Enter data as follows: 

 

 
Fig. 12.13: Data Table ï Linearity: Correlation and QC Coefficient window 

 

Click Calculate to start the evaluation of Linearity and to show the window Results ï Linearity: Correlation and 

QC Coefficient: 

 

 
Fig. 12.14: Data Table ï Linearity: Correlation and QC Coefficient window 

 

Because the calculated correlation coefficient is larger than the considered reference correlation coefficient 

(0.99988 > 0.99) and the QC coefficient is lower than the reference QC coefficient (1.46 < 5%), the Hypothesis 

about Linearity is accepted. Below the Results table, the Conclusion states that Linearity of the Method was 

confirmed based on Correlation and QC Coefficient. Click Close ï Close and Sheet > Close to return to the Full 

Validation window.  

  

12.3.4 SELECTIVITY     

 

In the opened window, select the algorithm to be used to evaluate Selectivity: Comparison of Calibration Lines 

and click OK. The choice of evaluation method is described in chapter 5.4. 

The Data Table ï Selectivity: Comparison of Calibration Lines window is opened. Enter the Number of 

Interferences to be considered to test Selectivity: 2. The number of columns displayed in the Data Table is 

changed to 6: the first two columns are devoted to the initial calibration without any interference, the subsequent 

pairs of columns are intended for calibration in the presence of one interference (e.g. with increasing 

concentration): 
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Fig. 12.15: Data Table ï Selectivity: Comparison of Calibration Lines window 

 

In the columns Val. Pr. 0 and Measrt 0, enter initial calibration without any interference. In columns Val. Pr. 1 

and Measrt 1, Val. Pr. 2 and Measrt 2, enter calibration data obtained in the presence of interference 1 and 

interference 2 respectively. Because the number of calibration standards (concentration levels) for Interference 2 

is smaller than in case of the initial calibration without interference and the calibration with Interference 1, in the 

last row of the calibration with Interference 2 enter values ï1. ñ-1ò is a conventional value considered by 

EffiValidation 3.0 as an empty level, which will not be used in the comparison of calibration lines  

 

Click Calculate to start the evaluation of Selectivity and to show the window Results ï Selectivity: Comparison 

of Calibration Lines: 

 

 
Fig. 12.16: Results ï Selectivity: Comparison of Calibration Lines window 

 

Because the calculated value t = 0.332 for Interference 1 is smaller than the critical value t-crit = 2.179 from 

statistical tables, the hypothesis about Selectivity of the method against Interference 1 is accepted. On the other 

hand, calculated t for Interference 2 is t = 13.207, i.e. larger than the critical t-crit = 2.201. The hypothesis about 

Selectivity of the method against Interference 2 is rejected. Click Close (the window Results is closed).  

 

 
Fig. 12.17: Graph ï Selectivity: Comparison of Calibration Lines window 

 

The window Graph shows that the slope of calibration line with Interference 2 is significantly different from the 

calibration without interference. It is therefore concluded that the given method is not selective against 

Interference 2.  

Click Close, Close and Sheet > Close to return to the Full Validation window.  



111/115 

5/5/2010  Userôs Guide EffiValidation 3.0  version: 2.505     

 
 

 

12.3.5 LIMIT OF DETECTION AND LIMIT OF QUANTIFICATION     

 

In the opened window, select the algorithm to be used to evaluate Limit of Detection and Limit of Quantification: 

From Calibration Line and click OK. The choice of evaluation method is described in chapter 5.4. 

The Data Table ï Limit of Detection and Limit of Quantification: From Calibration Line window is opened. 

Enter the following data (or copy them from the Data Table ï Linearity: Correlation and QC Coefficient using 

Copy and Paste). 

 

 
Fig. 12.18: Data Table ï Limit of Detection and Limit of Quantification: From Calibration Line window 

 

Click Calculate to start the evaluation of Limit of Detection and Limit of Quantification and to show the window 

Results ï Limit of Detection and Limit of Quantification: From Calibration Line: 

 

 
Fig. 12.19: Data Table ï Limit of Detection and Limit of Quantification: From Calibration Line window 

 

Limit of Detection and Limit of Quantification is 0.01669 and 0.03235. Validated Property (Concentration) at 

the Limit of Detection and Limit of Quantification is 1.74 and 3.56.  

Click Close, Close and Sheet > Close to return to the Full Validation window.  

 

12.3.6 ROBUSTNESS    

 

In the opened window, select Robustness and click OK. The Data Table ï Robustness window is opened. Enter 

the Number of Factors to be tested: 5. Titles of columns in Data Table are upgraded (namely Factor 4 and 

Factor 5 instead of Dummy 1 and Dummy 2). In the column Results enter results of performed experiments for 

the individual combinations of experimental conditions included in the experimental design: 

 



112/115 

5/5/2010  Userôs Guide EffiValidation 3.0  version: 2.505     

 
 

 
Fig. 12.20: Data Table ï Robustness window 

 

Click Calculate to start the evaluation of Robustness and to show the window Results ï Robustness with table of 

calculated Factor Effects and Critical Effects for individual evaluated Factors: 

 

 
Fig. 12.21: Results ï Robustness window 

 

Because the Factor Effect of Factor 2 (4.225 mg/l) is larger then the Critical Effect (0.419), the change (shift) 

of Factor 2 from the nominal and the extreme tested level has a significant effect on the Results. The hypothesis 

about the method Robustness against Factor 2 is rejected. Factor 2 has to be better controlled (within narrower 

limits) to make its influence on Results negligible. 

Click Close, Close and Sheet > Close to return to the Full Validation window.  

 

12.3.7 SENSITIVITY     

 

In the opened window, select Sensitivity and the algorithm to be used to evaluate Sensitivity: From Calibration 

Line and click OK. The choice of evaluation method is described in chapter 5.4. 

The Data Table ï Sensitivity: From Calibration Line window is opened. Enter data as follows (or copy data to 

evaluate Linearity or Limit of Detection and Limit of Quantification): 

 

 
 Fig. 12.22: Data Table ï Sensitivity: From Calibration Line window 
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Click Calculate to start the evaluation of Sensitivity and to show the window Results ï Sensitivity: From 

Calibration Line. Sensitivity evaluated as the slope of the calibration line is 0.00862 

 

 
Fig. 12.23: Results ï Sensitivity: From Calibration Line window 

 

Click Close, Close and Sheet > Close to return to the Full Validation window.  

 

12.3.8 RANGE    

 

Click Range. In the opened window Range, enter the range of Validated Property (Concentration) in which the 

validation characteristics are valid: 

 

 
Fig. 12.24: Range window 

 

No calculation is performed for Range. By clicking Save data are saved in the EffiValidation 3.0 database, 

clicking Print they are printed. Click Close to return to Full Validation window. 

 

Because the validation of Nitrates in water is finished, the user can continue with validation of the second 

analyte - determination of Nitrites (NO2
-
). Otherwise, the user can click on EffiValidation 3.0 window Analytical 

Methods and Close Method and the validation of the given method by the given user is finished. In cases when 

the software runs as a networking application, the method becomes available to other users with the appropriate 

access right.  

 

The procedure to enter data, calculate results and display graphs is similar for all computational methods in all 

software modules, i.e. Inter-laboratory Comparison, Calibration, Control Charts and Uncertainties determination. 

12.4 USE ELECTRONIC  RECORD BOOK         

 

From the main EffiValidation 3.0 window, click Record Books and Book of Reference Standards. The Book of 

Reference Standards is opened. In the upper table of the window, all Reference Standards in the database are 

listed. In the lower table, List of Records for the Standard is displayed: 
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Fig. 12.25: Book of Reference Standards window 

 

Click Edit to open the Edit Standard window. In this window, all information regarding the given Standard can 

be entered/edited, such as Name, Supplier, Amount, etc.: 

 

 
Fig. 12.26: Edit Standard window 

 

In a similar way, a new standard can be entered in the Book of Reference Standards. 

In Edit Standard window, click Edit to open the Edit Record window. In this window, all actions with the given 

standard can be recorded, such as receipt, consumption, etc.: 

 

 
Fig. 12.27: Edit Record of standard window 
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Edit data and click Save to save all information and to return to the Edit Standard window. In this window, other 

actions can be entered after clicking New.  

 

Click Close to return to the Book of Reference Standards window. 

 

Click Close to return to the main EffiValidation 3.0 window. 

 

Handling of all other electronic Record Books is similar to the presented example. 

 

 

Click Analytical Methods and Close EffiValidation 3.0. to close software EffiValidation 3.0,  

 

  
 


